
CallPilot
Enterprise Networking Implementation and Administration 
Guide

Product Release 1.0            Standard 1.0    November 1998  

555-7101-304



P0886147



  

CallPilot
Enterprise Networking Implementation and Administration 
Guide

NTP number: 555-7101-304
Product release: 1.0

Document release: Standard 1.0
Date: November 1998

Copyright © 1998 Northern Telecom, All Rights Reserved.

Printed in the United States of America

Information is subject to change without notice. Northern Telecom reserves the right to make 
changes in design or components as progress in engineering and manufacturing may warrant.

The process of transmitting data and call messaging between the Meridian 1 and the Meridian 
Application Server is proprietary to Northern Telecom. Any other use of the data and the 
transmission process is a violation of the user license unless specifically authorized in writing by 
Northern Telecom prior to such use. Violations of the license by alternative usage of any portion of 
this process or the related hardware constitutes grounds for an immediate termination of the license 
and Northern Telecom reserves the right to seek all allowable remedies for such breach.

This page and the following page are considered the title page, and contain Northern Telecom and 
third-party trademarks.



CALLPILOT, NORTEL, NORTEL NETWORKS, NORTEL NETWORKS HOW THE WORLD 
SHARES IDEAS, NORTHERN TELECOM, BNR, DMS, DMS-100, DMS-250, DMS-MTX, DMS-SCP, 
DNC, DPN, DUALMODE, HELMSMAN, IVR, LINK, MAP, MERIDIAN DIGITAL CENTREX (MDC), 
MERIDIAN, MERIDIAN 1, MERIDIAN LINK, MERIDIAN MAIL, MERIDIAN MAX, MFA, NORSTAR, 
SL-1, SL-100, SUPERNODE, SYMPOSIUM, and UNITY are trademarks of Northern Telecom 
Limited. TELESIS is a trademark of Bell-Northern Research.

ACCENT is a trademark of Accent Software International Ltd.

ACTION REQUEST SYSTEM and AR SYSTEM are trademarks of Remedy Corporation.

AMDEK is a trademark of Amdek Corporation.

ANSI is a trademark of the American National Standards Institute, Inc. 

AT&T is a trademark of American Telephone and Telegraph Corporation.

ATRIA is a trademark of Pure Atria Corporation.

CASEWARE is a trademark of Caseware, Inc.

CLEARCASE is a trademark of Rational Software Corporation.

CONTINUUS and CONTINUUS/CM are trademarks of Continuus Software Corporation. 

CRYSTAL REPORTS is a trademark of Seagate Software Inc.

FRAME, FRAMEBUILDER, FRAMEMAKER, and POSTSCRIPT are trademarks of Adobe Systems 
Incorporated.

HELVETICA and TIMES are trademarks of Linotype Corporation.

HITACHI is a trademark of Hitachi Limited.

LOGITECH is a trademark of Logitech, Inc. 

MACINTOSH and APPLE are trademarks of Apple Computer Inc.

MICROSOFT, MICROSOFT WINDOWS, MICROSOFT WINDOWS NT, MS-DOS, and 
POWERPOINT are trademarks of Microsoft Corporation.

NOVELL is a trademark of Novell, Inc.

PCANYWHERE is a trademark of Symantec.

PROMARK and RHOBOT are trademarks of DMI Promark, Inc.

SONY is a trademark of Sony Corporation.

SYBASE is a trademark of Sybase, Inc.

3COM is a trademark of 3Com Corporation.

UNIX is a trademark of Novell, Inc.

WINRUNNER is a trademark of Mercury Interactive Corporation.



November 1998 Publication History
Publication history

 

November 1998 This is the Standard 1.0 issue of the Enterprise Networking 
Implementation and Administration Guide for CallPilot 1.0 
from Nortel Networks.
Enterprise Networking Implementation and Administration Guide v



Publication History  Standard 1.0
vi CallPilot



. . 14
. . 15
. . 16
. . 20
. . 29
. . 31
. . 33

 . 36
. . 44
. . 46
. . 49

. . 58
 . 62
. . 66

. . 72
. . 76

. . 78
. . 80
. . 84

. . 88

. . 90

. . 93
. . . 94
Contents

1 About CallPilot 11

About this guide 13
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Skills you need. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Related information products  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Using the online reference guides . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Contacting technical support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
How this guide is organized  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Conventions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Finding your way around CallPilot 35
Connecting to CallPilot . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Multi-administrator access  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Error handling in property sheets  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Using the online Help  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

2 Getting started 55

About Enterprise Networking 57
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
CallPilot and Enterprise Networking. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Names Across the Network . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Implementing Enterprise Networking 71
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Implementation in a complex messaging network  . . . . . . . . . . . . . . . . . . . 

How Enterprise Networking works 77
About Enterprise Networking messages . . . . . . . . . . . . . . . . . . . . . . . . . . . 
About Enterprise Networking parameters . . . . . . . . . . . . . . . . . . . . . . . . . . 
Understanding Enterprise Networking settings. . . . . . . . . . . . . . . . . . . . . . 

How Enterprise Networking handles messages 87
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
What the MTA does  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
What the ANA does. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
How a message is transferred  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Enterprise Networking Implementation and Administration Guide vii



Contents Standard 1.0

 102
103
105
 108
 109
. 110

 116
118
124
 128

 134
 135
. 138
. 141
 143

 148
149

 154
 156
162
168
172

 176
3 Gathering information 99

Information required 101
Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Switch information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Information required from the switch. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Evaluating the gathered information. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Information from other sites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Messaging network representation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

4 Configuring the switch for Enterprise Networking 113

Configuring the switch 115
Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
SDN Table and Enterprise Networking . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Adding and configuring SDNs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Phantom DNs and Enterprise Networking . . . . . . . . . . . . . . . . . . . . . . . . . .

5 Configuring CallPilot for Enterprise Networking 131

Configuring CallPilot 133
Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Configuration summary  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Message delivery parameters—Enterprise tab . . . . . . . . . . . . . . . . . . . . . . 
Configuring the message delivery parameters . . . . . . . . . . . . . . . . . . . . . . 
Creating a loopback mailbox  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

6 Adding sites to Enterprise Networking 145

About the messaging network 147
Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Configuration and other networking solutions . . . . . . . . . . . . . . . . . . . . . . . 

Configuring the local site 153
Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Configuring the local messaging server . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Configuring the local prime switch location. . . . . . . . . . . . . . . . . . . . . . . . . 
Configuring ESN information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Configuring CDP information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Adding and configuring a remote site 175
Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
viii CallPilot



November 1998 Contents

 . 178
187
199
 . 203
 . 205
.207
.209
211

.212

.216

.218

.219

.221
 . 222
 . 224
227

.232
234
35

.238

.240
42
244
.247
249
.251
.253
254
.257
60
Configuring a remote messaging server  . . . . . . . . . . . . . . . . . . . . . . . . . . .
Configuring a remote prime switch location . . . . . . . . . . . . . . . . . . . . . . . . .
Configuring a remote satellite switch location  . . . . . . . . . . . . . . . . . . . . . . .
Recording a spoken name . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Importing a spoken name  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Checking the configuration of other remote sites . . . . . . . . . . . . . . . . . . . . 
Non-CallPilot remote sites. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Meridian Mail remote sites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Norstar Voice Mail remote sites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

7 Testing and backing up Enterprise Networking 213

Tests and backups 215
Enterprise Networking test suite . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Call routing test . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Local SDN test. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Quick SDN test . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Loopback test. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
End-to-end test. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Backing up Enterprise Networking . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

8 Maintaining Enterprise Networking 229

About maintaining Enterprise Networking 231
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Maintain a network history . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Printing configuration information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

Regularly scheduled maintenance tasks 237
Reviewing OM reports and alerts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

As-required maintenance tasks 239
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Modifying the Enterprise Networking configuration  . . . . . . . . . . . . . . . . . . 2
Disabling and enabling Enterprise Networking. . . . . . . . . . . . . . . . . . . . . . .
Modifying message delivery parameters. . . . . . . . . . . . . . . . . . . . . . . . . . . 
Modifying the channel resource allocation . . . . . . . . . . . . . . . . . . . . . . . . . .
Add, modify, or delete remote sites. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Locating an item in the tree view  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Modify a remote site configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Deleting items in the tree view . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Modifying dialing plan information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
Enterprise Networking Implementation and Administration Guide ix



Contents Standard 1.0

 262
263
. 266
 270
 271
 272

 276
78
279
 280

 282
. 283
 285
Maintaining remote users 261
Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Adding remote users with User Administration . . . . . . . . . . . . . . . . . . . . . . 
Finding remote users. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Printing a list of remote users . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Modifying records of remote users. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Manually deleting remote voice users  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

9 Troubleshooting Enterprise Networking 273

About troubleshooting Enterprise Networking 275
Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Determining if Enterprise Networking is disabled . . . . . . . . . . . . . . . . . . . . 2
Reviewing Alarm and Event reports. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Reviewing Operational Measurement reports  . . . . . . . . . . . . . . . . . . . . . . .

Determining if problems are switch-related 281
Switch-related problems . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Call trace test  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Link diagnostic test. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
x CallPilot



m 

dows 
c h a p t e r  1

About CallPilot

This chapter introduces CallPilot, the powerful multimedia messaging syste
from Nortel Networks. CallPilot offers a single solution for managing many 
types of information, including voice mail, fax-mail, e-mail, telephone calls, 
conferencing, calendars, directories, and call logs.

CallPilot enables you to get all the information you need from one source, 
whether through display-based telephone sets, your wireless set, your Win
desktop computer, a speech recognition interface, or another personal 
communications device. 

In this chapter 
About this guide 13

Finding your way around CallPilot 35
Enterprise Networking Implementation and Administration Guide 11
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Overview

Introduction
The Enterprise Networking Implementation and Administration Guide provides 
the information and procedures that are necessary to implement Enterprise
Networking.

Assumptions
This guide assumes that the Meridian Application Server has been correctl
installed and is operational. If the application has not been installed, then in
it before proceeding. For installation instructions, refer to the hardware 
installation guide appropriate to your server type.

If the server has been installed but is not operational, refer to the Maintenance 
and Diagnostics Guide for information on troubleshooting your system.
14 CallPilot
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Skills you need

Introduction
You need certain skills and knowledge to use this guide effectively.

Nortel Networks product knowledge
Knowledge of, or experience with, the following Nortel Networks products w
assist you:

■ Meridian 1

■ Meridian Mail

PC experience or knowledge
Knowledge of, or experience with, the following PC products will be of 
assistance. This guide does not document the following functionality:

■ Microsoft Windows NT

■ Microsoft Windows 95

Other experience or knowledge
Other types of experience or knowledge that may be of use include the 
following:

■ network management

■ client-server systems

■ flowcharting
Enterprise Networking Implementation and Administration Guide 15
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Related information products

Introduction
Following is a list of all CallPilot technical documents. The CD-ROM that yo
receive with your system contains these guides, enabling you to search the 
suite of documentation online. If you prefer, you can print out entire guides,
parts of a guide. 

You order copies of these documents using the NTP numbers or P0 numbe
provided. 

Planning and migration
These guides are used before CallPilot is installed to help you plan your sy
and, if you have a Meridian Mail system, migrate to CallPilot. 

Document Title NTP number

Planning and Engineering Guide 555-7101-101

Meridian Mail to CallPilot Migration Guide 555-7101-801
16 CallPilot



November 1998 About CallPilot 

e.  

it, 
Installation guides
These guides describe how to install server hardware and CallPilot softwar

Administration and feature guides
These guides describe how to configure CallPilot, administer and maintain 
and use its features. 

Document Title

NTP number
or
P0 number

Meridian Application Server 200i Installation Guide P0884895

Meridian Application Server 702t Installation and 
Maintenance Guide

P0884909

Meridian Application Server 1001rp Installation and 
Maintenance Guide

P0886776

Software Installation Guide 555-7101-200

Document Title NTP number

Basic Administration Guide 555-7101-300

Advanced Administration Guide - 
volume 1

555-7101-301

Advanced Administration Guide - 
volume 2

555-7101-301

Reporter Guide 555-7101-310

Application Builder Guide 555-7101-325
Enterprise Networking Implementation and Administration Guide 17
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Networking guides
These guides describe how to plan, install, set up, and troubleshoot networ
services. 

Maintenance and troubleshooting guides
These guides describe how to maintain your system once it is in service and
you troubleshoot operational problems.  

End user guides
These guides are intended for end users of CallPilot, such as telephone se
and desktop messaging users. 

Document Title NTP number

Networking Planning Guide 555-7101-100

NMS Implementation and Administration Guide 555-7101-302

AMIS Networking Implementation and Administration 
Guide

555-7101-303

Enterprise Networking Implementation and 
Administration Guide

555-7101-304

Integrated AMIS Networking Implementation and 
Administration Guide

555-7101-305

VPIM Networking Implementation and Administration 
Guide

555-7101-306

Document Title NTP number

Maintenance and Diagnostics Guide 555-7101-500

Support Tools Guide 555-7101-800

Document Title P0 number

Speech Activated Messaging User Guide P0886127
18 CallPilot
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CD ROM
The CD-ROM contains all the listed documents, except the end user guides

Multimedia Messaging Quick Reference Card P0886128

Multimedia Messaging User Guide P0886140

Desktop Messaging for Microsoft Exchange Guide P0886141

Desktop Messaging for Lotus Notes Guide P0886142

Internet Messaging Guide P0886143

Document Title Order number

CallPilot Technical Documentation CD NTRG19AA

A0742811

Document Title P0 number
Enterprise Networking Implementation and Administration Guide 19
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Using the online reference guides

Introduction
The online reference guides contain the same procedures and context-sen
information that you find in the online Help. However, the guides contain 
additional information not included in the online Help. These guides have 
overview sections that describe concepts and features and provide other 
CallPilot information.

To print an online guide, see Printing an online guide on page 28.

The online guides
The following reference guides are available online:

■ Overview Guide

■ Advanced Administration Guide

■ Application Builder Guide

■ Reporter Guide

■ Networking guides

● Networking Planning Guide

● AMIS Networking Implementation and Administration Guide

● Integrated AMIS Networking Implementation and Administration Gu

● Enterprise Networking Implementation and Administration Guide

● VPIM Networking Implementation and Administration Guide

● NMS Implementation and Administration Guide
20 CallPilot



November 1998 About CallPilot 
To access the online guides

1 On the Help menu, click Reference Guides.

Attention:  If you see the following error message, Adobe Acrobat was not 
installed during the MAS software installation. Refer to the Software 
Installation Guide for the Acrobat Installation procedure.
Enterprise Networking Implementation and Administration Guide 21
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2 Click the document you want to open.

Result: The front cover is displayed. Select a chapter from the front cover 
or from the bookmarks displayed in the left frame.

Navigating the online guides
There are several ways to navigate through the guides and to find specific to 
22 CallPilot
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Bookmarks
Bookmarks are displayed on the left-hand side of each document. To go to
specific part of the document, such as a chapter or section, click the bookm
 

Enterprise Networking Implementation and Administration Guide 23
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Using hypertext links
Once you find the chapter or section you are interested in, use hypertext lin
navigate within the chapter and document.

Links appear as blue underlined text.
 

24 CallPilot
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When you click a link, the selected topic is displayed.
Enterprise Networking Implementation and Administration Guide 25
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Using the document button bar
The online guides have a button bar at the top of each page to help you ge
around quickly. 

On each page you can use the following buttons:  

Using Acrobat Reader commands
Adobe Acrobat Reader also has features to help you work through the docum
You can learn more about Reader by accessing its online guide from the Ac
Reader Help menu.

Here are some of the more common commands:

Button Description

home Goes to the cover page of the current guide.

help Provides tips on how to use the online guides.

contents Goes to the table of contents for the current guide.

index Goes to the index for the current guide.

back Goes to the previous page in the guide.

next Goes to the next page in the guide.

 Function Description

. Goes back to the last view and forward to the next view

. Goes to the previous page and to the next page in the 
document.
26 CallPilot
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Searching for information
You can use the Acrobat Search tool to find specific information. This tool 
enables you to find all instances of a word or phrase. You can search eithe
current guide or all the online guides.  

. Goes to the first page of the document and to the last pa
of the document.

Search function Description

. 

Searches the current document for all instances of the 
word or phrase you type. Goes to the first page that has
least one instance of the word or phrase, and highlights
your choice.

. 

Searches all the online guides for the word or phrase yo
type. Displays a list of the guides containing the search
word or phrase. The guide you select opens to the first 
page that has at least one instance of the word or phras
and highlights your choice.

. 

Goes to the next instance of the word or phrase.

. 

Goes to the previous instance of the word or phrase.

 Function Description
Enterprise Networking Implementation and Administration Guide 27
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Printing an online guide
For best results when you print an online guide, use a Postscript-compatibl
printer capable of 600 dpi output. If a Postscript printer is not available, use
Adobe Acrobat 3.0 (not Acrobat 3.01). Acrobat 3.0 is installed by default wi
the CallPilot 1.0 Administration client software. It is also available from 
http://www.adobe.com.

To set print properties for an online guide

1 In Acrobat Reader, open the file for the online guide.

2 From the File menu, select Print Setup...

3 In the Print Setup dialog box, select Properties.

4 Select the Graphics tab.

5 Select Resolution, and then select 600 dpi.

6 Click OK until you exit from all the dialog boxes.

Note: Your screens should print out legibly, even on a non-Postscript 
printer.

To print an online guide

1 From the File menu, select Print.

2 Indicate the page range.

3 Click OK.
28 CallPilot
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Contacting technical support

Introduction
Contact your distributor’s technical support organization to get help with 
troubleshooting your system.

Before contacting Technical Support, ensure that you have the necessary 
information on hand.

Information about your server
Technical Support may ask for the following information, which is displayed
the Server Settings window: 

■ server version number

■ release number

■ serial number (if you have this number available)

Getting there  Nortel SMI > Meridian Application Server > System 
Administration

To view server settings

1 Double-click System Configuration.

2 Double-click Server Settings.
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Identifying Field Replacement Units (FRUs)
If you have diagnosed a hardware problem and need to order a replacemen
you must be able to identify the part.

For more information about running diagnostics on hardware components a
identifying field replacement units, see the Maintenance and Diagnostics Guide.

Contacting Nortel Networks
If you have comments or suggestions for improving CallPilot and its 
documentation, Nortel Networks would like to hear from you. Please see th
following address:

http://www.nortelnetworks.com/callpilot_feedback
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How this guide is organized

Introduction
The Enterprise Networking Implementation and Administration Guide is 
organized in the sequence of tasks required to successfully implement Ente
Networking for CallPilot. Start at the beginning of the guide and work your w
through it until all required tasks are completed.

Contents
This guide contains the following chapters.

Chapter title Description

Chapter 1, About CallPilot This chapter describes how to work with the
CallPilot interface and how to use this guide

Chapter 2, Getting started This chapter provides an overview of 
Enterprise Networking.

This chapter describes the features support
by Enterprise Networking and how Enterprise
Networking works.

This chapter also provides a high-level 
overview of the tasks that are performed 
during implementation.

Chapter 3, Gathering information This chapter explains how to gather the 
information required to implement Enterprise
Networking.

Chapter 4, Configuring the switch for 
Enterprise Networking

This chapter explains how to configure the 
switch for Enterprise Networking.

Chapter 5, Configuring CallPilot for 
Enterprise Networking

This chapter describes how to configure 
CallPilot for Enterprise Networking.

This chapter describes every box that must b
completed and provides detailed procedures
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Chapter 6, Adding sites to Enterprise 
Networking

This chapter describes how to configure the
local site. This chapter also describes how t
add and configure every site in the messagin
network that uses Enterprise Networking to 
exchange messages with local site.

This chapter describes every box that must b
completed and provides detailed procedures

Chapter 7, Testing and backing up 
Enterprise Networking

This chapter describes how to test the 
implementation of Enterprise Networking to 
ensure that it is properly configured. This 
chapter also describes how to perform a 
backup of the system.

Chapter 8, Maintaining Enterprise 
Networking

This chapter explains how to perform both 
regularly scheduled maintenance tasks and
as-required maintenance tasks.

Chapter 9, Troubleshooting Enterprise 
Networking

This chapter provides information to identify
and solve problems with Enterprise 
Networking.

Chapter title Description
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Conventions

Introduction
This guide uses the following conventions.

How commands are documented in procedures
As with many Windows applications, there are several different ways to exe
a command. For example, to copy text, you can choose any of the following
methods:

■ Choose Copy from the Edit menu.

■ Click the Copy button on the toolbar.

■ Type the keyboard shortcut Control + C.

The procedures in this guide document only the first method, choosing a 
command from a menu.

Navigation information in procedures: Getting there
Procedures in this guide are preceded by a Getting there statement. This 
statement summarizes the steps you take to navigate to the window or tab w
the procedure is carried out.

All Getting there statements start at the Nortel SMI window. This assumes 
have logged on and selected the appropriate system. Each item mentioned
that represents an icon, window, or tab that makes up the path to the final 
destination. 

Example
To define special mailboxes such as the broadcast mailbox, you must be o
Mailboxes tab. The Getting there statement for this procedure is as follows:

Getting there  Nortel SMI > Meridian Application Server > CallPilot > Messaging 
Administration
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After you double-click Messaging Administration, the property sheet display
You then click the Mailboxes tab.
 

34 CallPilot



November 1998 About CallPilot 
Finding your way around CallPilot

In this section
Connecting to CallPilot 36

Multi-administrator access 44

Error handling in property sheets 46

Using the online Help 49
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Connecting to CallPilot

Introduction
To perform administrative tasks, or to build or work with CallPilot application
you must first connect to the Meridian Application Server (the MAS server).
The MAT Navigator and the System Management Interface (SMI) work 
together to give you access to your system and sites.

Selecting a system—the MAT Navigator
The first step in logging in is to launch the MAT Navigator, which has its ow
password. The MAT Navigator connects your administration client to the M
server. It displays all your sites and systems and enables you to select one
work on.
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Selecting a program—the System Management Interface (SMI)
When you select a system from the MAT Navigator, you are prompted for a
second password. At this point, the SMI window for the selected system or 
displays. 
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The SMI gives you quick and easy access to your system or sites. The SMI
a navigation tree to display the system’s hierarchy. In the tree, icons repres
the folders and programs. Double-click a folder icon to view its contents. 
Folders can contain programs and other folders. Double-click a program ico
run the associated program. 

Selecting an object—list views
When you launch certain programs, the first thing you see is a list view. The
view displays all the objects of a certain type (such as mailbox classes) tha
currently defined in the system. The list view includes predefined objects as
as those defined by an administrator. From the list view window, you can se
a specific object to work on.
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Viewing and changing properties
Select an object and display its properties by 

■ double-clicking it or 

■ single-clicking it and selecting Properties from the File menu

■ right-clicking it and selecting Properties from the popup menu

Entering data and choosing options—property sheets
A property sheet is displayed when you view an object selected from a list v
Certain programs, such as Messaging Administration, display a property sh
immediately after launching. Property sheets have one or more tabs. Each 
has fields, referred to as boxes, in which you can type data or from which y
can select options. 
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Most CallPilot property sheets look like the following:
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Some property sheets are divided into two panes. When a box is checked i
left pane, the selected capabilities are enabled and you can access the ass
tabs. Select a tab by clicking its name in the left pane or by clicking the tab in
right pane. These property sheets look like this:
 

Mandatory boxes
If the name of a box is underlined, the box is mandatory, and you must fill it
You cannot save if any mandatory boxes are empty.
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Common buttons
The following buttons appear on most property sheets: 

Using the toolbar buttons
For easier access, some of the more common tasks, such as Print and Sav
represented as buttons on the toolbar. 

The following buttons are used throughout CallPilot. Buttons or icons specifi
certain CallPilot functions, such as backups and archives, are documented 
relevant chapters.

Button Description

Save Saves all changes made on any of the tabs in a property s
and closes the property sheet. Therefore, save only when y
have made the necessary changes on all tabs.

Cancel Closes the property sheet without saving any changes.

Print Prints the contents of all tabs in the property sheet.

Help Displays Help for the current tab. From this overview Help 
topic, you can access other Help topics, the index, and the
search function.

Toolbar button Description

. 

Saves any changes you have made and then transfers 
the application’s data to the server.

. 

Opens the Print dialog box and prints the active file or th
objects you specify.

. 

Deletes the object you select.
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Displays the properties of the object you select.

. 

Displays the Help topics window.

. 

Explains the next menu item or screen object you click. 
a window, there is an arrow. On tabs or in dialog boxes
there is no arrow.

. 

Opens the New dialog box, where you identify the 
properties of the object you are creating. The button loo
different in different applications.

. 

Displays the Open dialog box, where you select an obje
to open. The button is different in different applications.

. 

Reloads the current page and displays the changes you
have made.

. 

Enables you to select how the system displays icons.

Toolbar button Description
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Multi-administrator access

Introduction
You can create multiple administrator accounts to make administering CallP
easier and more efficient. Multiple accounts enable administration 
responsibilities to be distributed among a number of people. Therefore, cer
administrators can specialize in certain tasks, such as maintaining users, 
performing backups, analyzing reports, or creating multimedia services. 

Access classes
For security reasons, administrators should be given access only to those pa
the system that relate to their role. For example, an administrator who is 
responsible only for creating multimedia services should have access only 
Application Builder and the Service Directory Number Table. 

Each administrator account is assigned an access class. An access class i
of the parts of the system and the level of access allowed. The access leve
as follows:

■ create/delete (enables an administrator to delete objects such as users
services)

■ edit

■ view

■ none

For example, an administrator may be able to create or delete objects in 
Application Builder but only view User Templates.

Simultaneous access
Multiple administrators can log in to CallPilot at the same time without 
overwriting other work.

If you are the first to log in to a particular resource, such as a specific mailb
class or user profile, and another administrator tries to access the same res
a dialog box appears to inform you of the other administrator. At this point, 
can do one of the following:
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■ Keep editing.

■ Save your changes, and release the resource to the other administrato

■ Cancel your changes, and release the resource to the other administra

If you do not respond to this prompt within two minutes—because you are a
from the terminal, for example—the system releases the resource so that o
can access it. If this happens, all your unsaved changes are lost.

An administrator who accesses a resource that is currently being edited se
read-only view of the property sheet in which all boxes are dimmed. This 
indicates that the resource is currently locked. The administrator is not notif
when the resource is released, but must try to access the property sheet ag
see whether its status has changed. 

If a user tries to log on to a mailbox while an administrator is changing the 
profile, the user is unable to log on and receives a message that says the m
is in use.

Refreshing screens
Because multiple administrators can access the same database at the sam
a Refresh command is available from the View menu to ensure that the view
are seeing is the most up-to-date. 

For example, if you are viewing a list of users when another administrator 
deletes a user, the only way to see the change is to refresh the screen. You
should, therefore, refresh the screen regularly.
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Error handling in property sheets

Introduction
If you make certain types of errors while entering data, you are not able to s
your changes until you correct the errors. For example, if you leave a mand
box empty, you receive a message prompting you to fix it. 

Note: These errors do not show up in the Event Browser or Alarm Monitor 
because the errors relate only to data entry and are not operational problem

How error handling works
There are two types of error messages.

Type 1
If you get this type of error message, click OK, and then fix the problem 
described in the message before you try to save again.
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Type 2
If you get this type of error message, click OK to see a list of errors.

Double-click an error from the list. Your cursor is automatically placed in the
box where the error was made so that you can correct it. 
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For example, if you double-click the second error, the Remote notification ta
displayed, with the cursor in the Target number box. 
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Using the online Help

Introduction
While administering or maintaining CallPilot, you may have questions about
purpose of certain boxes and buttons, or need more information about 
completing certain tasks. 

Online Help provides brief answers to the questions “What’s this?” and “Ho
do I...?”
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Context-sensitive Help
If you need to know the purpose of a particular box or button, use context-
sensitive Help.

To access context-sensitive Help

1 Click the  icon in a window or the  icon on a tab or in a dialog 
box.

2 Point to the box or button for which you want more information, and click.

Result: A pop-up description of the selected object is displayed.
50 CallPilot



November 1998 About CallPilot 

ad 

 tasks 
e.
Procedures
If you need to know how to do something, you can access procedures to le
you through a task. 

High-level tasks
In some cases, high-level tasks take you through longer procedures. These
also provide you with navigation to the step-by-step procedures they includ
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For example, setting up Delivery to Telephone requires several procedures
high-level task summarizes these procedures. You click the gray buttons w
the task to open the step-by-step procedures. The high-level task remains o
your screen so that you can continue to use it to move through the procedu
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Overviews
Overview topics provide brief descriptions of tabs, features, and the tasks 
carried out from the tabs. However, the online guides contain more detailed
feature descriptions.

To access overview topics

Click the Help button on a tab.

To find information in Help
You can look up procedures and overview topics in the following ways: 

1 From the Help menu, select Help Topics.

Note: You can also press F1 on the keyboard.

2 Go to one of the following tabs: 

■ To see the table of contents of all the Help topics, select the Contents 
tab.

■ To look up a subject alphabetically, select the Index tab.

■ To do a full-text search to find topics that contain the words you enter, 
select the Find tab.
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Getting started

Enterprise Networking is one of the networking solutions offered by CallPilo
Enterprise Networking uses a proprietary protocol, the Enterprise Networkin
protocol, to exchange messages.

This chapter introduces Enterprise Networking and provides a basic overvie
the Enterprise Networking implementation process.

In this chapter
About Enterprise Networking 57

Implementing Enterprise Networking 71

How Enterprise Networking works 77

How Enterprise Networking handles messages 87
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Overview 58

CallPilot and Enterprise Networking 62

Names Across the Network 66
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Overview

Introduction
Enterprise Networking is one of the networking solutions offered by CallPilo
This chapter introduces Enterprise Networking and provides a basic overvie
its implementation process.

You must be familiar with the basic concepts of messaging networks, dialin
plans, and protocols. To review these concepts, consult the Networking Planning 
Guide.

Definition: Enterprise Networking
Enterprise Networking is a CallPilot networking solution that is used to trans
messages between users at different sites in a private messaging network.

The following diagram is a conceptual illustration of how Enterprise 
Networking works:

Switch Switch
MPCX

MPCX Site MPCX Site

MPCX

Network
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Protocol
Enterprise Networking uses a proprietary analog protocol that is based on 
extensions to the Audio Messaging Interchange Specification (AMIS) proto
Like the AMIS protocol, the Enterprise Networking protocol uses dual-tone 
multifrequency (DTMF) signaling.

Since DTMF signaling is a global standard, Enterprise Networking can be u
globally.

Advantages of Enterprise Networking protocol
The Enterprise Networking extensions to the AMIS protocol offer important 
advantages.

The Enterprise protocol requires less resource consumption and costs less
operate.

For example, when a single message is sent to multiple recipients at the sa
remote site using AMIS Networking, you make one call for each recipient. W
Enterprise Networking, you make only one call.

The Enterprise protocol also supports a longer voice message length than A

The Enterprise Networking extensions also support additional CallPilot feat
that are not supported by AMIS Networking.

Message transmitted with Enterprise Networking
A message that you transmit with Enterprise Networking consists of two pa

■ a message header consisting of

● the mailbox numbers of the sender and the recipient or recipients

● an indication of whether the message is a regular message or a non
delivery notification (NDN) message

■ the recorded message
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Enterprise site ID numbers
Every messaging system in the messaging network is called a site. A site 
consists of a server and one or more switches.

If you install Enterprise Networking on the messaging network, every site in
messaging network that exchanges messages with the site using Enterpris
Networking needs a unique site ID number.

Enterprise Networking is the only networking solution that uses site IDs.

If your implementation of Enterprise Networking is an upgrade of an existin
voice messaging system that used Enterprise Networking, maintain the site
numbers of the previous system.

Complex network with Enterprise Networking
You can implement Enterprise Networking on a complex messaging netwo
that combines several networking solutions. A messaging network is often 
open and private, combining various protocols.

The following diagram illustrates a complex network that includes sites with
Network Message Service (NMS), AMIS Networking, VPIM Networking, an
Enterprise Networking implemented.

Because Enterprise Networking is implemented in this messaging network,
every site has a unique site ID number.

G101139.ep

 Site 1  Site 2

 Site 3  Site 4

 Site 5  Site 6

VPIM

AMIS

Satellite Satellite

Enterprise

VPIM

Integrated AMIS

Enterprise

VPIM

Integrated AMIS Enterprise

Integrated AMIS

Integrated AMIS

Integrated AMIS

Enterprise

Enterprise

Off-net
site

Satellite Satellite

PRIVATE MESSAGING NETWORK

Off-net
site
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While the sites have more than one networking solution implemented, only 
protocol is used between any two sites. 

Example: 
Because Site 4 and Site 2 both have Integrated AMIS Networking and Enter
Networking implemented, you use only one protocol to send messages bet
the sites. The network administrators of Site 4 and Site 2 must agree on wh
protocol to use.
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CallPilot and Enterprise Networking

Introduction
Enterprise Networking supports most of the features offered by CallPilot.

Enterprise Networking features
The following table lists the CallPilot features that are supported by Enterpr
Networking.

For detailed information about CallPilot features, consult the Basic 
Administration Guide.

CallPilot feature Supported Notes

Call Sender Yes This feature can be used for both call 
answering and composed messages from 
network users if

■ the calling line identification (CLID) is 
present in the message, or

■ the mailbox numbering plan follows the 
dialing plan, or

■ a remote user entry is added for the 
network user

Names Across the Network Yes

Name Addressing Yes Name addressing is available if users at 
remote site are defined as remote users at
the local site. This can be done 
automatically with Names Across the 
Network or manually by the administrator.

Personal Distribution Lists Yes This feature is available if users at the 
remote site are defined as remote users at
the local site, which can be done by Name
Across the Network.
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Shared Distribution Lists Yes A remote user is required. A network 
address cannot be entered into the shared
distribution list unless the address 
corresponds to a remote user.

Multiple Recipients Yes The Enterprise Networking message 
contains all the recipients of the message 
who are at integrated sites. Recipients at 
open sites are not included.

Reply To Yes This feature can be used with all network 
messages. It can also be used with call 
answering messages left by network users
the calling line identification (CLID) is 
present on the message and all other 
conditions listed for Call Sender are met.

Reply All Yes This feature works with all recipients at 
integrated sites. It does not include 
recipients at open sites.

User’s Actual Personal 
Verification

Yes The user’s personal verification is played t
callers in voice messaging scenarios if 
recipients are defined as remote users at th
local site. AutoAdd or Names Across the 
Network can be used to create the user’s 
personal verification.

Administrator-Recorded 
Personal Verification

Yes The administrator can record a personal 
verification for remote users who are 
defined at the local site.

Remote Site Spoken 
Names

Yes A spoken name can be recorded for each 
remote site when configuring a remote site

Private Tag Yes Messages tagged as private are announc
to the recipient and may not be forwarded 
by the recipient to anyone else.

CallPilot feature Supported Notes
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Acknowledgment Tag Yes Acknowledgment tags result in a messag
to the sender indicating that the message 
was actually listened to.

Urgent Tag Yes Messages tagged as urgent trigger urgen
related features, such as remote notificatio
or message waiting indication. Urgent 
messages are given priority for transmissio
as determined by the scheduling 
parameters.

Economy Tag Yes

Received Time Announced Yes The time when the message was depos
into the mailbox is announced to the 
recipient. The time reflects the time zone o
the recipient.

Sent Time Announced Yes The sent time announced to the recipien
reflects the time zone of the sender, not th
recipient.

120-Minute  Messages Yes Enterprise Networking supports messag
containing up to 120 minutes of voice, 
including any attachments.

Sender’s Name (Text) Yes This feature is supported only if America
English character set (ASCII 32-126) is 
used.

Recipient’s Name (Text) Yes If the recipients are defined as remote us
their names are provided.

This feature is supported only if American 
English character set (ASCII 32-126) is 
used.

Message Subject (Text) Yes This feature is supported only if America
English character set (ASCII 32-126) is 
used.

CallPilot feature Supported Notes
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Sender’s Department No

Timed Delivery Yes Any message can be tagged for future 
delivery.

CallPilot feature Supported Notes
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Names Across the Network

Names Across the Network
Names Across the Network is a feature that automatically adds temporary 
remote users to a local database and maintains them.

You can use Names Across the Network if you have Enterprise Networking
installed on your system.

Incoming and outgoing messages
You enable Names Across the Network for incoming and outgoing messag
separately. A temporary remote user can be added when

■ A local user addresses a message to a user at a remote site.

■ A user at a remote site addresses a message to a local user.

When you select Names Across the Network for incoming messages, you a
temporary remote users from all sites in the messaging network.

However, because outgoing messages must carry additional information w
them, which results in longer transmission time, you can select Names Acro
the Network for outgoing messages for individual sites. For example, you m
select the feature for outgoing messages to a site that does not incur long-
distance toll charges, but clear the feature for a site that incurs these charg

Examples
The following examples describe a messaging network consisting of five sit

Example 1
As the local administrator of the Helsinki site, you set your system to receiv
Names Across the Network by selecting the Add/Update Remote Users op
You receive messages from all other sites that are configured to send the 
information.
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However, when you configure information about the remote servers in your l
database, you clear the Send Local User Information to this Server option fo
sites to which you do not want to send remote user information. In this case
do not want to incur the extra long-distance toll charges associated with Na
Across the Network. Therefore, you clear the Send Local User Information 
this Server option for Cairo and Paris.

Because Lammi and Korso-Rekola are near Helsinki and do not incur long-
distance toll charges, you allow local user information to be sent to these si

However, Names Across the Network is also affected by the way the netwo
administrator at a remote site configures the system.

G100970

Local Server

Add/Update
Remote Users?

YES

Helsinki
Local Network Database

Send Local User Info
to this server?

Cairo

Paris

Korso-Rekola

YES

YES

NO

NO

Remote Server
Lammi

Lammi

Local charges
only

Send /
Receive

Local charges
only

Korso-Rekola

Send /
Receive ReceiveReceive

Cairo

Long-distance
toll charges

Paris

Long-distance
toll charges
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Example 2
In this example, the network administrator in Lammi decides to clear the Se
Local User Information to this Server option when configuring the Helsinki 
remote server in the local messaging database. This means that even thoug
are willing to receive Names Across the Network from Lammi, messages are
sent to your site in Helsinki.

In this case, when a user from Helsinki sends a message to a user in Lamm
Helsinki user is not added to the Lammi database as a remote user.

To add remote users with Names Across the Network
The setting to add remote users with Names Across the Network is on the 
Messaging Network Configuration page for your local server. 

This setting controls your local server. You must coordinate with the system
administrator of each remote site with which you want to enable Names Ac
the Network. You can use Names Across the Network only with remote sites
have Enterprise Networking installed.

G100971

Local Server

Add/Update
Remote Users?

YES

Helsinki
Local Network Database

Helsinki sends/
Lammi does  not

receive

Lammi sends/
Helsinki
receives

Local Server

Add/Update
Remote Users?

NO

Lammi
Local Network Database

Korso-RekolaCairoParis

Send Local User Info
to this server?

YES

Remote Server
Helsinki

Send Local User Info
to this server?

YES

Remote Server
Lammi
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When remote users are added and updated
Names Across the Network adds a temporary remote user to the local site 
a user at the remote site sends a network message to a user at the local si
remote user information is taken from the header of the message that is rec

Limitations
Names Across the Network has the following limitations:

■ Users at remote sites are added to your system as temporary remote u
only when messages are received from them. Users at remote sites wh
not send network messages are not added to your system, even if they
regularly name-dialed or have messages sent to them.

■ Operational measurements are not collected for remote users.

■ If the sender’s site does not have mailbox numbers that match the dial
plan, the Call Sender and Name Dialing features are not available.

■ While the nightly audit is in progress, temporary remote users cannot b
added or updated.

■ Only 18 characters of the remote voice user’s text name are sent.

IF THEN

the first and last names are 18 
characters or less

the first and last names of the user are 
sent.

the initials and last name are 18 
characters or less

the initials and last name of the user are 
sent.

the last name only is 18 characters 
or less

only the last name is sent.

the last name is longer than 18 
characters

only the last name, truncated to 18 
characters, is sent.
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Outgoing Enterprise Networking sessions
When the local site initiates an Enterprise Networking session to a remote s
the two sites negotiate whether spoken names are sent. This negotiation oc
as follows:

Time stamps updated
When a message is received from a user who already exists in the local dat
as a temporary remote user, the time stamp of the remote user is updated 
the current date and time.

IF THEN

the local site chooses to send spoken 
names and the remote site has selected the 
Add/Update Remote Users on this Server 
option

■ the local site includes the sender’s text an
spoken name with each message.

■ the remote site adds or updates the 
sender’s remote user information.

the local site chooses not to send spoken 
names and/or the remote site has not 
selected the Add/Update Remote Users on 
this Server option

■ the local site does not include the spoken
names for the senders.

■ the remote site does not add or update th
sender’s remote user information.
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Implementing Enterprise Networking

In this section
Overview 72

Implementation in a complex messaging network 76
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Overview

Introduction
Planning is critical to successfully implement Enterprise Networking. Before
you begin to implement Enterprise Networking, you must understand the ba
implementation process and know what information to provide.

The process for planning the implementation of a CallPilot networking solut
is described in detail in the Networking Planning Guide. The following overview 
assumes that you are familiar with this description.

Before you begin
This guide makes the following assumptions:

■ The switch is installed and configured.

■ Sufficient trunks that connect the switch to a public switch are available

■ CallPilot is installed and configured, except for networking.

■ If implemented on the local site, Network Message Service (NMS) is fu
implemented.

■ If implementation is an upgrade from Meridian Mail, all legacy informatio
is available or is migrated.

■ Contact is made with the network administrators of the remote sites.

Fulfill all of these requirements before you continue with the implementation
Enterprise Networking.

Implementation steps
To implement Enterprise Networking, you must complete the following step

■ Gather information for the network.

■ Configure the switch for Enterprise Networking.

■ Configure CallPilot for Enterprise Networking.

■ Add and configure the sites that use Enterprise Networking to the local
network database.

■ Test and back up the system.
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Gather information for the network
The first step in implementing Enterprise Networking is to gather the 
information required during the configuration. You must gather information 
about

■ the switch configuration

■ the remote sites

You must also create a network representation.

Gather information from the switch
Much of the information you need to implement Enterprise Networking is 
available in the switch database.

For example, before you begin to implement networking, the switch is set u
make telephone calls to all the remote sites. The dialing plan exists in the sw
database. You must reflect the dialing plan settings when you configure 
CallPilot for networking.

Ask the administrator who is responsible for the switch configuration to prov
this dialing plan information.

Create the messaging network representation
You need information about the other sites in the messaging network to cre
messaging network representation.

You must create a detailed representation. This representation, which is yo
blueprint for implementation, shows the relationship between all sites.

Configure the switch
The switch must be set up and configured at your site before you begin to 
implement Enterprise Networking. However, you must check the configurat
and ensure that it is properly configured for Enterprise Networking.

The only additional switch configuration necessary for Enterprise Networkin
the creation and setting of phantom DNs.
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Configure CallPilot
The network database contains information about your messaging network
When you configure CallPilot, you add information to the network database
You must add the following information to configure CallPilot:

■ general information about the message delivery configuration

■ detailed information about the local site: information about how the ser
handles messages and how the switch handles messages

■ detailed information about each remote site that communicates with th
local site using Enterprise Networking

Validate the configuration
When you implement Enterprise Networking, you add configuration 
information about the messaging servers and switch locations to your netw
database.

Before you add this information, CallPilot validates the information to ensur
that there are no conflicts.

Keep records
As you plan and implement Enterprise Networking, it is important to mainta
detailed records about your site.

These records

■ provide a source of information for support personnel

■ share information about the site with other network administrators

Test the network
When you complete the configuration of Enterprise Networking, you perform
test suite. This test suite ensures that the configuration is correct and that 
Enterprise Networking is working properly.
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Backup the network
When you successfully complete the test suite, you perform a backup. The
backup ensures that no configuration information is lost in the event of syst
failure.

See also
If you need additional information about the general implementation proces
consult the Networking Planning Guide.

The Networking Planning Guide provides a more detailed discussion about th
preliminary requirements, how to create network diagrams, and how to main
a network history.
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Implementation in a complex messaging 
network

Introduction
Enterprise Networking is usually part of a complex messaging network that
combines several CallPilot networking solutions.

Order of implementation
If you are implementing any other CallPilot networking solutions on your sit
you will make the process easier to understand and manage by following th
correct order of implementation.

The implementation of each networking solution builds upon earlier 
implementations. Information is often configured only once, and all subsequ
networking solutions that are implemented use this configuration.

Recommended order
The recommended order for implementation is

■ Network Messaging Service (NMS), if the local site is an NMS site

■ Integrated AMIS Networking

■ Enterprise Networking

■ VPIM Networking

AMIS Networking
If your local site exchanges messages with both integrated and open sites,
implement Integrated AMIS Networking only. Integrated AMIS Networking 
also contains the functionality of AMIS Networking.
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How Enterprise Networking works

In this section
About Enterprise Networking messages 78

About Enterprise Networking parameters 80

Understanding Enterprise Networking settings 84
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About Enterprise Networking messages

Introduction
You use Enterprise Networking to exchange messages among the sites in 
messaging network. When you implement Enterprise Networking, you 
configure the system to handle these messages in a particular way.

An understanding of the basic components of a message makes the 
implementation process and configuration of CallPilot easier to understand

Contents of an Enterprise Networking message
Every Enterprise Networking message contains two parts:

■ a message header

■ the message body

Message header
The message header transmits to the receiving site with  DTMF signals. Th
header contains the following information:

■ the sender’s address (which may include the site or location ID, mailbo
number, and text name, depending on how the features are enabled)

■ each recipient’s address (site or location ID, mailbox number)

■ the type of message (regular, acknowledgment, or non-delivery 
notification)

■ the time and date when the message was sent

■ the message priority applied to the message (private, urgent, or 
acknowledgment)
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Message body
The recorded message and spoken name are played over the voice port of
sending site and are recorded by the receiving site. The recorded message
contains the following information:

■ the voice portion of the message

■ any attachments

Note: The recorded message can optionally include a spoken name if this 
feature is enabled.

Message priorities
The sender can assign a message priority to Enterprise Networking messa
There are three message priorities:

■ economy

■ standard

■ urgent

One message priority, usually standard, is the default. Users must assign an
message priority manually.

Configuration required for each message priority
The message priority that is assigned to a message determines how CallPi
handles the message.

When you implement Enterprise Networking, you configure the scheduling 
parameters that determine how messages with different message priority a
handled.

In general, you send economy messages during lower long-distance toll ch
periods. You send urgent messages quickly, with the emphasis on speed ra
than cost.
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About Enterprise Networking parameters

Introduction
You set Enterprise Networking parameters during the implementation proce
These parameters work with internal CallPilot settings to control how Enterp
Networking works.

Before you begin the implementation process, you must understand these 
parameters and decide on their settings.

Parameters set during implementation
CallPilot uses scheduling parameters to determine when to send messages
remote sites. CallPilot uses the following scheduling parameters:

■ batch threshold

■ stale times

■ economy message priority delivery start and stop times 

Parameter default values
CallPilot provides default settings for all scheduling parameters. The defaul
values are based on typical requirements.

To ensure a quick implementation process, use these default values.

After your system is operational, monitor usage to determine if the default 
settings are serving the needs of your users. You can modify the schedulin
parameters whenever users’ needs change.

For all default values, see Defaults on page 136.
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Batch threshold
The batch threshold is the number of standard and urgent messages that a
in queue waiting for delivery to a single remote site. When you send messag
batches, you make more efficient use of system resources. However, to en
that messages awaiting delivery are not held too long in queue, the hold tim
overrides the batch threshold.

A message is held in a batch until either the batch threshold is exceeded or
hold time for standard or urgent messages is reached.

Batch thresholds only apply to standard and urgent messages.

Holding time
Holding time is the period of time that a message is held in queue before 
CallPilot attempts delivery. CallPilot holds a message in queue while it awa
the arrival of more messages for the same destination. This bulk sending m
more efficient use of the system.

However, to ensure that messages are always delivered in a timely fashion
do not wait too long for the arrival of additional messages, they are held for 
a set period of time. This is the holding time.

CallPilot computes the holding time internally, based on the stale time.

Standard message holding time
The holding time for standard messages is one-third of the stale time for 
standard messages.

Urgent message holding time
The holding time for urgent messages is one-tenth of the stale time for urge
messages.
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Stale time
Stale time determines how long an undelivered message is held within the 
system before being returned to the sender with a non-delivery notification 
(NDN).

Stale times are set independently for economy, standard, and urgent mess
Typically, the stale time for an urgent message is shorter than that of a stan
message because it may be critical for a user to know that an urgent messag
not delivered.

The following examples are based on an Enterprise Networking site that use
default values.

Example 1
Milo Feinstein sends a standard message. The message is held in the queu
awaiting the arrival of three more messages. However, when the message 
waited in queue for 40 minutes (the holding time for standard messages), th
message is sent.

Example 2
Ronnie Prakesh and Philippe Dumont are users at the same site. Ronnie s
three standard messages for users at the remote site in Newmarket. Her 
messages are held in the queue. Philippe sends a message to a user at the
remote site. The batch threshold is reached, and all four messages are sen

Example 3
Barney Gumbolski sends an urgent message. It is held in queue. No other 
messages for the same remote site arrive within six minutes (the holding tim
urgent messages). Barney’s urgent message is sent.
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Economy delivery start and stop times
Economy messages receive different treament from standard and urgent 
messages. Economy messages are collected and are sent only during desi
times, rather than held in queues.

The delivery start and stop times determine when the system sends econom
messages to their destinations.

Economy messages often have a start time set to the beginning of lower-ra
telephone services, and a stop time set to the resumption of regular rates.

Example
The following example is based on an Enterprise Networking site that uses
current default values.

At 8:00 a.m., Marge Sampson sends an economy message to a remote site
message is held in queue until the economy delivery start time. The messa
held in queue for a total of 16 hours. The economy message stale time is la
enough to take this into account.
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Understanding Enterprise Networking settings

Introduction
In addition to the scheduling parameters, you must configure other settings w
you implement Enterprise Networking.

These settings include

■ Enterprise site IDs

■ initiating and responding passwords

■ dialing plans

You must determining these settings in cooperation with the network 
administrators of all sites. The settings must be decided on before any site 
implemented.

Enterprise site ID
If you implement Enterprise Networking on your local site, every remote site
your network database requires an Enterprise site ID.

All site IDs must be unique. Therefore, you need to coordinate with remote
network administrators to ensure that this rule is observed before any site i
implemented.

Initiating and responding passwords
Enterprise Networking uses passwords to send messages securely. When 
message is sent from one site to another, the two sites trade two password
initiating password and a responding password. Both passwords must matc
before a message is sent.

You establish passwords between pairs of sites. For this reason, you must c
the network administrator of each remote site in the messaging network an
agree on the passwords that will be used.
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Example
The following diagram shows how passwords in network databases must m
Simple passwords are used for illustrative purposes.

The administrator in Bombay had to coordinate with the administrators in To
and Tel Aviv to determine the passwords. With Tokyo, the passwords are “12
and “5678.” With Tel Aviv, the passwords are “4321” and “8765.” This 
information is added to the network database in Bombay. 

Selecting passwords
Like all passwords, the initiating and responding passwords should be care
thought out and secured. A password should be at least six characters long
combine both alphabetic and numeric characters within the ASCII set 3–12

G100953.eps

Tel Aviv Network Database

Tokyo
Initiating password: 1234
Responding password: 5678

Bombay
Initiating password: 4321
Responding password: 8765

Bombay Network Database

Tokyo
Initiating password: 1234
Responding password: 5678

Tel Aviv
Initiating password: 4321
Responding password: 8765

Tokyo Network Database
Bombay
Initiating password: 1234
Responding password: 5678

Tel Aviv
Initiating password: 8877
Responding password: 9911

"4321" "8765"

"8877" "9911"

"1234" "5678"
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How Enterprise Networking handles 
messages

In this section
Overview 88

What the MTA does 90

What the ANA does 93

How a message is transferred 94
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Overview

Introduction
The scheduling parameters that you configure during the implementation o
Enterprise Networking work in conjunction with internal CallPilot networking
settings. These internal settings are controlled by

■ Message Transfer Agent (MTA)

■ Analog Networking Agent (ANA)

This brief overview provides a general understanding of how Enterprise 
Networking handles messages to help you interpret Alarm and Event repor

MTA responsibilities
The MTA is responsible for the following services:

■ Queue outgoing network messages.

■ Determine when to begin sending messages to a remote system.

■ Receive incoming messages for delivery to local users.

■ Collect networking traffic operational measurements (OMs).

To ensure the timely handling of messages, the MTA wakes up CallPilot ev
minute.

When it wakes up, the MTA does the following:

■ initiates calls to remote sites

■ checks for stale messages

■ checks if any sites are in error status

MTA Monitor
The MTA Monitor continuously watches the performance of the MTA. The 
MTA Monitor provides detailed information and is useful for regular 
maintenance and troubleshooting. 

For complete information about the MTA Monitor and how it is used, consult
relevant section in System Support Tools.
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ANA responsibilities
The ANA sends messages to and from remote systems.

There is one ANA for every active port used during an Enterprise Networkin
session.

Main steps of message transfer
There are three main steps in the message transfer process:

■ The Message Transfer Agent determines if the message is ready for 
transfer.

■ The Analog Networking Agent completes a communication process, 
known as handshaking, with the receiving site.

■ The message, consisting of the message header and the message bod
transferred.
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What the MTA does

Introduction
The Message Transfer Agent (MTA) handles most aspects of message 
transmission for CallPilot.

 How MTA and ANA handle messages
The following diagram is a graphical representation of how CallPilot handle
Enterprise Networking messages.
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The diagram shows the activity of both the MTA and the ANA in message 
handling.

G100969.eps
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As the diagram indicates, the MTA handles most of the processing. Every 
minute, a scheduler wakes the MTA. The MTA scans the message queue f
each destination and checks the status of messages awaiting delivery. This
determines if there are valid messages, according to the system parameter
configuration. The MTA then determines if the valid messages are ready fo
delivery, according to the set system parameters.

Once the MTA determines that a transmission session is needed, it seeks a
method of delivery from the call router. The ANA assumes responsibility for
delivering the message.
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What the ANA does

Introduction
The Analog Networking Agent (ANA) works with the MTA to handle message

How the ANA sets up calls
The ANA calls a remote site and delivers messages. 

CallPilot originates a network call to the receiving site using the connection
directory number (DN) defined for that site. The switch places the call accord
to switch call-processing parameters.

If the call is successful, the call terminates on the networking connection DN
the receiving site.

If the call is not successful
If the call fails due to a busy or no-answer condition, CallPilot waits until the
next wake-up interval before it attempts the call again. If three consecutive 
attempts fail, CallPilot places the receiving site into error status and an alar
generated, depending on the nature of the problem.

CallPilot waits for one hour before it repeats the three-call attempt cycle.

When connection is established
When connection between the sending and receiving sites is established, A
initiates a communication process known as handshaking.
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How a message is transferred

Introduction
After the ANA successfully establishes a message transfer session, the me
transfer begins.

The message contains the message header and the recorded message.

How the ANA sets up calls
The ANA is responsible for calling a remote site and delivering messages a
follows a complex routine. 

CallPilot originates a network call to the receiving site using the connection
directory number (DN) defined for that site. The call is placed by the switch
according to switch call-processing parameters.

If the call is successful, the call terminates on the networking connection DN
the receiving site.

If the call is not successful
If the call fails due to a busy or no-answer condition, CallPilot waits until the
next wake-up interval before attempting the call again. If three attempts in a
fail, CallPilot places the receiving site into error status and an alarm is 
generated, depending on the nature of the problem.

CallPilot waits one hour before repeating the three-call attempt cycle.

When connection is established
When connection between the sending and receiving sites is established, A
initiates a communication process known as handshaking.

Handshaking consists of the following steps:

1. The sending site identifies itself to the receiving site.

2. The receiving site verifies that the sending site is defined in the networ
database of the receiving site, and that the site ID and the message tra
protocol agree.
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If the information does not agree, the receiving site informs the sending
of the error and drops the call.

3. The sending site sends the initiating password and the receiving site ID
the receiving site.

4. The sending site also indicates that it will send a remote user text 
information if the necessary options are enabled on the site configurati
for the receiving site.

5. The receiving site checks the site ID and password:

If the information is invalid, the receiving site informs the sending site t
either the site ID or the password is incorrect, and drops the call.

If the information is valid, the receiving site proceeds to the following st

6. The receiving site determines whether remote user or message text 
information will be received during this session.

7. The receiving site sends the responding password and indicates wheth
Names Across the Network information and a text subject header will b
sent during this session.

8. The sending site checks the password:

If the password is invalid, the sending site sends an end-of-session me
and drops the call.

If the password is valid, the sending site starts the message transfer to
receiving site.

Message transfer process
After the ANA successfully establishes a message transfer session, the me
transfer begins.

The message contains the message header and the recorded message.
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The following table describes how messages are transferred:

The sending site The receiving site

sends the message information. The 
message contains the following:

■ time and date stamp

■ subject

■ message priority (private, urgent, 
or acknowledgment)

receives and intercepts the message 
information and creates the message.

sends the information about the 
sender. The information includes the 
following:

■ mailbox number, including site ID 
(and location ID if the remote site 
is using NMS)

receives and adds the sender to the 
message.

if the Remote User Add/Update 
option is selected, plays the spoken 
name.

■ records the spoken name.

■ adds or updates the remote user.

sends recipient information. The 
information includes the following:

■ mailbox number (including site 
and location ID).

■ recipient’s address as text, if the 
Receive Text Information option is 
selected.

receives and adds each recipient to the
message.

plays the message body. records the message body and adds
the message.

plays any attachments. records each attachment and adds i
the message.

indicates the end of the message. sends to the local MTA to deposit t
message in each local recipient’s 
mailbox.
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repeats all of the above for each 
message.

repeats all of the above for each 
message.

The sending site The receiving site
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Gathering information

This chapter describes how to gather the information required to implemen
Enterprise Networking. This chapter provides a checklist for all information t
is needed about the switch configuration.

This chapter also describes how to gather information about the other sites 
messaging network, and how to convert this information into a messaging 
network representation.

In this chapter 
Information required 101
Enterprise Networking Implementation and Administration Guide 99
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Information required

In this section
Overview 102 

Switch information 103

Information required from the switch 105

Evaluating the gathered information 108

Information from other sites 109

Messaging network representation 110
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Overview

Introduction
Before you begin to implement Enterprise Networking, gather the informati
that you require. You will speed up the implementation process if you have
information before you begin. When you analyze the information for 
inconsistencies and incompleteness, you ensure that potential problems ar
resolved ahead of time.

Required information
You must gather two types of information:

■ local site information, especially about the switch configuration 
information and dialing plan

■ messaging network information that is provided by all remote sites

Why gather information?
The gathered information is used to

■ identify the sites in the messaging network

■ identify how the sites relate to each other

■ identify the dialing plan used by each switch in the network

■ determine if the dialing plan on one or more switches in the network m
be modified to support the networking solutions of CallPilot

■ create a messaging network representation

■ prepare for CallPilot configuration
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Switch information

Introduction
When you begin to implement of Enterprise Networking, the switch is alrea
correctly installed and configured, and is operational for CallPilot.

This means that the switch is set up for dialing between the sites in the 
messaging network. The dialing plans that are configured on the switch for 
making telephone calls between sites are also used to exchange messages
between sites.

You must check the configuration to make sure it is suitable for Enterprise 
Networking.

Gathering dialing plan information
You need the dialing plan information that is configured on the switch. You m
know the dialing plan used in the messaging network and how all sites dial 
other.

The easiest way to gather this information is to ask the switch technician or
system administrator.

Gathering information directly from the switch
Gathering information directly from the switch is not recommended. The 
information that you require is found on several switch configuration files ca
overlays. Finding the information can be difficult and time-consuming. 

If you must gather the information from the switch, consult your switch 
documentation for the proper procedures and detailed descriptions of the 
information in each overlay.
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Confirming settings
Usually, when the switch is configured, the switch technician addresses the
impact of messaging on the switch.

However, to ensure that there will be no problems, you must confirm that th
configuration suits the needs of Enterprise Networking and can handle you
anticipated volume of traffic.

If you discover that changes are necessary, you must complete these chan
before you proceed with the implementation of Enterprise Networking.
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Information required from the switch

Introduction
You must gather information from the switch. You must verify that the switc
supports networking. You use some of the information, such as dialing plan
information, to configure CallPilot.

Gather information from

■ the local prime switch location

■ the remote switch locations (prime and satellite)

Note: If the local site is an NMS site, you must also gather information from
each satellite switch location. For instructions on how to gather this informat
consult the NMS Implementation and Administration Guide.

Gather information about used features only
Most of the information that you gather from the switch is related to the dial
plan.

Gather information about a dialing plan only if a dialing plan is being used. 
not gather the information if the dialing plan is installed on the switch but is 
currently being used.

Example: Your switch has both ESN and CDP installed. However, only ESN
used. Do not gather CDP information.
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Local prime switch location checklist
You need the following information from the switch configuration:

■ name or physical location of switch (useful to name the switch location
CallPilot)

■ dialing plan used:

● Electronic Switched Network (ESN)

● Coordinated Dialing Plan (CDP)

● hybrid dialing plan, combining ESN and CDP

● another dialing plan, such as public switched telephone network (PS

■ if ESN or hybrid dialing plan is used:

● ESN access code

● ESN location codes:

- local switch location

- remote switch locations

● overlap of location codes with extension numbers

■ if CDP or hybrid dialing plan is used:

● CDP steering codes:

- local switch location

- remote switch location

● overlap of steering codes with extension numbers

■ confirmation that sufficient trunks are available for anticipated networki
traffic

■ confirmation that restrictions are suitable for networking (for example, 
trunk group access restrictions [TGAR])

■ range of extension numbers used at the local site (for example, 7000–7

■ information about existing CDNs and phantom DNs that are defined on
switch
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Remote switch location information checklist
For each remote site in the messaging network, you need the following 
information about each switch location (prime and satellite):

■ name or physical location of switch (useful to name the switch location
CallPilot)

■ dialing plan used:

● Electronic Switched Network (ESN)

● Coordinated Dialing Plan (CDP)

● hybrid dialing plan, combining ESN and CDP

● another dialing plan, such as public switched telephone network

■ if ESN or hybrid dialing plan is used:

● ESN access code

● verify the ESN location codes:

- local switch location

- remote switch locations

● overlap of location codes with extension numbers

■ if CDP or hybrid dialing plan is used:

● CDP steering codes:

- local switch location

- remote switch location

● overlap of steering codes with extension numbers

■ range of extension numbers used at the local site (for example, 7000–7

■ confirmation that all extension numbers at this switch location can be 
dialed directly from the local switch

■ confirmation that all extension numbers at this switch location can be 
dialed in the same way
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Evaluating the gathered information

Introduction
When you have the dialing plan information from all switches in the messag
network, review the information to ensure that you do not have to make any
changes to switch configurations.

Mandatory requirement
The dialing plans of all switches in the network must have a uniform, or 
standardized, dialing plan.

A uniform dialing plan means that users on all switches dial the same way t
reach the same recipient. 

There is only one exception to this rule: ESN access codes can be differen

You need a uniform dialing plan to dial users on other switches within the 
messaging network and at public sites.

A uniform dialing plan offers the following benefits:

■ The network is easier to configure and maintain.

■ Future growth of the network is allowed.

Configuring dialing plan information
You need extensive switch programming experience to configure dialing pla
information on a switch.

See also
You can find detailed information on dialing plan configuration in your switc
documentation.

ATTENTION! If you determine that changes to the dialing plan 
configuration are necessary, ask a switch technician to 
confirm your conclusion and make the necessary change
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Information from other sites

Introduction
Implementation of a networking solution is a coordinated effort. Many decisi
must be made before implementation begins.

Gather the following information before you begin to implement Enterprise 
Networking:

■ site names

■ Enterprise site IDs

■ fully qualified domain names (FQDNs) of servers

■ the protocol used between the local site and all remote sites

■ the dialing plan used between the local site and all remote sites

■ connection DNs for each site that uses the AMIS protocol to exchange
messages with the local site

If any remote sites are NMS sites, also gather the following information for e
satellite switch location:

● switch location name

● switch type

● location ID

■ passwords—each site must decide on the initiating password and the 
responding password that is used with every other site
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Messaging network representation

Introduction
A messaging network representation provides a complete summary of your
messaging network. This representation contains information about each o
sites and indicates the relationship between each pair of sites.

If sufficiently detailed, a messaging network representation is the primary so
of information for implementing a messaging network.

The more detail you can supply, the easier you will find the implementation
process.

A diagram is the most suitable form of representing most messaging netwo
A spreadsheet is more appropriate for large messaging networks.

Definition: Messaging network diagram
A messaging network diagram is a graphical representation of your network
includes the following types of information:

■ all sites in the network 

■ the protocols implemented at each site

■ the protocol used between sites

■ location codes and names

■ dialing plan information

Definition: Messaging network spreadsheet
A spreadsheet is more appropriate for representing a large messaging netw
provides the same information as the diagram.
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Benefits
There are many benefits to creating a representation of your messaging net
A representation

■ offers a clear view of how your network is connected

■ gathers all information required to implement a networking solution in o
source

■ provides useful information when you plan future modifications

■ helps during the analysis of traffic issues

■ reveals areas where you can improve the network

■ provides support personnel with a concise, clear view of your network

Coordinating efforts
Administrators of other sites must provide much of the information for your 
network representation. For example, you need to know the site name and 
information of every site.

Although each site administrator creates a representation, ideally one site 
administrator should create a final version to distribute to all sites. This ens
that the representation is comprehensive and that each site uses the same
information for implementation.

Protecting the representation
Your network representation contains sensitive information. Keep it properl
stored and protected as part of standard security procedures.

See also
For detailed instructions on how to create a network representation, as wel
for several examples, consult the relevant section in the Networking Planning 
Guide.
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Configuring the switch for Enterprise 
Networking

This chapter describes how to configure the switch to implement Enterprise
Networking. The chapter introduces the concepts that are necessary to 
understand the configuration process and provides detailed configuration 
procedures.

In this chapter
Configuring the switch 115
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Configuring the switch

In this section
Overview 116

SDN Table and Enterprise Networking 118

Adding and configuring SDNs 124

Phantom DNs and Enterprise Networking 128
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Overview

Introduction
The switch provides the call handling for CallPilot.

When you implement Enterprise Networking, the switch is already installed 
configured, and is operational. It is ready for the implementation of Enterpri
Networking.

There are two steps in the configuration process. On the server, you must s
inbound and outbound service directory numbers (SDNs) for Enterprise 
Networking. On the switch, you must set up phantom directory numbers (D

Before you begin
Review the information that you gathered. Confirm the settings to ensure th
they are correct. 

Before you begin to implement Enterprise Networking, complete and test a
required changes to the switch settings.

How the switch views an Enterprise Networking call
The switch handles an Enterprise Networking message from the local site t
remote site like any other outbound telephone call.

The switch is already configured to handle outbound telephone calls. For th
reason, Enterprise Networking is just an incremental implementation.

Enterprise Networking requirements
Like all services, however, Enterprise Networking needs a route that conne
the messaging server and the switch.

Enterprise Networking requires only one additional configuration on the swi
A phantom DN is required for Enterprise Networking.
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See also
For detailed information about the switch, consult your switch documentatio

For information about how CallPilot works with the switch and how the swit
must be configured, consult the relevant section in the Advanced Administration 
Guide.
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SDN Table and Enterprise Networking

Definition: SDN
A service directory number (SDN) is a number that enables a user to acces
CallPilot service. Each SDN must be unique so that CallPilot can identify th
requested service and play the appropriate prompts.

SDN Table
The system automatically creates the Service Directory Number Table duri
the initial installation of CallPilot. The SDN Table lists all SDNs and provide
details about their settings.

CallPilot uses the SDN Table to map directory numbers (DNs) to services. 
SDN Table lists both inbound and outbound SDNs.

Inbound and outbound SDNs
CallPilot requires both inbound and outbound SDNs. 

You must manually add an inbound SDN. An outbound SDN is created 
automatically if Enterprise Networking is installed. Both the inbound and the
outbound SDNs require additional configuration.

Inbound SDNs
For most services, an inbound SDN is a number that a user enters to acces
service. However, the Enterprise Networking inbound SDN is not a directly 
dialable number. A remote system dials this SDN when it delivers an Enterp
Networking message.

Outbound SDNs
CallPilot uses an outbound SDN to make the requested service available. A
outbound SDN consists of the word OUTBOUND and a number.
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Example: SDN Table
The following illustration shows an SDN Table that lists both inbound and 
outbound Enterprise SDNs.

If another service shares the inbound Enterprise SDN, that service appears
SDN Table. 

When you review an SDN Table, the only way you know if an SDN is share
by the description. For this reason, the description of the SDN should ment
that it is shared with the inbound Enterprise Networking SDN.
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SDN numbers
An SDN must be unique, but it is not randomly selected. CallPilot uses SDN
map numbers to services. There are also important relationships between t
SDN and other numbers used by the system.

Relationship of SDN to other numbers
The CallPilot SDN setup echoes the DN settings on the switch.

An important relationship exists between the inbound SDN and the local sys
access number (SAN), and the phantom DN on the switch. For example,

■ The inbound Enterprise Networking SDN = 7400.

■ The Enterprise Networking local SAN = 1-416-597-7400.

■ The phantom DN for Enterprise Networking = 7400.

The Enterprise Networking inbound SDN on CallPilot must correspond to th
Enterprise Networking phantom DN on the Meridian switch. Before you cre
an SDN for Enterprise Networking, confirm the phantom DN on the switch.

To view the phantom DN setting, consult the gathered switch information.

Phantom DNs
There are two ways to create an Enterprise Networking phantom DN on the
switch:

■ Define a new phantom DN for Enterprise Networking.

■ Share an existing phantom DN of specific services.

Media type
To process a call, Enterprise Networking needs access to a channel. A cha
provides a connection between the switch and the Digital Signal Processor
(DSP) cards on the CallPilot server.

CallPilot supports three channel types. Each type corresponds to different 
media:

■ voice

■ fax

■ speech recognition
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Enterprise Networking can use all three channel types. However, a voice cha
is recommended. By default, CallPilot automatically assigns a voice port to
Enterprise Networking.

Minimum and maximum channels
You must determine the channel resources for both inbound and outbound
Enterprise Networking SDNs.

Every service, including Enterprise Networking, requires channel resources
process calls. Channel resources are the number of channels that Enterpris
Networking has available. Channel resources are set as minimum and max
values. The minimum value is the number of channels that is always reserve
the exclusive use of the service.

This setting is important because if you incorrectly allocate channel resourc
users may experience delays in reaching requested services.

Example: Channel allocation
Your system has 96 available channels. You decide to dedicate a minimum
channels and a maximum of 30 channels to Enterprise Networking. If the sy
handles only five Enterprise Networking calls each day, more appropriate 
allocation is a minimum of 1 channel and maximum of 3 channels.

Examples: How to use inbound and outbound Enterprise Networking 
SDNs

The following examples describe a network that consists of two sites, and s
how to use the inbound and outbound Enterprise Networking SDNs to prov
services. 

In these examples, it is important to distinguish between messages sent by
and calls made by the CallPilot system itself.
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Example 1: Shared SDN
This example describes how to use a shared inbound SDN.

Howard wants to send a message to Joy in Chicago. He enters 6060, whic
directed to the SDN for Integrated Voice/Fax. The request is directed to 
CallPilot, which routes it to the outbound Enterprise Networking SDN. The 
system in Philadelphia calls the remote SAN of the system in Chicago, 
64447080, and the two systems complete the required handshaking before
message is transferred. 

The Voice Menu SDN, which is shared with the inbound Enterprise Network
SDN, receives the message. The Voice Menu SDN is set to act when it rec
an AMIS initiator tone. The message is directed to Joy’s mailbox.

G100993.eps

SDN Service

6060 Integrate Voice/Fax
6070 Announcement
6080 Inbound Enterprise

Outbound Enterprise 10

SDN Service
7070 Integrated Voice/Fax
7075 Express Messaging
7079 Fax on Demand
7080 Voice menu
        (acts on Enterprise initiator tone)

Outbound Enterprise 10

Joy Howard

MAS
Server

MAS
Server6444xxxx

6338xxxx

SAN = 64447080

SAN = 63386080
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Example 2: Unique SDN
This example describes how to use an inbound Enterprise Networking SDN
is not shared.

Joy wants to send a message to Howard in Philadelphia. She enters 7070, 
is directed to the SDN for Integrated Voice/Fax. The request is directed to 
CallPilot, which routes it to the outbound Enterprise Networking SDN. The 
system in Chicago calls the remote SAN of the system in Philadelphia, 
63386080, and the two systems complete the required handshaking before
message is transferred. The inbound Enterprise Networking SDN receives 
message and directs it to Howard’s mailbox. 

See also
For detailed information on SDNs and SDN Tables, consult the Advanced 
Administration Guide.

G100991.eps

SDN Service

6060 Integrate Voice/Fax
6070 Announcement
6080 Inbound Enterprise

Outbound Enterprise 10

SDN Service
7070 Integrated Voice/Fax
7075 Express Messaging
7079 Fax on Demand
7080 Voice menu
        (acts on Enterprise initiator tone)

Outbound Enterprise 10

Joy Howard

MAS
Server

MAS
Server6444xxxx

6338xxxx

SAN = 64447080

SAN = 63386080
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Adding and configuring SDNs

Enterprise Networking SDNs
Enterprise Networking requires an outbound SDN and an inbound SDN.

Outbound SDN
An outbound SDN is created automatically when you install Enterprise 
Networking. You can modify the default channel resource allocation.

Inbound SDN
An inbound SDN is not created automatically. There are two ways to set up
inbound SDN:

■ Create a new inbound SDN.

■ Share an inbound SDN with certain other services.

The choice depends on your administrative requirements.

Services that can share an inbound SDN with Enterprise Networking
Enterprise Networking can share the inbound SDN of the following services

■ Announcement Service

■ AMIS Networking

■ Fax Information Service

■ Voice Menu

■ Time of Day Controller

■ Thru-Dial

Do this If the primary concern is

Create new SDNs. Operational Measurement reports must be 
precise for each service.

Share SDNs with other 
services.

a shortage of DNs exists or is likely to exist.
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Getting there  Nortel SMI > Meridian Application Server > System Configuration 
> Service Administration > Service Directory Number

To add and configure a new inbound SDN

1 From the SDN Table, select New from the File menu.

Result: The New Inbound Service Directory Number Properties dialog box 
appears.

2 On the General tab, enter the SDN number in the Service DN box.

Note: This number must correspond to a CDN or phantom DN on the 
switch.

3 Select an application from the Application Name list.

Result: The corresponding application ID appears above the application 
name in the Application ID box.

4 Select the type of channel required by the service in the Media Type list.
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5 If you want to reserve a minimum number of channels for the service, enter 
the number in the Minimum Channels box.

6 Do one of the following:

● Select the Use Default Maximum box. This is the recommended option.

● Enter the maximum number of channels that a service can use at one 
time in the Maximum Channels box.

Note: The maximum number of channels cannot exceed the total number 
of channels available on the server. If you enter a number larger than the 
total number of channels, a warning box appears asking you to change the 
number.

7 Enter any comments in the Comments box.

8 Click Save to add the SDN to the SDN Table.

To share an existing inbound SDN with Enterprise Networking

1 Select an existing inbound SDN that can be shared with Enterprise 
Networking from the SDN Table.

2 On the File menu, click New.

Result: The New Inbound Service Directory Number Properties dialog box 
appears.

3 On the General tab, in the Comments box, insert a brief comment that the 
SDN is shared with Enterprise Networking. 

Tip: This comment appears in the final column of the SDN Table and is the 
easiest way to determine which SDN is shared with Enterprise Networking.
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4 Click the Session Profile tab.

Result: The Session Profile tab appears.

5 Select Act on AMIS/Enterprise networking initiator tone. You select this 
option only for the SDN that is being shared with the inbound Enterprise 
SDN.

6 Click Save to add the shared SDN to the SDN Table.
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Phantom DNs and Enterprise Networking

Switch setting required for Enterprise Networking
SDNs on the server have a direct correspondence to phantom directory num
(DNs) on the switch.

If you create a new SDN for Enterprise Networking, you need a phantom DN
Enterprise Networking. If you share an existing SDN for Enterprise Network
with an existing service, Enterprise Networking also shares the phantom DN
that service.

Enterprise Networking uses DNs
To access a CallPilot service, a user enters a unique dialable number. The
dialable number is known as a directory number (DN). There are different ty
of DNs, including extension numbers and telephone numbers. 

The switch uses the DN to route the call to the requested service.

Example 
A user enters a DN, 7505, to access Remote Notification.

Switch and DNs
All DNs that you use to access a service correspond to a setting on the switc
handle calls in sequence of arrival, the system places calls in a queue, depe
on the call type.

The switch has as many as three queues, called controlled directory numbe
(CDN) queues, which you use for the following types of services:

■ Voice Messaging

■ Fax Call Answering

■ Speech Recognition Messaging

Each CDN queue is associated with a dialable number known as the CDN.
user can dial the service directly by entering the CDN.
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Example
The CDN of Voice Messaging is 7400. A user can dial 7400 to reach Voice
Messaging. The call is placed into the queue.

Phantom DNs
While there are queues for three types of services, CallPilot users usually h
many individual services available within each type. These services are als
dialable.

To offer more than three services, the switch uses phantom DNs.

A phantom DN is a unique dialable number that is routed to one of the CDN
queues.

A phantom DN is not a randomly selected number. There is a direct 
correspondence between the local system access number (SAN) for Enterp
Networking and the phantom DN.

If Enterprise Networking shares an existing phantom DN, check that the 
phantom DN is configured to forward messages to the correct CDN queue.
Enterprise Networking, the phantom DN should forward messages to the V
Messaging CDN queue.

Example
The phantom DN for Express Messaging is 7401. A user dials 7401 and ex
to reach the requested service. However, the switch routes the phantom DN
the appropriate CDN queue (in this case, Voice Messaging) before the serv
provided.

Enterprise Networking phantom DN
Enterprise Networking requires a phantom DN for incoming messages.

However, unlike other phantom DNs, it is not dialed by a local user when 
addressing an Enterprise Networking site. The system uses this number wh
Enterprise Networking message must be sent to a remote site.

Users at remote sites also use the phantom DN when they make a call to a
system.
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Ways to create the phantom DN
There are two ways to create a phantom DN for Enterprise Networking:

■ Use a unique phantom DN. Most switch technicians create additional 
phantom DNs for use by services like Enterprise Networking.

■ Share an existing phantom DN. If Enterprise Networking shares a serv
directory number (SDN) with another service, it also shares the phanto
DN of the service.

See also
For a detailed description of how the switch is configured for CallPilot, cons
the relevant section in the Advanced Administration Guide.
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Configuring CallPilot for Enterprise 
Networking

This chapter describes how to configure CallPilot to implement Enterprise 
Networking.

The chapter introduces the concepts that are necessary to understand the 
configuration process and provides detailed descriptions of configuration 
procedures.

In this chapter
Configuring CallPilot 133
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Configuring CallPilot

In this section
Overview 134

Configuration summary 135

Message delivery parameters—Enterprise tab 138

Configuring the message delivery parameters 141

Creating a loopback mailbox 143
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Overview

Configuring CallPilot
The implementation of Enterprise Networking requires additional configurat
of CallPilot. This configuration determines how Enterprise Networking 
exchanges messages with other sites in the messaging network.

To configure CallPilot for Enterprise Networking, you must

■ confirm CallPilot administration settings

■ define Enterprise Networking information

■ create a loopback mailbox

Before you begin
Complete the switch configuration before you configure CallPilot.

ATTENTION! You must perform each step in the configuration proce
in the order presented.
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Introduction
The Enterprise Networking message delivery configuration determines how
Enterprise Networking handles messages.

You provide this information on the Enterprise tab of the Message Delivery
Configuration dialog box.

Required information
When you complete the Enterprise tab, the following are required:

■ enabled outgoing and incoming Enterprise Networking

■ batch threshold

■ economy delivery times

■ stale times

See also
A general overview of how Enterprise Networking uses this information is 
provided in Chapter 2, Getting started.
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Defaults
CallPilot provides default settings for the message delivery configuration. T
default values are based on typical requirements.

To simplify the process of implementing Enterprise Networking, use the def
values. After your system is operational, monitor usage and performance to
determine if the default settings are sufficient. You can change the settings
whenever users’ needs change.

Parameter Current default

Batch threshold 4 messages

Stale time for standard messages 2 hours

Holding time for standard messages 40 minutes (calculated internally, bas
on stale time settings)

Stale time for urgent messages 60 minutes

Holding time for urgent messages 6 minutes (calculated internally, base
stale time setting)

Stale time for economy messages 6 hours

Delivery start time for economy 
messages

6:00 p.m.

Delivery stop time for economy 
messages

11:00 p.m.
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Suggested process
Read through this section on how to configure Enterprise Networking 
information. The settings that you select determine how efficiently your sys
handles Enterprise Networking messages.

Ideally, know how you are going to complete the required information befor
you begin the configuration.

Before you begin
You must properly configure the inbound and outbound SDNs for Enterpris
Networking before you configure Enterprise Networking.
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Message delivery parameters—Enterprise tab

Introduction
To implement Enterprise Networking you must set the parameters that Call
uses to deliver messages.

These parameters are set on the Message Delivery Configuration dialog bo
Enterprise tab. 

Outgoing and incoming Enterprise networking
If Enterprise Networking is installed on your system, the following options a
enabled by default:

■ Outgoing Enterprise Networking

■ Incoming Enterprise Networking
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These boxes restrict the use of Enterprise Networking.

If you do not want local users to send outbound Enterprise Networking 
messages, clear the Outgoing Enterprise Networking option.

If you do not want local users to receive inbound Enterprise Networking 
messages, clear the Incoming Enterprise Networking option.

To completely disable Enterprise Networking, clear both options.

Batch Threshold
When you batch messages, you send messages that are intended for a sin
destination in a group. This method makes more efficient use of the system
if you send each message separately.

The batch threshold defines the maximum number of messages intended fo
single destination that can be queued before CallPilot begins to send the 
messages.

The batch threshold applies only to standard and urgent message types.

The batch threshold overrides the CallPilot holding times.

Economy delivery start and stop times
An economy message is a message that a user tags for economy delivery.

Economy messages are treated differently from standard and urgent messa
Economy messages are not held in queues. Instead, they are collected thro
the day and are sent only during designated times. The delivery start and s
times determine when the system begins to send economy messages to th
destinations.

Economy messages often have a start time set to the beginning of lower-ra
telephone services, and a stop time set to the resumption of regular rates.

Example
If the telephone rate is lower between 11:00 p.m. and 6:00 a.m., set the star
at 11:00 p.m. and the stop time at 5:55 a.m.
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Stale times
Stale time is the period of time that CallPilot holds an undelivered message
before it considers the message undeliverable and returns it to the sender w
non-delivery notification (NDN). In the period before a message is consider
stale, CallPilot makes repeated attempts at delivery.

Stale time is expressed as a time period, such as 10 minutes or 5 hours.

Separate stale times are set for economy, standard, and urgent messages.
stale time for urgent messages should be the shortest time, because it is cr
to know if an urgent message is not delivered.

Stale time settings affect holding times
CallPilot uses stale time settings to calculate holding times. 

The holding time is the period of time that a message is held in queue befo
attempt is made to send it.

Urgent messages
For urgent messages, the holding time is one-third of the stale time.

For example, if you set the urgent stale time to 30 minutes, the urgent mes
holding time is automatically set to 10 minutes. 

Standard messages
For standard messages, the holding time is one-tenth of the stale time.

For example, if you set the standard stale time to 5 hours, the standard me
holding time is automatically set to 30 minutes.

Holding times interact with the batch threshold
The interaction of the holding time and the batch threshold ensures that 
messages are delivered in a timely and efficient manner. A message is sent
the batch threshold is reached or when the holding time is reached—which
is sooner.
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Configuring the message delivery parameters

Introduction
You must configure the parameters that determine how your system handle
messages.

You configure these parameters on the Message Delivery Configuration dia
Enterprise tab.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > Message 
Delivery Configuration > Enterprise tab

To configure Enterprise Networking parameters

1 To enable your site to send outgoing Enterprise Networking messages, 
ensure the Outgoing Enterprise Networking check box is selected.

2 To enable your site to receive incoming Enterprise Networking messages, 
ensure the Incoming Enterprise Networking check box is selected.

3 Enter the batch threshold in the Collect (number of) messages before 
sending (Batch Threshold) box.

4 Enter the economy delivery start and start times in the Start Time and Stop 
Time boxes.

5 Enter the stale times for each message type:

● Standard

● Urgent

● Economy

6 Click Save.

Result: The information is validated and entered into the network 
database.
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What’s next?
After configuring CallPilot for Enterprise Networking, you must complete on
basic administrative activity. Every site in the messaging network requires a
loopback mailbox.

Although it is not mandatory to complete this administrative task at this time
is recommended.
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Creating a loopback mailbox

Introduction
When you implement Enterprise Networking, create a loopback mailbox. 
Although it is not mandatory to create the loopback mailbox at this time, 
completing this task now will save you considerable time later.

Definition: Loopback mailbox
A loopback mailbox is a mailbox that is created at each site in a messaging
network. You use a loopback mailbox to test the capability of a site.

To test that a site can send a message to a remote site, a message is sent
loopback mailbox. The loopback mailbox automatically returns the messag
the sender.

Remote sites use your loopback mailbox to test their systems. You use the
loopback mailboxes of each remote site to test your system.

Since each site requires a loopback mailbox, create one now so that the te
can proceed without interruption.

Loopback mailbox requirements
A loopback mailbox is not a real mailbox because it does not collect messa
It bounces messages back to the sender. However, the loopback mailbox nu
must be unique and cannot conflict with any other mailbox number.
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Getting there  Nortel SMI > Meridian Application Server > User Administration > 
Messaging Administration Properties > Mailboxes tab

To create a loopback mailbox

1 In the Networking Loopback mailbox box, enter the mailbox number.

2 Click Save.

Result: The information is validated and saved to the database.

Announce the loopback mailbox
Remote network administrators test their implementation by sending an 
Enterprise Networking message to your loopback mailbox. Announce the 
loopback mailbox number to all remote sites.

Similarly, gather the loopback mailbox numbers from the network 
administrators of all other remote sites.

Using the loopback mailbox
A remote administrator addresses a test message to a loopback mailbox us
the protocol and dialing plans specified for use between the two sites.

For example, you create a loopback mailbox, 9999, on your site. Enterprise
Networking is used between a remote site and your site. The ESN dialing pl
used, and the ESN prefix to address your site from the remote site is 3555.
Therefore, to address your loopback mailbox, the remote network administr
enters 35559999.
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Adding sites to Enterprise 
Networking

This chapter describes how to define the sites in the messaging network tha
Enterprise Networking to exchange messages.

This chapter describes how to configure the local messaging server and pr
switch location. It also explains how to add and configure remote messagin
servers and switch locations.

In this chapter
About the messaging network 147

Configuring the local site 153

Adding and configuring a remote site 175
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Adding sites to Enterprise Networking  Standard 1.0
146 CallPilot



November 1998 Adding sites to Enterprise Networking 
About the messaging network

In this section
Overview 148

Configuration and other networking solutions 149
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Overview

Introduction
A CallPilot messaging network consists of a local site and one or more rem
sites.

All sites in your private messaging network with which your local site exchan
messages must appear in the Messaging Network Configuration tree view.
remote site is part of the messaging network, but the local site does not exch
messages with that remote site, you do not add it to the tree view.

To implement Enterprise Networking, you must configure the local site and 
and configure all remote sites that will transfer messages with the local site
using Enterprise Networking.

See also
Sites are configured in the Messaging Network Configuration tree view. For
overview of how to work with the tree view, consult the relevant section in t
Networking Planning Guide.

Before you begin
You should have already configured the Message Delivery Configuration dia
box for Enterprise Networking.

If your local site is an NMS site, NMS should be configured and tested.

Your messaging network representation should be complete and available.
representation provides a blueprint for the implementation process.

ATTENTION! It is strongly recommended that you complete each ste
in the configuration process in the order presented.
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Configuration and other networking solutions

Introduction
If any other CallPilot networking solution is implemented on your local syste
much of local messaging server and the local switch location configuration 
already complete.

Configuring the local messaging server and switch location
If another networking solution is implemented on the local site, the local 
messaging server and prime switch location configuration is almost entirely
complete. You must only confirm the settings and enter the information tha
specifically required to implement Enterprise Networking.

For example, if Integrated AMIS Networking is already implemented on you
system, most of the required information is already entered into the network
database.

NMS local site
If your local site is an NMS site, implement and test NMS before you begin 
implement Enterprise Networking.

If NMS is installed, the NMS satellite switch locations for the local site appe
in the Messaging Network Configuration tree view below the local prime swi
location.

Remote sites
If another CallPilot networking solution is implemented on your system, rem
sites may already be added and configured. These sites appear in the Mess
Network Configuration tree view. These sites exchange messages with the 
site using the other networking solution.

When you implement Enterprise Networking, you must add and configure t
remote sites that will communicate with your local site using Enterprise 
Networking. These sites appear in the tree view only as you add them.
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Example: Implementing Enterprise Networking
In this example, you are the network administrator of Site 6. Working with th
network administrators of the other sites in your messaging network, you ha
created a diagram of your messaging network. Note that many details are 
removed from this network diagram for clarity.

Your local site has the following networking solutions: Integrated AMIS 
Networking, AMIS Networking (available because Integrated AMIS 
Networking is installed), NMS, and Enterprise Networking.

Since you are following the recommended order of implementation, you ha
completed the following for Site 6:

■ NMS is implemented and tested.

■ Integrated AMIS Networking (and AMIS Networking) is implemented an
tested.

The local messaging server and switch locations are configured.

To implement Integrated AMIS Networking, you add the following remote si
to your network database because you use the AMIS protocol to send and 
receive messages with them:

■ Site 3

■ Site 4

■ Site 5—satellite switches are also added

G101139.ep

 Site 1  Site 2
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You are now ready to begin implementing Enterprise Networking. After 
configuring the message delivery parameters, complete the configuration o
local messaging server and add the sites that use Enterprise Networking to
network database.

In this example, you must add Site 1 and Site 2 to your network database, 
because they are the sites that use Enterprise Networking to communicate
your site, Site 6.
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Configuring the local site

In this section
Overview 154

Configuring the local messaging server 156

Configuring the local prime switch location 162

Configuring ESN information 168

Configuring CDP information 172
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Overview

Introduction
When CallPilot is initially installed on your system, a local messaging serve
and local switch location are automatically added to the Messaging Networ
Configuration tree view.

Local messaging server name
By default, both the local messaging server and the prime switch location a
assigned the name “Untitled.” Assign new names to the local messaging se
and the prime switch location during configuration.

The local site receives its name from the name assigned to the local messa
server.

Configuration
You must configure the local messaging server. To configure the messagin
server, you save general information, such as name and description, to the
network database.

The local messaging server is configured on the General tab of the Local S
Properties dialog box.

SMTP/VPIM Server FQDN
The SMTP/VPIM Networking Server FQDN box is enabled only if VPIM 
Networking is installed on your system. It is configured during the 
implementation of VPIM Networking.

However, if the box is enabled on the General tab, you must enter a placeh
in the box or you will be unable to close the tab and save the information to
network database.

While implementing Enterprise Networking, enter a placeholder in this box. Y
will replace this placeholder with the correct server FQDN when you implem
VPIM Networking.
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Configuring the local server if another messaging solution is 
implemented

If you have implemented another CallPilot networking solution on your loca
system, you have already completed most local messaging server configur

For example, if Integrated AMIS Networking is already implemented, the Na
Description, and Send Messages to all other Server fields are already comp

In this case, check the current configuration and complete additional options
are specific to Enterprise Networking and would not have been completed 
during the previous implementation.
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Configuring the local messaging server

Introduction
You must configure the local messaging server to implement Enterprise 
Networking.

If another networking solution is implemented, most of the information is 
already completed. You must only check the information and add the 
information required for Enterprise Networking.

The local messaging server is configured on the Local Server Properties—
General tab. 
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Name
By default, both the local messaging server and the prime switch location a
assigned the name “Untitled.” Assign new names during configuration.

The messaging server is usually given a name that corresponds to its geog
location.

Local site name
The name given to the local messaging server becomes the name of the lo
site.

Server type
The local messaging server is always CallPilot.

Description
Provide a brief description of the messaging server or implementation note
such as when the server was configured or who completed the configuratio
the Description.

Send Messages to all other Servers
The Send Messages to all other Servers check box determines if the local s
can send messages to integrated remote sites in the messaging network.

This check box is selected by default and is cleared only under exceptional
circumstances.

When cleared, the local messaging server does not send messages to any
integrated remote site using any protocol. Messages can still be sent to ope
remote sites.

When to clear this option
This option lets you quickly disable messaging from your local site. Clear th
check box in emergency situations.

Restricting the sending of messages
Clearing the Send Messages to all other Servers check box is a quick way 
disable the system.
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You restrict the sending of messages to each remote site separately.

To prohibit the local messaging server from sending messages to a particu
remote site, clear the Send Messages to this Server check box on the Rem
Messaging Server Properties—General tab.

For example, your messaging network has six sites and you do not want to
messages to one of these sites. You select the Send Messages to all other S
option while you configure the local messaging server. You clear the Send 
Messages to this Server option while you configure the remote server to wh
you do not want to send messages.

Note: When the Send Messages to all other Servers box is cleared, users ca
send messages to open sites using the VPIM and AMIS protocols.

Add/Update Remote Users on this Server
The Names Across the Network feature is available with Enterprise Network
only.

The Add/Update Remote Users on this Server check box enables the Nam
Across the Network feature to work with Enterprise Networking.

This box controls your local server. You must coordinate with the network 
administrator of each remote site with which you want to enable Names Ac
the Network. You can use Names Across the Network only with remote sites
use Enterprise Networking and have the Send Remote User Info feature en

Additional information
The Names Across the Network feature is not the only way to add remote u
to your local network database. You can also add remote users manually w
User Administration.

For a detailed discussion of remote users and Names Across the Network, 
consult the Networking Planning Guide.
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Enterprise Site ID
To implement Enterprise Networking, you must assign an Enterprise site ID
your local messaging server.

The site ID, combined with the location ID, identifies the local site to remote
sites in the messaging network.

The site ID is one of the pieces of information included in a message heade

When Enterprise Networking is implemented on any site in a messaging 
network, every site that exchanges Enterprise Networking messages with it 
have a site ID.

Receive Message Text Info
The local messaging server can receive message subject headers in the me
sent by all remote sites that are enabled to send message subject headers

The message subject header is available to desktop users.

In most environments, the Receive Message Text Info check box is selecte
However, if the local site incurs long-distance toll charges when receiving 
messages, you may want to clear this option because messages that includ
message subject headers take longer to send.

Server FQDN
The Server FQDN box is enabled only if VPIM Networking is installed on yo
local site. The server FQDN is entered when you implement VPIM Network

However, the Local Server Properties—General tab cannot be closed and t
information cannot be saved to the network database unless the Server FQ
box contains some information. When you implement Enterprise Networking
you do not know the server FQDN, enter a placeholder in the box. If you kn
the server FQDN, enter it.

For example, enter “FQDN_goes_here”. A clearly marked placeholder remi
you to complete the box when you implement VPIM Networking.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To configure the local messaging server

1 In the Messaging Network Configuration tree view, select the local 
messaging server.

2 On the File menu, click Open.

Result: The Messaging Network Configuration—Local Server—General 
tab appears.

3 To change the name of the local server, enter a new name in the Name box.

Tip: The name given to the local messaging server is also the name of the 
local site.

Note: The server type is always CallPilot and cannot be changed.

4 In the Description box, enter details about the local messaging server.

5 To enable the local messaging server to send messages to the remote sites 
in your messaging network, select the Send Messages to all other Servers 
check box.

Attention: If this check box is not selected, messages cannot be sent to 
remote sites. This check box is cleared only in unusual circumstances. To 
clear the check box, you are prompted to confirm your decision.

6 To enable the Names Across the Network feature, select the Add/Update 
Remote Users on this Server box.

7 In the Enterprise Site ID box, enter a unique ID number for the local 
messaging server.

8 To enable the local messaging server to receive message subject headers 
with Enterprise Networking messages from all remote sites that are willing 
to send these headers, select the Receive Message Text Info check box.

9 If the Server FQDN box is enabled, enter a valid placeholder or, if available, 
the FQDN of the local server.

Note: If you enter a placeholder, you replace it when you implement VPIM 
Networking.

10 Click Save.

Result: The information is validated and saved to the network database.
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What’s next?
After you configure the local messaging server, configure the local prime sw
location.
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Configuring the local prime switch location

Introduction
You must configure the local prime switch location to implement Enterprise
Networking.

If any other networking solution is implemented
If another networking solution is implemented on the local site, the local sw
location is already configured.

Check the current configuration information. Make any necessary modificat

If NMS is implemented
If NMS is installed on the local site, the local prime switch location is alread
configured.

All satellite switch locations attached to the local prime switch location are a
already configured.

Check the current configuration information. Make any necessary modificat

If no other networking solution is installed locally
If no other networking solution is implemented on the local site, complete th
General tab. Complete the ESN tab or the CDP tab, or both, depending on
dialing plan used on your local switch location.
162 CallPilot



November 1998 Adding sites to Enterprise Networking 

 site.

.

.

r 

n 
Where the prime switch location is configured
The local prime switch location is configured on the Prime Switch Location 
Properties dialog box, which has four tabs:

■ General

■ ESN

■ CDP

■ SMTP/VPIM

General tab
Complete the General tab no matter what dialing plan is used on your local

ESN tab
Complete the ESN tab if the local site uses the ESN or a hybrid dialing plan

CDP tab
Complete the CDP tab if the local site uses the CDP or a hybrid dialing plan

SMTP/VPIM tab
The SMTP/VPIM tab is enabled only if VPIM Networking is installed on you
local switch location.

You complete the SMTP/VPIM tab when you implement VPIM Networking o
your local site, not during the implementation of Enterprise Networking.
Enterprise Networking Implementation and Administration Guide 163



Adding sites to Enterprise Networking  Standard 1.0
Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration

To open the Prime Switch Location Properties dialog box

1 In the Messaging Network Configuration tree view, select the local prime 
switch location.

2 On the File menu, click Open.

Result: The Messaging Network Configuration—Prime Location 
Properties—General tab appears.

. 
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Name
Each switch location must be assigned a name that is unique within the 
messaging network. Usually, this name is the same as the name of the mes
server. This ensures that the identity of the switch location within the netwo
immediately apparent. A geographic name is common.

For example, if a messaging server is named “Moscow,” the prime switch 
location is usually also named “Moscow.”

By default, the local prime switch location is given the name “Untitled.” This
name must be changed.

Description
The Description box is useful for short notes, reminders, or comments abou
switch location.

You might find it useful to specify your switch model, the date of the switch 
configuration, or contact information for the switch technician.

Enterprise Location ID
The Enterprise Location ID box is not enabled for the prime switch location

Note: The location ID for a prime switch location is always 0 and cannot be 
changed.

Spoken Name Recorded
If your local site is not an NMS site, the Spoken Name Recorded box is not
enabled.

If your site is an NMS site, the Spoken Name Recorded check box was 
configured during the NMS implementation.

Dialing plan information
Detailed information about the dialing plan used on the local prime switch 
location is required when configuring the local prime switch location.
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Dialing plans for dialing to this location
You must specify which of the following dialing plans is used to dial to the lo
switch location:

■ ESN

■ CDP

■ hybrid, which combines ESN and CDP

■ another dialing plan (such as PSTN)

When you configure the local prime switch location, you specify the dialing p
that is used to dial to the local site. 

Note: If you use ESN anywhere in the messaging network, ESN must be 
selected because the local site needs an ESN access code.

Mailbox specifications
The following boxes are dynamically enabled and disabled depending on th
dialing plan you have specified for the prime switch location:

■ Mailbox addressing follows dialing plan

■ Mailbox prefixes

Mailbox addressing follows dialing plan
The Mailbox addressing follows dialing plan box is enabled only if NMS is 
installed on the local messaging server. If NMS is implemented, this check 
should be properly configured already.

Mailbox prefixes
A mailbox prefix is a leading string of digits that uniquely identifies a mailbo
number as belonging to a particular site.

If the local site does not have NMS installed, you never need mailbox prefix
for the local prime switch location.

If the local site does have NMS installed, the mailbox prefix or prefixes sho
be properly configured already.
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To configure the local prime switch location

1 To change the name of the local prime switch location, enter a name in the 
Name box.

2 In the Description box, enter details about the local prime switch location.

3 In the Enterprise Location ID box, enter the location ID number of the local 
prime switch location.

Note: The Enterprise location ID is always 0 and cannot be changed.

4 Confirm the status of the Spoken Name Recorded box.

Note: This box is enabled only if NMS is installed and was completed 
during the implementation of NMS.

5 Specify the dialing plan used to dial the local prime switch location. Select 
the

● ESN check box if ESN is used

● CDP check box if CDP is used

● ESN and CDP check boxes if a hybrid dialing plan is used

Note: Leave both check boxes clear if you use another dialing plan, such as 
PSTN.

6 Determine whether you must complete another tab. If not, click Save to 
close the dialog box. 

7 Select another tab to continue the configuration.

What’s next?

If the local site uses an ESN, CDP, or hybrid dialing plan
After you complete the General tab, you must complete the ESN tab, or the 
tab, or both tabs, depending on the dialing plan used.

If the local site uses another dialing plan
If your local site uses another dialing plan, such as PSTN, you have comple
the configuration of your local prime switch location.
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Configuring ESN information

Introduction
If the local prime switch location uses either an ESN dialing plan or a hybrid
dialing plan, you must complete the ESN tab.

You provide the ESN access codes and ESN location codes. These are com
to create the ESN prefix.

See also
For a description of the ESN dialing plan and how it works, consult the 
Networking Planning Guide.

. 
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ESN Access Code used by this location
The ESN access code is used to access ESN routing in the same way that
access code, such as 9, is used to dial out to the public network from a priv
network.

Typically, all switches in a messaging network use the same ESN access c

ESN Location Codes
An ESN location code is a routing prefix that identifies a location within a 
network. It is usually three digits long, but can be up to ten digits long.

You must also indicate the number of digits in the ESN location code that 
overlap the mailbox number.

The ESN Location Codes list contains all ESN location codes currently assig
and indicates the overlap between the ESN location code and the mailbox 
directory numbers.

ESN location codes can be added, modified, or deleted at any time. The ES
location codes must always match the dialing plan configuration on the swi

ESN location code capacity
The maximum number of ESN location codes for a switch location is 30.

ESN location code overlap
When you enter the dialing plan information for the local site, calculate the 
number of digits in the ESN prefix that overlap the digits in the local extens

If there is overlap between the rightmost digit or digits of the location code a
the leftmost digit or digits of the extension number, enter the amount of ove

The following table provides two examples of ESN location code overlap.

Access 
code

Location 
code

Extension 
number

Number dialed by users at 
other sites Overlap

6 338 8300 63388300 0

6 338 8300 6338300 1
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration > Local Prime 
Switch Location > ESN tab

To configure the ESN information

1 Enter the ESN access code.

2 To add a new location code, click the Add New button.

Result: The New ESN Location Code Properties dialog box appears.

3 In the Location Code box, enter the location code.

4 In the Overlap box, enter the number of digits in the mailbox number that 
overlap the location code.

5 Click Save.

Result: The location code and overlap are validated and appear in the ESN 
Location Codes list box on the ESN tab.

6 Repeat steps 3–5 for each ESN location code that you require.

7 When you have finished configuring the ESN information, determine if you 
must configure CDP information. 

● If yes, click the CDP tab. 

● If no, click Save to validate the ESN information and save it to the 
database.
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What’s next?
If your local prime switch location uses the hybrid dialing plan, click the CD
tab to continue configuring the local prime switch location.
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Configuring CDP information

Introduction
If the local switch location uses either a CDP dialing plan or a hybrid dialing
plan, complete the CDP tab.

You must provide the CDP steering codes.

See also
For a general description of the CDP dialing plan and how it works, consult
Networking Planning Guide.
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CDP Steering Codes
A CDP steering code is a site prefix that identifies the local site within the 
network. Therefore, a CDP prefix must be unique for all switches in the 
messaging network.

CDP steering codes are determined by the switch technician. 

The CDP steering codes defined on the switch are entered on CallPilot bec
the system must be able to identify the steering code in the mailbox numbe
determine the site.

The CDP Steering Codes list box contains all CDP steering codes currently
assigned to the switch location. The list box also indicates the overlap betw
the CDP steering codes and the mailbox directory numbers.

CDP steering codes can be added, modified, or deleted.

CDP steering code capacity
The maximum number of CDP steering codes for a switch location is 500.

CDP steering code overlap
When you enter the dialing plan information, you must calculate the numbe
digits in the CDP steering code that overlap the digits of the local extension

If there is overlap between the rightmost digit or digits of the steering code 
the leftmost digit or digits of the extension number, enter the amount of ove

Normally, the steering code overlaps with the first few digits of a local extens
number.

The following table provides three examples of CDP steering code overlap.

Steering 
code

Extension 
number

Number dialed by users at other 
sites

Amount of 
overlap

22 22345 2222345 0

22 22345 222345 1

22 22345 22345 2
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration > Local Prime 
Switch Location > CDP tab

. 

To configure the CDP information

1 Click the Add New button.

Result: The New CDP Steering Code Properties dialog box appears.

2 In the Steering Code box, enter the steering code.

3 In the Overlap box, enter the number of digits in the mailbox number that 
overlap the steering code.

4 Click Save.

Result: The steering code and overlap are validated and appear in the 
CDP Steering Codes list box on the CDP tab.

5 Repeat steps 1–4 for each CDP steering code required.

6 When you have added all necessary CDP steering codes, click Save.

Result: The information is validated and saved to the network database.

What’s next?
You have completed the configuration of the local site and are ready to beg
adding and configuring remote sites.
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Adding and configuring a remote site

In this section
Overview 176

Configuring a remote messaging server 178

Configuring a remote prime switch location 187

Configuring a remote satellite switch location 199

Recording a spoken name 203

Importing a spoken name 205

Checking the configuration of other remote sites 207

Non-CallPilot remote sites 209

Meridian Mail remote sites 211
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Overview

Introduction
When you implement Enterprise Networking, you add to the Messaging 
Network Configuration tree view all the remote sites that use Enterprise 
Networking to exchange messages with the local site.

Every remote site added to the tree view must be configured.

Information required
The information that you enter when you configure a remote site reflects th
information that is configured for that site in its own local network database.
example, you enter the name of that site and its Enterprise site ID. You mus
this information from the remote network administrator.

However, configuring a remote site involves more than simply copying the 
information provided by the remote site. You also enter information that refle
how your local site will communicate with that remote site. For example, for
each remote site, you decide whether your local site sends messages to th
particular remote server.

Main steps
There are three main steps to adding a remote site to your local network 
database. For each remote site, you must add and configure

■ the remote messaging server

■ the remote prime switch location

■ the remote satellite switch locations, if the remote site is an NMS site

Network representation
Much of the information that you must provide while configuring a remote 
messaging server is contained in the network diagram or spreadsheet.
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Correcting information about remote sites already added to the 
network database

If another messaging network solution is already implemented on your local 
such as Integrated AMIS Networking, check the information for the remote 
messaging servers that you added to your local network database during th
configuration.

For example, when you added remote sites to your network database durin
installation of Integrated AMIS Networking, you added the remote sites that
the AMIS protocol to send messages to and receive messages from your lo
site. When configuring these remote sites, the validation process forced yo
enter an Enterprise site ID for the remote site to save the configuration to y
network database.

You must check the Enterprise site IDs that you entered for these sites to e
that they are valid and correct. If you entered a random number as a placeh
change them to actual site ID numbers.
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Configuring a remote messaging server

Introduction
When you initially install CallPilot on your system, your local site, which 
consists of a local messaging server and a local prime switch location, is 
automatically added to the Messaging Network Configuration tree view.

However, you must manually add each remote site that exchanges message
the local site using Integrated AMIS Networking into the Messaging Networ
Configuration tree view. You must configure both the remote messaging se
and the remote prime switch location.

You must complete the following tabs for each remote messaging server:

■ Remote Messaging Server Properties—General tab

■ Remote Messaging Server Properties—Connection Information tab

Remote servers and other messaging solutions
If you have implemented another CallPilot networking solution on your syste
you have already added remote sites to the Messaging Network Configurat
tree view.

The process of adding a remote site is essentially the same regardless of th
networking solution being implemented. However, when you add remote si
during the implementation of Enterprise Networking there are important 
differences.
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Remote Messaging Server Properties—General tab
The Remote Messaging Server Properties—General tab contains detailed 
information about the remote messaging server and defines how the local s
and the remote site exchange messages.

. 

Name
You should assign the remote messaging server the same name that was as
to it by its local network administrator. This correspondence in naming sites
makes the network easier to administer and maintain because all network 
administrators use the same names for the same sites.

For example, if a remote site calls itself “Connecticut,” you should name it 
“Connecticut” when you add it to the Messaging Network Configuration tree
view.
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Server type
The remote messaging server can be any of the following types:

■ CallPilot

■ Meridian Mail Net Gateway (MMNG)

■ Norstar Voice Mail (Norstar)

■ Meridian Mail

■ Other

Description
Provide a brief description of the remote messaging server or useful notes,
as when the messaging server was configured or who completed the 
configuration. 

Send Messages to this Server
The Send Messages to this Server check box interacts with the Send Messa
all other Servers check box on the Local Messaging Server Properties—Ge
tab.

When you configured the local messaging server, you decided if you wante
local messaging server to send messages to all remote messaging servers
option is selected by default and is cleared only under exceptional circumsta
only. 

However, you can still stop the delivery of messages to specific remote 
messaging servers. The Send Messages to this Server check box enables 
block the delivery of messages from your local messaging server to a partic
remote site.
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Example
In the following diagram, Helsinki is configured to deliver messages to all ot
sites. However, the network database record for Paris and for Cairo specifie
messages are not sent to these remote sites. Messages are sent to both La
and Korso-Rekola. Therefore, while the potential exists for sending messag
all remote sites, only two remote sites receive messages.

Send local user information to this Server
The Send local user information to this Server check box determines if the 
Names Across the Network feature is used with this remote site. If enabled
feature was configured during the implementation of Enterprise Networking

G100995.eps
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Enterprise Site ID
The Enterprise Site ID box is enabled only if Enterprise Networking is instal
on the local site. 

All remote sites connected to a site that has Enterprise Networking installed
must have an Enterprise site ID, regardless of the actual protocol used with
site.

Send Message Text Info to this Server
This check box applies only to remote sites that use Enterprise Networking
exchange messages with the local site. If enabled, message text informatio
sent to the remote site.

Server FQDN
If VPIM Networking is installed on your local site, the VPIM Networking 
Server FQDN box is enabled.

However, since your local site transfers messages with this remote site usin
Enterprise Networking, the Fully Qualified Domain Name (FQDN) of the 
remote server is not required.
182 CallPilot



November 1998 Adding sites to Enterprise Networking 

ons 

col 
rise.

tion 

the 
Remote Messaging Server—Connections tab
The configuration of a remote messaging server continues on the Connecti
tab.

Network protocol
When implementing Enterprise Networking, you must specify that the proto
used by the local site to exchange messages with this remote site is Enterp

To use a particular protocol, both sites must have the same networking solu
installed and implemented.

If a remote site is not configured to use the same protocol as the local site, 
following occurs when the local site attempts to send a message:

■ The message is not delivered.

■ An error message is generated.

■ The remote site is put into error status on the local system.
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Enterprise Networking Connection DNs
When CallPilot initiates a call to a remote site, it uses the networking connec
DN that is specified for the remote site in your network database.

Up to three DNs can be defined. DN1 is mandatory. DN2 and DN3 are optio

The first Enterprise Networking connection DN is the Enterprise Networking
SDN for the remote site, as defined in the SDN table of the remote site. If 
Enterprise Networking is sharing an SDN with another service, such as AM
Networking, then the networking connection DN is the DN that accepts suc
network calls.

You must contact the administrator of the remote site for the connection DN

The connection is entered in a format that is dialable from the local site.

The system always uses DN1 to call the remote site unless it encounters 
problems. If the system does encounter a problem, it attempts to contact th
remote site using DN2, then DN3. In general, the DNs are ordered from lea
expensive to most expensive connections. For example, DN1 could be a pr
number and DN3 could be a public telephone number.

Network passwords
Unique passwords are used between each pair of sites in the messaging ne
They are used to secure the messaging network and the integrity of the 
messages. Two passwords are used to verify that any two sites may 
communicate with each other:

■ initiating password

■ responding password

The passwords on your site must match the site you are calling or from whi
you are receiving messages.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration 

To configure a remote messaging server

1 In the Messaging Network Configuration tree view, select Remote Server 
Maintenance.

2 On the File menu, click New > Messaging Server.

Result: The Remote Messaging Server Properties—General tab appears.

3 On the General tab, in the Name box, enter the name of the remote 
messaging server.

4 Select the server type from the Server type box.

5 In the Description box, enter details about the remote messaging server.

6 To enable the local messaging server to send messages to this remote 
messaging server, ensure that the Send Messages to this Server box is 
selected.

7 Enter the unique Enterprise site ID number of the remote messaging server 
or a valid placeholder.

8 To continue configuring the remote messaging server, click the 
Connections tab.

Result: The Connections tab appears.
. 

9 From the Network protocol list, select Enterprise.

Result: The Connection DNs boxes become enabled.

10 In the DN1 box, enter the connection DN.

Note: DN1 is mandatory. At least one DN must be the system access 
number of the remote site.

11 Repeat for each connection DN.

Note: If you are defining more than one connection DN, list them in order of 
cost. Connection DN1 should be the least expensive means of contacting 
the remote site.

12 Enter the Initiating and Responding Enterprise Passwords.
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13 Click Save.

Result: The information is validated and entered into the network 
database.

What’s next?
After you add information about the remote messaging server into your loca
network database, you must also add information about the remote prime s
location.
186 CallPilot



November 1998 Adding sites to Enterprise Networking 

h 

ote 

with 
Configuring a remote prime switch location

Introduction
When you added a remote messaging server to the Message Network 
Configuration tree view, a corresponding prime switch location was added.

A remote prime switch location must be configured. This process is almost 
identical to configuring the local prime switch location.

Remote Prime Switch Location dialog box
The remote prime switch location is configured on the Remote Prime Switc
Location Properties dialog box, which has four tabs:

■ General

■ ESN

■ CDP

■ SMTP/VPIM

General tab
Completing the General tab is mandatory.

ESN tab
Complete the ESN tab if an ESN or a hybrid dialing plan is used with this 
remote site.

CDP tab
Complete the CDP tab if a CDP or a hybrid dialing plan is used with this rem
site.

SMTP/VPIM tab
Because your local site is not using VPIM Networking to transfer messages 
this remote site, do not complete the SMTP/VPIM tab.
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Remote Prime Switch Location Properties—General tab
. 

Name
Assign a unique name to each switch location. The name should correspon
the switch location to make the location easy to identify. A street or city nam
a good choice.

The remote switch location is automatically given the name of the remote se
that was added to the Messaging Network Configuration tree view. This na
can be changed.

Description
Enter short notes or comments about the remote switch location in this box
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Enterprise Location ID
The Enterprise Location ID box is enabled only if Enterprise Networking is 
implemented on the local site.

A location ID is required for all remote sites if Enterprise Networking is 
installed locally, even if another protocol is used to exchange messages wit
site.

The location ID of the prime switch location is set to 0 by default and canno
changed.

Spoken Name Recorded
When local users compose a message to this remote site or use the playba
feature to determine the sender of a message, they hear a message that id
the sender. The content of the message depends on whether a spoken nam
that remote site is recorded.

If a spoken name is recorded, voice mail users hear the location name follo
by the local mailbox directory number.

Example: “Dallas, Mailbox 2346”

Spoken name not recorded
If a spoken name is not recorded, local users hear a full mailbox address th
does not identify the sender’s site by name.

For example, for an ESN switch location, users hear the ESN location prefi
followed by the local mailbox directory number.

Example: “Mailbox 6444 2346”

When a spoken name is not desirable
You may decide that you do not want local users to hear a spoken name fo
particular remote site. For example, if CDP is used for messaging with this 
remote site and the mailbox numbers follow the dialing plan, you may decid
that a recorded spoken name is unnecessary. In this case, do not record or 
a spoken name.

Ways to add a spoken name recording
There are two ways to add a spoken name recording: record a spoken nam
directly by clicking the Record button, or import a prerecorded message.
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Dialing and addressing
Provide general information on the dialing plan used by the switch.

Several of the boxes are enabled or disabled, depending on the selections 
The dialing plan boxes have complex interactions. Complete all enabled bo

Dialing plans for dialing to this location
You must specify which dialing plan is used to dial this remote switch locati
from the local switch location. There are four possible dialing plans:

■ ESN

■ CDP

■ hybrid, which combines ESN and CDP

■ another (such as PSTN)

Mailbox addressing follows dialing plan
When a mailbox follows the dialing plan, a user dials and addresses a messa
a recipient in the same way. There are two ways to achieve this correspond

■ A user’s mailbox number and extension number are the same.

■ The addressing plan and the dialing plan are the same.

If either situation is true, select the Mailbox addressing follows dialing plan 
check box.

Clear this option if users at the site do not dial and address recipients in the 
way.

Example: If the local ESN prefix is 6222 and the local mailbox is 1234, remo
users can dial the local user with the number 62221234, which is the ESN p
and the mailbox number combined.

Example: If the CDP steering code is 22 and the local mailbox is 1234, rem
users can dial the local user with the number 221234, which is the steering 
and the mailbox number combined.
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Mailbox prefixes
Mailbox prefixes are used by local users to address users at a remote site i
mailboxes at the remote site do not follow the dialing plan.

A mailbox prefix must be provided if the mailbox does not follow the dialing
plan or if another dialing plan, such as PSTN, is used.

A mailbox prefix does not have to overlap with local mailbox numbers. Two
mailbox prefixes can be entered. Either prefix can be used to address any 
mailbox at the local site. Normally, however, only one prefix is required.

Usually, the mailbox prefix is a shortcut. A mailbox prefix can be any numbe
long as it does not conflict with other network data.

A mailbox prefix can also be the entire telephone number of the site, includ
country code, city/area code, and exchange.

Example: If the mailbox prefix is 22 and the mailbox number of a local user
6565, users at other switches address the local user by dialing 226565.

Dialing prefix
A dialing plan is needed if the local site uses another dialing plan, such as P
and users at your local site use a dialing prefix to reach users at this remote

Usually, if the Dialing prefix box is enabled, you enter the prefix.

In a few cases, a dialing prefix is not needed. For example, if the mailbox 
number, without the mailbox prefix, can be dialed directly, a dialing prefix is 
needed. This situation is rare because most systems use some sort of acce
code.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration 

To configure the remote prime switch location

1 In the Messaging Network Configuration tree view, select the remote prime 
switch location.

2 On the File menu, select Properties.

Result: The Remote Prime Switch Location Properties dialog box appears.

3 On the General tab, in the Name box, enter the name of the remote prime 
switch location.

4 In the Description box, enter details about the switch location.

Note: The Enterprise Location ID is always set to 0 for remote prime switch 
locations and cannot be changed.

5 If needed, click Record to record a spoken name for the site, or click Import 
to import a prerecorded spoken name.

Note: For instructions on how to record a spoken name, see Recording a 
spoken name on page 203.

For instructions on how to import a spoken name, see Importing a spoken 
name on page 205.

6 Specify the dialing plan used to dial the remote site. Select the

■ ESN check box if ESN is used

■ CDP check box if CDP is used

■ ESN and CDP check boxes if a hybrid dialing plan is used

Note: Leave both check boxes clear if you use another dialing plan, such as 
PSTN.

7 Indicate if mailbox addressing follows the dialing plan.

8 If necessary, enter the mailbox prefix or prefixes.

9 If necessary, enter the dialing prefix.
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ESN information
If the remote prime switch location uses an ESN or a hybrid dialing plan, 
complete the ESN tab.

The procedure for configuring the ESN information for a remote prime switc
identical to the procedure used for the local prime switch location.

Note: You must provide the ESN access code used at the remote site. Do n
enter the access code used locally.

For a review of the ESN access codes, ESN location codes, and overlap, co
Configuring ESN information on page 168.
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To configure the ESN information

1 Open Message Delivery Configuration > Remote Prime Switch Location > 
ESN tab.

2 Enter the ESN access code.
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3 To add a new location code, click the Add New button.

Result: The New ESN Location Code Properties dialog box appears.

4 In the Location Code box, enter the location code.

5 In the Overlap box, enter the number of digits in the mailbox number that 
overlap the location code.

6 Click Save.

Result: The location code and overlap are validated and appear in the ESN 
Location Codes box on the ESN tab.

7 Repeat steps 3–6 for each ESN location code required.

8 When you have finished configuring the ESN information, determine if you 
must configure CDP information. If yes, click the CDP tab. If no, click Save.

What’s next?
If your remote prime switch location uses the hybrid dialing plan, click the C
tab to continue the configuration of the local prime switch location.

If the local prime switch location uses only the ESN dialing plan, click Save
validate the configuration information and save it to the network database.

. 
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CDP information
If a CDP dialing plan or a hybrid dialing plan is used to connect the local sit
the remote site, complete the CDP tab.

Configuring the CDP information for a remote prime switch location is identi
to configuring the local prime switch location.

For a review of the CDP steering codes and overlap, consult Configuring CDP 
information on page 172.
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To configure the CDP information:

1 Open Message Delivery Configuration > Remote Prime Switch Location > 
CDP tab.

2 Click the Add New button.
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Result: The New CDP Steering Code Properties dialog box appears. 

3 In the Steering Code box, enter the steering code.

4 In the Overlap box, enter the number of digits in the mailbox number that 
overlap the steering code.

5 Click Save.

Result: The steering code and overlap are validated and appear in the 
CDP Steering Codes box on the CDP tab.

6 Repeat steps 2–5 for each CDP steering code required.

7 When you have added all necessary CDP steering codes, click Save.

Result: The information is validated and added to the network database, 
and you return to the Messaging Network Configuration tree view.

What’s next?
You have completed the configuration of the remote prime switch location.
198 CallPilot



November 1998 Adding sites to Enterprise Networking 

llite 

 is 
lly 

ging 

ork 

y the 
Configuring a remote satellite switch location

Introduction
If a remote site is an NMS site, you must add and configure each of its sate
switch locations. This information is saved to the local network database.

Although a prime switch location is added automatically when a remote site
added to the Messaging Network Configuration tree view, you must manua
add each satellite switch location of a remote NMS site.

Capacity
An NMS site can have up to 59 satellite switch locations.

Organization
When you add a satellite switch location, this location appears in the Messa
Network Configuration tree view. Satellite switch locations are listed 
alphabetically below the prime switch location.

Where to configure a satellite switch location
To configure a satellite switch location, complete the General tab of the Netw
Messaging Configuration property page.

You must also complete the tabs that correspond to the dialing plan used b
local site.

ESN tab
Complete the ESN tab if you use an ESN or a hybrid dialing plan.

CDP tab
Complete the CDP tab if you use a CDP or a hybrid dialing plan.
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Spoken Name Recorded
When local users compose a message to a remote satellite switch location 
the playback feature to hear who sent a message, the name of the switch lo
is played. 

If a spoken name is not recorded, local users hear the full DN, such as “Ma
64441234.” If a recording of the spoken name is available, local users hear
switch location name followed by the mailbox number, such as “Milan 1234
You can either record a message using the telephone or import a prerecord
WAV file.

When a recording of the spoken name is available, Yes appears in the Spo
Name Recorded box.

If you do not want your local users to hear the name of this satellite switch 
location when composing messages or using playback, do not record a mes
For example, if you are using CDP to transfer messages to the site and ma
numbers follow the dialing plan, you may feel that a spoken name is 
unnecessary.

Dialing plan interaction
The dialing plan boxes are dynamically enabled or disabled depending on t
choices made. Complete all enabled fields. 

See also
Configuring a satellite switch location for a remote site is  identical to 
configuring a remote prime switch location for a remote site. 

For a review, consult Configuring a remote prime switch location on page 187.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot> Networking 
> Messaging Network Configuration

To add a remote satellite switch location

1 On the Messaging Network Configuration tree view, highlight the remote 
messaging server.

2 On the File menu, select New > Switch location.

Result: The Satellite Switch Location Properties dialog box appears.

3 To add the satellite switch location to the remote site, configure the satellite 
switch location.

4 In the Satellite Switch Location Properties dialog box, complete the General 
tab.

5 To record a spoken name, click Record.
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To import a prerecorded spoken name, click Import.

Note: For detailed instructions on how to record or import spoken names, 
consult Recording a spoken name on page 203, or Importing a spoken 
name on page 205.

6 Complete the ESN tab and the CDP tab as required.

7 Click Save.

Result: The information is validated and the satellite switch location is 
added to the remote site.

8 Repeat steps 1–4 for each satellite switch location required.

9 When all satellite switch locations are added, click Save to save them to the 
Messaging Network Configuration tree view.
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Recording a spoken name

Introduction
You can create a recording of the name of a switch location. A recorded nam
heard by a local user whenever an address is played back. A recorded nam
site is played if a user does not have a personal recorded name.

Local switch location
If your local site is not an NMS site, a spoken name is not required for the l
site.

If your local site is an NMS site, you can decide if you want to record a spo
name. For example, if the NMS site uses CDP, you may decide a spoken na
not necessary.

Remote switch location
A spoken name should be available for every remote site in your Message 
Delivery Configuration tree view.

The recording is played when local users compose messages to the remote

Importing a spoken name
If you do not want to record your own voice using the telephone, you can im
a prerecorded WAV file. See Importing a spoken name on page 205.

Before you begin
A telephone serves as the microphone. Therefore, if you want to record a sp
name, a telephone must be available.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To record a spoken name

1 In the Messaging Network Configuration tree view, select the switch 
location of the site for which you want to record a spoken name.

2 On the File menu, select Open.

Result: The Switch Location Properties dialog box appears.

3 On the General tab, click Record.

Result: The Specify Phoneset dialog box appears.

4 Enter the telephone number of the telephone to be used as a microphone 
and click Dial.

Result: The telephone rings and the Voice Recorder dialog box appears.

5 Answer the telephone.

6 In the Voice Recorder dialog box, click Record.

7 Speak the name of the site into the telephone.

8 Click Stop.

9 To review the recording, click Play.

10 If you are satisfied with the recording, click Done.
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Importing a spoken name

Introduction
You can import a prerecorded file of the name of a switch location. The 
recording is heard by a local user whenever an address is played back. A 
recording for a site is played if a user does not have a personal spoken nam

Local switch location
If your local site is not an NMS site, a spoken name is not required for the l
site.

If your local site is an NMS site, you can decide if you want to import a spok
name. For example, if the NMS site uses CDP, you may decide a spoken na
not necessary.

Remote switch location
A spoken name should be available for every remote site in your Message 
Delivery Configuration tree view.

The recording is played when local users compose messages to the remote

Instead of importing a spoken name
If you do not want to import a prerecorded spoken name, you can record yo
own voice message using the telephone.

Before you begin
A prerecorded WAV file must be available. Check the quality of the recordin
before importing the file.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To import a prerecorded file

1 In the Messaging Network Configuration tree view, select the switch 
location of the site for which you want to import a prerecorded file.

2 On the File menu, select Open.

Result: The Switch Location Properties dialog box appears.

3 On the General tab, click Import.

Result: The Open dialog box appears.

4 Select the WAV file, and click Open.

Result: The file is imported.

5 Close the Open dialog box.
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Checking the configuration of other remote 
sites

Introduction
If you implemented another networking solution before you implemented 
Enterprise Networking, you may not have completed all required informatio

For example, if you implemented Integrated AMIS Networking, you may ha
added an Enterprise site ID. You should have entered the correct site ID sh
in your network diagram. However, if you used a placeholder instead of the
site ID, you must correct it.

Note: You are not changing the protocol used for these remote sites. You a
only defining information that Enterprise Networking uses to identify a site.

Recommended procedure
It is recommended that you check the Enterprise site ID for all remote 
messaging servers added during the implementation of another networking
solution. Check the remote switch location ID number also.

To check the Enterprise Site ID

1 Open the Remote Server Properties dialog box.

2 On the General tab, check the Enterprise site ID.

3 If the site ID is correct, click Cancel.

If the site ID is incorrect, replace the ID and click Save.

4 Repeat steps 1–3 for each remote site added during the implementation of 
another networking solution.
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To check the Enterprise Location ID

1 Open the Remote Prime Switch Location Properties dialog box.

2 On the General tab, check the Enterprise location ID.

3 If the location ID is correct, click Cancel.

If the location ID is incorrect, replace the ID and click Save.

4 Repeat steps 1–3 for each remote site added during the implementation of 
another networking solution.
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Non-CallPilot remote sites

Introduction
Enterprise Networking can exchange messages between a CallPilot system
the following non-CallPilot remote systems:

■ a  Meridian Mail (Release 8 and later) system

■ a Norstar Voice Mail (Release 3 and later) system

Coordination
If a remote site is a non-CallPilot system, you must coordinate with the netw
administrator of that remote site to ensure that the systems are properly 
configured. You must share the standard information that is required betwe
any sites in a messaging network.

Example
The two sites must coordinate dialing plans and ensure that there are no con
in the configuration information.

Adding and configuring the remote site
Adding a non-CallPilot remote site to the local network database is exactly 
same as adding a CallPilot remote site.

To configure the non-CallPilot remote site, you require no special informatio
You must only specify the server type on the Remote Messaging Server dia
box. The rest of the configuration is the same as the configuration of a Call
remote site.

Server type
Specify the server type of a non-CallPilot system on the Messaging Networ
Configuration—Remote Server Properties—General tab.
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Instructions for the remote administrator
For both Meridian Mail and Norstar Voice Mail systems, there are no specia
considerations that must be communicated to the remote network administ

You add the CallPilot site to the remote network database like any other rem
site. No special configuration is required.
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Meridian Mail remote sites

Introduction
CallPilot can exchange Enterprise Networking messages with Meridian Ma
(Release 8 and higher).

If a remote site is a Meridian Mail system, you must coordinate with the netw
administrator of that site to ensure that the systems are properly configured

The coordination involves standard information that is required between an
sites in a messaging network (for example, site names and dialing plan 
information).

Instructions for the remote Meridian Mail administrator
The CallPilot site is added to the network database like any other site.

Special considerations
CallPilot does not support network broadcast. If network broadcast message
sent from the Meridian Mail site, they are rejected.

For Meridian Mail (Release 11 and higher), the Meridian Mail administrator 
selectively disable the network broadcast for selective sites. Network broad
should be disabled for remote CallPilot sites.

Testing
The Meridian Mail administrator can run an additional test, the Enterprise 
diagnostic test, to determine if Enterprise Networking is performing properly
This test is not available for network administrators at CallPilot sites.
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Norstar Voice Mail remote sites

Introduction
Enterprise Networking can exchange messages between a CallPilot system
Norstar Voice Mail (Release 3 and later) system.

Instructions for the remote Norstar Voice Mail administrator
Add the CallPilot site to the network database like any other site. There are
special considerations that must be communicated to the network administ
212 CallPilot
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Testing and backing up Enterprise 
Networking

This chapter describes how to test the Enterprise Networking configuration.
test suite determines if Enterprise Networking works properly both locally a
with remote sites.

This chapter also describes how to create a backup of your system to ensu
the correct configuration is not lost due to system failure.

In this chapter 
Tests and backups 215
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Tests and backups

In this section
Enterprise Networking test suite 216

Call routing test 218

Local SDN test 219

Quick SDN test 221

Loopback test 222

End-to-end test 224

Backing up Enterprise Networking 227
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Enterprise Networking test suite

Introduction
After you configure CallPilot for Enterprise Networking, test the system.

The Enterprise Networking test suite tests every aspect of the system. If an
fails, resolve the problem and retry the test before you continue.

Note: These tests are not intended to validate the Enterprise compliance of
third-party system. The tests assume that any system that you communicate
is Enterprise-compliant.

Test suite
The Enterprise Networking test suite consists of five tests. Two tests are lo
site tests, which verify that your local configuration is correct. Three tests a
coordinated site tests, which verify that everything works properly at your s
and at every remote site.

The following table lists the local site tests and describes their purpose:

This local site test determines if

call routing test ■ the local system can make outbound 
calls to other sites in the network.

■ the local system cannot make 
outbound calls to restricted sites on th
network.

local SDNs test ■ Digital Signal Processing (DSP) cards
are working properly and SDNs are 
defined correctly.
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The following table lists the coordinated site tests and describes their purpo

Coordination
While you can perform local site tests independently, you must work with th
network administrators at each remote site to perform the coordinated site 

In some instances, the remote administrator must make preparations befor
can conduct the test. For example, to complete the loopback test, the remo
network administrator must create a loopback mailbox.

If a test is unsuccessful and you do not find the cause of the problem locall
work with the remote administrators to determine the cause of the problem.

For quick results
When you test your implementation of Enterprise Networking, there are two
ways to ensure quick results:

■ Change the batch threshold to 1.

■ Tag a test message as an urgent priority message.

An urgent tag ensures quick results. You do not need to change the schedu
parameters to perform the tests and return them to their original settings af
you complete the tests.

Note: Messages tagged as urgent are handled according to the scheduling 
parameters. For example, if the urgent message hold time is five minutes, it
take five minutes before the test message is sent.

This coordinated site test determines if

end-to-end test ■ a remote system can receive messag
from the local system.

loopback test ■ the local system can receive message
from the remote system.
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Call routing test

Introduction
The call routing test determines if the local system

■ can make outbound calls to other sites using Enterprise Networking

■ cannot make outbound calls to numbers that are configured as restricte
the system

Before you begin
Ask the switch technician for the ACD/UCD agent and trunk printouts for th
switch.

To perform the call routing test

1 Use the ACD/UCD agent and trunk printouts to select an ACD/UCD agent.

2 Program a telephone to use the same NCOS and TGAR as the agent.

Note: For instructions, consult your switch documentation.

3 Dial a network address.

4 Repeat steps 1–3 for a number that you know should be restricted.

Example: Attempt to access a trunk directly.

Evaluating test results
The call routing test is successful if an outbound call goes through to the allo
system but is blocked to a restricted system.

If the test is not successful
If the call routing test fails or produces unexpected results, a switch technic
must check the switch settings that control routing and restrictions on calls.

What’s next?
After you successfully complete the call routing test, perform the local SDN 
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Local SDN test

Introduction
The local SDN test verifies that the local system can receive messages from
remote system. This test confirms that the SDN for Enterprise Networking in
SDN Table is correct.

The quick SDN test can be substituted for the local SDN test. See Quick SDN 
test on page 221.

Note: The SDN for Enterprise Networking is, by default, the same default us
by AMIS Networking.

If Enterprise Networking and AMIS Networking share an SDN with another 
service, send the message to that SDN when you enter the system access 
number.

The SDN test consists of sending a message to a mailbox at your local site
address the message as if it is being sent to an Open AMIS site. You enter
system access number in dialable format. For this test, the system access n
consists of the following:

■ the access code required to dial out of the system

■ your local site’s number, including the exchange code and SDN

To perform the SDN test

1 Log in to CallPilot.

2 Press 75 to compose a message.

3 Enter the following:

■ the AMIS compose prefix

■ the system access number

■ # to indicate the end of the system access number
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4 Enter the local mailbox number on which you are currently logged, followed 
by #.

Result: The system responds with the following message: Open network 
user <mailbox number> at <system access number> .

5 Press # again to indicate the end of the list of recipients.

6 Press 5 to record a message.

7 Record the message.

8 Press # to stop the recording.

9 Tag the message as urgent.

10 Press 79 to send the message.

Result: The system responds with the following message: Message 
sent .

11 Log off.

Evaluating test results
The message is sent according to the scheduling parameters for urgent me

The test is successful if you receive the message you recorded.

The test is not successful if you receive a non-delivery notification message

If the test is not successful
If the SDN test is not successful, check the Enterprise Networking SDN in t
SDN Table. Review the SDN setup requirements and make any necessary
adjustments.

See also
For an overview of setting up SDNs, consult the Advanced Administration 
Guide.

For a detailed discussion of setting up SDNs for Enterprise Networking, con
Adding and configuring SDNs on page 124.

What’s next?
After you successfully complete the SDN test, perform the loopback test.
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Quick SDN test

Introduction
The quick SDN test verifies that the local system can receive messages. Th
confirms that Enterprise Networking is correctly configured in the SDN Tab

The quick SDN test does not require the participation of a remote network 
administrator.

The local SDN test can be substituted for the quick SDN test. See Local SDN 
test on page 219.

To perform the quick SDN test

1 Log in to CallPilot.

2 From your local telephone, enter the local SDN for Enterprise Networking.

3 Listen for the system to answer the call.

4 Repeat these steps for every SDN used by Enterprise Networking.

Evaluating test results
The quick SDN test is successful if the system answers and waits for a C-to
The system times out after approximately 20 seconds.

The test is not successful if any prompts are heard.

If the test is not successful
If the quick SDN test is not successful, check the Enterprise Networking SD
in the SDN Table. Review the SDN setup requirements and make any nece
adjustments.

For detailed information on setting up SDNs, consult the relevant section in
Advanced Administration Guide.

What’s next?
After you successfully complete the SDN test, perform the loopback test.
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Loopback test

Introduction
A loopback test confirms that a message can be sent from a local site to a re
site, and returned to the local site.

You should perform this test after you add each remote site to the local data

To perform the loopback test, compose and send a message to a loopback
mailbox at a remote site. A loopback mailbox automatically returns a messa
the originator.

Before you begin
Before you perform the loopback test, ensure that a loopback mailbox exist
each remote site tested.

Loopback mailbox
A loopback mailbox is a mailbox that is set up on every site in the messagin
network. The only purpose of a loopback mailbox is to return a confirmation
receipt.

Get the loopback mailbox number from the network administrator of each 
remote site with which you are performing the loopback test.

To perform the loopback test

1 Log in to CallPilot.

2 Press 75 to compose a message.

3 Enter the network address of the remote site.

4 Enter the loopback mailbox number of the remote site.

5 Press 5 to record a message.

6 Record the message, and press # to stop recording.

7 Tag the message as urgent.

8 Press 79 to send the message.
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9 Wait for your Message Waiting Indicator light to activate. This light indicates 
that the message was successfully returned to you.

Note: Activation may take several minutes.

10 Log in and listen to the message.

11 Log out of the system.

Evaluating test results
The test is successful if you hear the message that you recorded.

The message is not successful if you receive a non-delivery notification 
message.

If the test is not successful
If the test is not successful, do the following:

■ Check with the remote network administrator and confirm the loopback
mailbox number.

■ Perform the test again to ensure that the message was addressed corr

■ Consult the operational measurement reports to determine the followin

● Are the connection DNs correct?

● Is the remote site operational?

● Do the message transfer protocols match?

What’s next?
After you successfully complete the AMIS loopback test, perform the end-to
end test.
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End-to-end test

Introduction
An end-to-end test verifies that users at a remote site can receive message
users at the local site.

To perform the end-to-end test, send a message to a mailbox at a remote s
Send the test message to the mailbox of the remote network administrator 
request a confirmation.

Before you begin
You must coordinate with the remote network administrator of each site wit
which you wish to perform a loopback test. Each remote administrator mus
listen to the message you have sent before returning an acknowledgment t

To perform the end-to-end test

1 Log in to a mailbox.

2 Press 75 to compose a message.

3 Enter the mailbox address for a mailbox at a remote site.

4 Press #.

5 Press # again.

6 Press 5 to record a message.

7 Record the message, and then press # to stop the recording.

8 Tag the message as urgent.

9 Press 79 to send the message.

10 Log out of the system and hang up.

11 Ask the remote administrator to log in to the mailbox and listen to the 
message.

12 Wait for an acknowledgment to be returned to you.

13 Log in to the mailbox and listen to the acknowledgment.
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Evaluating test results
The test is successful if the message is successfully delivered to the remot
system.

The test is not successful if a non-delivery notification (NDN) is received, wh
indicates that the message was not delivered.

Confirming successful delivery
Even if you do not receive an NDN, you may want to confirm that the mess
was successfully delivered.

To confirm the delivery, either

■ log on to the remote site and read the message, or

■ ask the administrator at the remote site to log on and read the messag

If the test is not successful
If the end-to-end test fails or produces unexpected results, check the follow

■ Was the message correctly addressed?

■ Does the mailbox on the remote system exist?

■ Does the NDN provide any indication of the problem?

If you receive an NDN, listen to the message to determine why the test
message was not delivered.

IF the NDN states THEN

it took too many attempts to send 
the message

the cause may be

■ incorrect message transfer protocol.

■ incorrect site ID.

■ incorrect connection DN.

■ incorrect passwords.

■ the remote site is disabled.
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■ Do the alarms and events reports provide details of the possible cause

Since all previous tests have been successfully completed, the remote
probably caused the test to fail.

Examples of remote site causes include the following:

● Incorrect password pairs were assigned between sites.

● Channels were not available.

● Addresses were incorrect.

● Connection DNs do not terminate on the networking DN.

● A remote site that is not yet operational was specified.

What’s next?
The end-to-end test is the final test in the Enterprise Networking test suite. W
you successfully complete the loopback test, perform a backup of your 
configuration.

the address was incorrect the message was delivered to the remot
but could not be delivered. The cause may
be

■ the mailbox does not exist.

■ the wrong mailbox number was used.

■ the Receive Composed Messages box o
the Class of Services screen is set to N

■ the disk at the remote site is full.

IF the NDN states THEN
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Backing up Enterprise Networking

Introduction
When all tests of the system are successfully completed and Enterprise 
Networking is working properly, perform a backup.

The backup ensures that the configuration is not lost due to system failure.

Backup schedule
Perform a manual backup as the final step in the AMIS Networking installat

Note: You must perform a manual backup even if the system is configured 
perform an automatic backup. 

In the unlikely event that the system experiences a disk failure before the 
automatic backup takes place, the networking configuration could be lost.

Whenever you modify Enterprise Networking information during regular 
maintenance, perform a backup.

System backup components
A system backup consists of two parts:

■ switch backup

■ CallPilot backup

Switch backup
For detailed instructions on how to perform a switch backup, consult your 
switch documentation.

CallPilot backup
You can perform a full or partial backup of your CallPilot system. For detaile
instructions on how to perform a CallPilot backup, consult the Advanced 
Administration Guide.
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Maintaining Enterprise Networking

After you complete the Enterprise Networking implementation, you only nee
perform regular maintenance.

This chapter describes maintenance procedures that must be performed 
regularly. The chapter also describes maintenance procedures that you per
only when required.

In this chapter
About maintaining Enterprise Networking 231

Regularly scheduled maintenance tasks 237

As-required maintenance tasks 239

Maintaining remote users 261
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About maintaining Enterprise Networking

In this section
Overview 232

Maintain a network history 234

Printing configuration information 235
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Overview

Introduction
After you successfully install and test Enterprise Networking, you need to 
perform two types of maintenance tasks:

■ regularly scheduled

■ as-required

Regularly scheduled tasks
Regularly scheduled tasks include

■ checking the network status

■ reviewing Operational Measurement (OM) reports

Although you can perform regularly scheduled tasks at any time, perform th
tasks at least once a week. Since these tasks do not interfere with the oper
of the Enterprise network, you can schedule them at a convenient time duri
regular workday.

If you monitor the performance of your messaging network, you avoid futur
problems. Careful monitoring shows bottlenecks in the system and indicate
how the system can be improved.

Monitoring can also help you to plan and forecast future messaging networ
requirements.

As-required tasks
Perform as-required tasks as needs arise. As-required tasks include

■ modifying networking parameters

■ disabling and enabling Enterprise Networking

■ modifications to the Enterprise Networking configuration
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When to perform as-required tasks
Since as-required tasks may affect the entire system, perform these tasks w
the system is not in heavy use.

Modifications to the configuration may be necessary for the following reaso

■ New legal delivery times are announced for computer-generated calls.

■ The system performance suggests that adjustments to the parameters
required.

■ The system access number is changed.

Perform a backup following maintenance
Perform a backup of the system whenever you modify the network parame
as part of your maintenance.

ATTENTION! Because as-required tasks may affect the performance
the entire system, schedule them for off-peak hours.
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Maintain a network history

Introduction
Keep detailed records of a network’s history. These records can

■ indicate significant performance or equipment issues that real-time 
monitoring may not detect

■ provide a background for comparing the current information

■ provide information needed during support calls

Information to record
A network history should contain the following types of information:

■ installation dates and descriptions

■ contact information for all key personnel involved in the system installat
and configuration

■ details of software installed on the messaging server, including version

■ installation process and results, including tests

■ diagrams of the initial and subsequent network configurations

■ any problems encountered and their solutions

■ hardware and software changes

■ changes to the messaging network layout

Where to keep the records
Make the records of your messaging network easy to access and easy to re
Graphics, including hand-drawn sketches, can be very useful.

Keep records in a log or online. Note, however, that online records online ca
be accessed if the system fails.

See also
For a detailed description of messaging network histories, consult the 
Networking Planning Guide.
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Printing configuration information

Introduction
Printouts of the system configuration are often included in a network history
You can print all configuration information contained in your local network 
database.

To print configuration information, you must open the relevant Properties dia
box. For example, to print an item in the Messaging Network Configuration 
view, you must open the Properties dialog box of the item.

If a Properties dialog box consists of more than one tab, the contents of all 
are printed.

Note: You cannot print the tree view of the messaging network contained in
Messaging Network Configuration dialog box.

When to print configuration information
Although configuration information is always available in the most recent 
backup of your network database, you may find it convenient to make printo
as well.

Printouts of the configuration information are especially useful in the followi
situations:

■ You must fax information to a remote network administrator.

■ You are keeping a network history.

■ You are planning to change a configuration or delete an item from the 
Messaging Network Configuration tree view, and you want a hard copy
the original configuration.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration or Messaging 
Network Configuration

To print the configuration information

1 Open the dialog box that you want to print.

2 With the dialog box open, click the Print button.

Result: The contents of the dialog box print. The printout includes the 
contents of all tabs.
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In this section
Reviewing OM reports and alerts 238
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Reviewing OM reports and alerts

Introduction
Operational Measurement (OM) reports show how much of the CallPilot sys
is being used by Enterprise Networking.

Three OM reports provide Enterprise Networking information:

Although you can review OM reports at any time, you should review them a
least weekly.

Access to OM reports is restricted
The generation of OM reports is a restricted activity that is determined by ac
level. If you do not have the necessary access, you must ask your system 
administrator to generate the reports.

The OM report request screens let you choose the reports that you want to
and print. For many reports, you can also customize the displayed results s
you receive the information in a format that best suits your needs.

See also
For additional information on OM reports, including how to interpret them, 
consult the Reporter Guide.

This OM report provides

Open Networking Activity information about open networking activity 
over a specified time interval.

Network Usage Bill-back information to bill back the cost of users’ 
networking activities.

Failed Networking Sessions 
alert

notification that the number of networking 
failures equals or exceeds the total number o
networking attempts.
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As-required maintenance tasks

In this section
Overview 240

Modifying the Enterprise Networking configuration 242

Disabling and enabling Enterprise Networking 244

Modifying message delivery parameters 247

Modifying the channel resource allocation 249

Add, modify, or delete remote sites 251

Locating an item in the tree view 253

Modify a remote site configuration 254

Deleting items in the tree view 257

Modifying dialing plan information 260
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Overview

Introduction
You may need to modify the Enterprise Networking configuration, including

■ whether the system can send or receive Enterprise messages

■ the time periods when outgoing messages are allowed to be sent durin
business and nonbusiness days

■ the minimum and maximum port allocation for Enterprise Networking

■ how many messages to transmit in each Enterprise Networking sessio

■ the scheduling parameters

Scheduling parameters
The scheduling parameters that may be modified are

■ economy message send time

■ stale times for economy, standard, and urgent messages

■ batch threshold

■ delivery days and times

Identifying required modifications
Changes to the Enterprise Networking configuration may be required if

■ message delivery scheduling is not performing as anticipated

■ there are changes to the long-distance charge period or to delivery day
times
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Example 1
When you originally configured the system, you set the economy delivery s
time to 8:00 p.m. and the stale time to 4 hours. Users find that many of thei
messages are going stale and are being returned with non-delivery notifica

A coordination problem exists between the two scheduling parameters. If y
compose an economy message in the morning, it may go stale before the 
delivery time begins. Therefore, you must reconfigure the stale time to 20 ho
for example. This reconfiguration ensures that messages can be composed
throughout the business day and will not go stale before the delivery begins

Example 2
When you originally configured Enterprise Networking, the lower rates for lo
distance came into effect at 11:00 p.m. Therefore, you set the economy del
start time to 11:00 p.m.

However, the telephone company has announced new periods for lower lon
distance toll rates. Lower rates now begin at 8:00 p.m. Therefore, you chan
the economy delivery start time to 8:00 p.m.
Enterprise Networking Implementation and Administration Guide 241



Maintaining Enterprise Networking  Standard 1.0

 

es 
in 
Modifying the Enterprise Networking 
configuration

Introduction
If you need to modify the Enterprise Networking configuration, follow these
general guidelines.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration > Enterprise tab

To modify the Enterprise Networking configuration

1 Review Chapter 5, Configuring CallPilot for Enterprise Networking, to 
ensure that you understand the impact of the changes.

2 Enter all required modifications on the Enterprise tab.

3 Click Save.

Result: The system validates the modifications and, if they are valid, puts 
the modifications into operation immediately.

CAUTION!
. 

Risk of loss of functionality
Changes to the networking configuration should be done 
during hours when users are not logged on. Making chang
to the configuration while users are logged on may result 
loss of messaging functionality.
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Announce some modifications
Most of the modifications that you make to the Enterprise Networking 
configurations are transparent to your users. Although modifications may a
the performance of the system, they do not require any new input from use

However, if you modify the Enterprise site ID, you must announce this chan
to all local users.

If you modify the SAN, you must notify remote callers about this change. Al
remind your local users to tell users at the open sites about the changes.

Perform a backup
After you modify the configuration of Enterprise Networking, perform a back
to ensure that these changes are not lost.

Also record the changes in your network history.
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Disabling and enabling Enterprise Networking

Introduction
You may need to disable Enterprise Networking occasionally. When you dis
Enterprise Networking, users cannot compose, send, or receive Enterprise
messages.

You might disable Enterprise Networking to

■ prevent system abuse

■ temporarily suspend outgoing or incoming messages, or both

Messages sent while system is disabled
When you disable outbound Enterprise Networking, your local users can 
continue to compose and send messages. The messages composed by yo
users are held in queue until the option is enabled or the message become

When you disable inbound Enterprise Networking, messages from remote 
systems are rejected. The remote system that sends the message is inform
the status, and messages are not accepted.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration > Enterprise tab

To disable and enable Enterprise Networking

1 Do the following:

2 To save your settings, click Save.

Other ways to disable and enable Enterprise Networking
There are several ways to disable and enable Enterprise Networking. Use t
most appropriate method, depending on the circumstances.

In addition to the Message Delivery Configuration method described above
following methods are available:

IF you want to THEN

disable your system from receiving 
Enterprise messages

clear the Incoming Enterprise 
Networking check box.

disable your system from sending 
Enterprise messages

clear the Outgoing Enterprise 
Networking check box.

enable your system to receive Enterprise 
messages

select the Incoming Enterprise 
Networking check box.

enable your system to send Enterprise 
messages

select the Outgoing Enterprise 
Networking check box.

IF you want to THEN

disable or restrict the sending of 
Enterprise Networking messages 
to specific or all SANs by a user

change the Enterprise Restriction/
Permission List for the user.
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disable the sending of messages 
to any remote site, using any 
protocol, by the local server

clear the Send Messages to all other Serve
option in the Messaging Network 
Configuration dialog box for the local 
server.

Note: This option is available only if 
additional networking solutions are 
installed on your local system.

disable the sending of messages, 
using the defined protocol, to a 
specific remote site

clear the Send Messages to all other Serve
option in the Messaging Network 
Configuration dialog box for the remote 
server.

Note: This option is available only if 
additional networking solutions are 
installed on your local system.

IF you want to THEN
246 CallPilot



November 1998 Maintaining Enterprise Networking 

 
rs as 

 one 

ny 
o 

ious 
Modifying message delivery parameters

Introduction
Message delivery parameters control when and how Enterprise Networking
sends messages. You can modify the following message delivery paramete
required:

■ batch threshold

■ stale times

■ economy delivery start and stop times

Impact of modifications
The message delivery parameters are closely interrelated. Modifications to
parameter may necessitate changes to others. Therefore, carefully plan 
modifications in advance.

You must test and monitor the performance of the system after you make a
modifications to ensure that the modifications have the desired effect and n
unplanned side effects.

Note: Before you modify the message delivery parameters, review the prev
discussion of how these parameters are set in Chapter 5, Configuring CallPilot 
for Enterprise Networking.
Enterprise Networking Implementation and Administration Guide 247



Maintaining Enterprise Networking  Standard 1.0

 the 
Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration > Enterprise tab

To modify message delivery parameters

1 Modify the delivery parameters on the tab as required.

2 Review the changes to ensure that there are no conflicts among the 
parameters.

3 Click Save.

Perform a backup
After any modification to the configuration, perform a backup to ensure that
modification is not lost.
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Modifying the channel resource allocation

Introduction
When you implemented Enterprise Networking, you set the minimum and 
maximum channel resource allocation for both the inbound and the outboun
Enterprise Networking SDNs. The channel resources determine how efficie
services are accessed.

Balance channel resources
You must carefully balance channels for each service when you allocate cha
resources. You must allocate enough channels to ensure that users can acc
service. However, you must not overallocate channels so that users are una
access other services.

Determine if modifications are necessary
To determine if modifications to the channel resource allocation are necess
monitor service usage. After Enterprise Networking is in service for a period
time, use the Reporter feature to determine how services are being used.

Reporter provides the following statistics:

■ the number of calls queued for a service

■ the average wait time for queued calls

■ the maximum wait time for queued calls

■ the number of callers who abandoned the queue

If you are dissatisfied with the performance of AMIS Networking after 
analyzing these statistics, modify the resource allocation. However, remem
that modifications to the resource allocation for one service may affect the 
performance of other services.
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Getting there  Nortel SMI > Meridian Application Server > System Configuration 
> Service Administration > Service Directory Number > Service 
Directory Number Table

To modify an SDN

1 In the SDN Table, select the SDN you want to modify.

2 On the File menu, select Properties.

Result: The Edit Service Directory Number properties dialog box appears.

3 Make the necessary modifications.

4 Click Save.
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Add, modify, or delete remote sites

Introduction
As your messaging network grows and changes, you may need to add or de
remote site, or to modify the configuration of an existing remote site.

It is very important that all network administrators keep the information in th
network database up-to-date.

Before you begin
Before you add, modify, or delete a remote site, create a printout of all 
configuration information that will be affected.

Add a remote site
When you add a site to the messaging network, all sites add the new site to
Messaging Network Configuration tree view. The remote administrator mus
provide the information necessary to add and configure a remote site.

Modify a remote site
You can modify the configurations of both the messaging server and the sw
locations as needs change. For example, if a remote site upgrades its syste
must modify its configuration information in your network database.

It is important that the information in your network database reflect the actu
configuration of the remote site. The remote network administrator must info
you of all necessary changes.
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Delete a remote site
When you remove a site from the messaging network, the site must be dele
from the Messaging Network Configuration tree view.

Impact on network database
Your network database reflects any additions, modifications, or deletions to
remote sites. For this reason, you should perform the Enterprise Networking
suite again, as well as a backup.
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Locating an item in the tree view

Introduction
It can be difficult to locate a particular remote site, messaging server, or sw
location in the Messaging Network Configuration tree view in a very large 
messaging network.

There are two ways to locate an item in a large messaging network:

■ Scroll through the alphabetized list.

■ Use the Find feature.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To locate an item using Find

1 On the File menu, select Find.

Result: The Find dialog box appears.

2 Enter the name of the item to be located, and press the Find button.

Result: The located item is highlighted in the Messaging Network 
Configuration tree view.
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Modify a remote site configuration

Introduction
Modify the configuration of a remote site as required.

To modify a remote site, you must open the Messaging Network Configurat
tree view and select the remote messaging server or switch location that yo
wish to modify.

Further information
Make modifications to the configuration on the Properties dialog box where
initial configuration was made. To review the settings, consult the instructio
for the initial configuration.

Impact of modifications
When you modify the configuration of a remote system,  networking service
between the remote site and your local site may be affected. Modifications t
following settings are especially important:

■ site IDs

■ connection DN

■ dialing plans

■ message transfer protocol

To review the settings on this 
Properties dialog box consult

Remote Messaging Server Configuring a remote messaging server 
on page 178.

Remote Prime Switch Location Configuring a remote prime switch 
location on page 187.

Remote Satellite Switch Location Configuring a remote satellite switch 
location on page 199.
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Enterprise Site IDs
Do not change the remote site ID unless the administrator at the remote sit
notifies you of a change in that ID, or if the ID is incorrect.

If you change the site ID to an invalid number by mistake, the system is una
to send or receive messages from the site.

Connection DN
Do not change the connection DN to a remote site unless

■ the administrator at the remote site notifies you that the DN in the SDN
Table is changed, or

■ you are changing the message transfer protocol

Dialing plans
Do not change the dialing plan unless the dialing plan on the switch is chan

Message transfer protocol
Do not change the message transfer protocol unless all network administra
who use the protocol to exchange messages with your site agree to the cha
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration 

To modify the configuration of a remote site

1 In the Messaging Network Configuration tree view, select the remote 
messaging server or server that you want to modify. 

2 On the File Menu, select Open.

Result: The Properties dialog box for the selected item opens.

3 Make all required modifications.

4 Click Save.

Result: The modifications are validated and saved to the network 
database.

5 Repeat steps 1–4 for all items in the tree view that must be modified.

After modifications are complete
You must test modifications to the configuration of a remote site. Complete
test suite to ensure that the modifications work properly.

When you are satisfied that your system is working properly, perform a bac
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Deleting items in the tree view

Introduction
The Messaging Network Configuration tree view contains all sites in your 
messaging network with which the local site exchanges messages.

A site always consists of a messaging server and a prime switch location. A
may also include satellite switch locations.

Sites and satellite switch locations are deleted from the Messaging Network
Configuration tree view.

Note: You cannot delete the local site. You can delete local satellite switch 
locations.

Multi-administrator environments
If several administrators maintain your local network database, ensure that 
view of the Messaging Network Configuration tree view is up-to-date. The 
Messaging Network Configuration tree view is updated when it is initially 
opened. An open tree view is not updated when another administrator mak
changes.

To check the status of the view
To see if another administrator has made changes to the Messaging Netwo
Configuration tree view, on the View menu, click Refresh.

ATTENTION! When an item is deleted from the Messaging 
Network Configuration tree view, it is permanently
removed from the local network database. The 
information cannot be recovered.For this reason,
is strongly recommended that you print out the 
complete configuration of all items to be deleted. I
an item is accidentally deleted, you can use the 
printed information to add the item again.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To delete a remote site

1 Print the configuration details of the site that you want to delete.

2 Open the folder of the remote site to see the messaging server, prime 
switch location, and any satellite switch locations.

3 In a multi-administrator environment, on the View menu, click Refresh.

4 Highlight the messaging server of the site that you want to delete.

5 Select File > Delete.

Result: A confirmation box appears asking if you really want to delete the 
site from your local network database.

6 To delete the site, click Yes.

Tip: You can also delete a highlighted remote site by clicking the Delete 
button.

Deleting several remote sites at once
If you must delete several remote sites from the local network database, yo
may find it more efficient to delete all the sites at once.

To delete several remote sites at once

1 Print the configuration details of all the sites that you want to delete.

2 In the tree view, highlight all the remote sites that you want to delete.

Tip: To select more than one item in the tree view, press Ctrl and right-click 
the mouse.

3 Select File > Delete.

Result: A confirmation message appears. To delete the sites, click Yes. To 
keep the sites, click No.
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Deleting a satellite switch location
If there are changes to an NMS site, you can delete one or more satellite sw
locations from the local site or from any remote sites.

If you remove a satellite switch location from an NMS site, you must also 
remove it from the local network database.

To delete a satellite switch location  

1 Print the configuration details of the satellite switch location.

2 In a multi-administrator environment, on the View menu, click Refresh.

3 Highlight the satellite switch location that you want to delete.

4 On the File menu, click Delete.

Result: A confirmation message appears. To delete the sites, click Yes. To 
keep the sites, click No.
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Modifying dialing plan information

Introduction
After you establish a dialing plan, you rarely modify it. Modifications to a 
dialing plan affect users and may require considerable relearning of the sys

However, if modifications are necessary, they are usually guided by change
made by the switch technician. These changes can be local or remote.

Switch changes
If any changes to the dialing plan are made on a switch,  the network datab
of the sites in the messaging network must reflect these changes. If change
made locally, ensure that all remote sites are notified.

To modify the dialing plan information
If you need to modify the dialing plan, follow the general instructions to mod
the local and remote sites.

Modifying CDP steering codes
Modifications to the CDP steering codes are more complicated. For a detai
review of how to plan for and implement changes, consult Chapter 4, “Diali
plans and networking,” in the Networking Planning Guide.

Initiating and responding passwords
If you modify the initiating or responding password for a remote site in your
network database, you must ensure that the same change is made in the n
database of the remote site.

The initiating and responding passwords in both databases must match to e
proper communication between sites.

See also
For a review of how initiating and responding passwords must be set up, co
Initiating and responding passwords on page 84.
260 CallPilot



November 1998 Maintaining Enterprise Networking 
Maintaining remote users

In this section
Overview 262

Adding remote users with User Administration 263

Finding remote users 266

Printing a list of remote users 270

Modifying records of remote users 271

Manually deleting remote voice users 272
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Overview

Introduction
After you have added remote users, you will have to perform regular 
maintenance activities to keep your system working optimally.

Maintenance activities
Common maintenance activities include the following:

■ Add remote users.

■ Find remote users.

■ List remote users.

■ Print remote users.

■ Modify remote users.

■ Delete remote users.
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Adding remote users with User Administration

User Administration
With User Administration, you can manually add temporary and permanent
remote users. Remote users are added one at a time.

User Administration requires you to enter detailed information for each rem
user, including

■ general information

■ settings information

General information
Personal identification information is required for every remote user. This 
information includes

■ last name, first name, and initial

■ comments

■ title and department

The personal identification information should be as complete as possible.

Check the spelling of the remote user’s name. The name that you enter is u
by Name Dialing and Name Addressing.

Setting information
Setting information includes the following:

■ mailbox number

■ primary, secondary, and tertiary DNs

■ whether a personal verification is recorded

■ whether the remote user can be name-dialed by external callers

■ whether the remote user has temporary status
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Mailbox number
The remote user’s mailbox number must be in network format and must inc
the network prefix or steering code required to address to the mailbox. For 
example, if the remote user’s mailbox number is 4433 and the ESN prefix is
6233, enter 62334433.

DNs
A remote user can have up to three extension DNs. This means that a calle
dial any one of these numbers and reach the remote user.

The DNs must be in network format and must include the network prefix or 
steering code required to call the remote user.

Personal verification recorded
When a remote user is added with User Administration, the remote user’s o
voice cannot be used for the personal verification. The system administrato
must record a personal verification on behalf of the remote user.

When a personal verification has been recorded for the remote user, the Pe
verification recorded box says Yes.

When a personal verification has not been recorded for the remote user, th
Personal verification recorded box says No. Instead of a personal verificatio
callers hear the mailbox number and the site spoken name, if one exists.

Name-dialable by external callers
The remote user can be name-dialed by external callers who are not part of
network.

Temporary user
The remote user can either be a temporary user or a remote user. This stat
be changed as required.
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Last access time
Monitor the activity of remote users to ensure that the system is used optim
For example, if a permanent remote user has not used the system for a yea
may be best to change the user’s status from permanent to temporary.

When you add a remote user to your database, the last access time is 
automatically filled in. The last access time is automatically updated whene
the remote user uses the system.

Adding a remote user manually
You can add a remote system to your network database manually.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > User 
Administration > User Creation Template

To add a remote user with User Administration

1 In the User Creation Template list, select Remote User Template.

Result: The New User Template appears.

2 Ensure the User Properties and Mailbox Capabilities check boxes are 
selected.

3 On the General tab, complete all required information.

4 On the Settings tab, complete all required information.

5 Click Save.
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Finding remote users

Introduction
CallPilot enables you to find all users on your local system, including remot
users.

Finding a remote user is often your first step in a maintenance activity.

Methods available
There are two ways to find a remote user or a group of remote users.

To find a remote user whose mailbox number is known

1 From User Administration, select Remote User.

2 Select the Remote User item and press Enter. 

Result: You are prompted to enter a mailbox number.

3 Enter the remote user’s mailbox number, including the access code and 
network prefix, and press Return.

Result: The information for the remote user appears.

Finding a remote user whose mailbox number is not known
If you do not know a remote user’s mailbox number, you can find the user b
performing a search of the remote user database. You can use this method
find a single remote user or a group of remote users who share some 
characteristics.

IF THEN

you know the remote user’s mailbox 
number

use the Remote User dialog box.

you do not know the remote user’s 
mailbox number

use the Find Remote User dialog box.
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You can use various search criteria to help narrow your search. The search
criteria are what you know about the remote user, or group of remote users
CallPilot searches your database and returns a list of all users who meet th
specified criteria.

Search criteria
You can perform a search based on the following fields:

■ Mailbox number

■ Last name

■ First name

■ Department

■ Title

Wildcards in search criteria
When you are unsure of a character or string of characters in your search cr
you can use wildcards. Wildcards represent the unknown characters.

For example, if you do not know if a remote user’s last name is spelled Joh
or Jonski, you can enter Jo+nski. Your search will locate all remote users w
last name begins with Jo and ends with nski.

There are two valid wildcards:

■ The underscore (_) replaces a single character.

■ The plus sign (+) replaces a string of characters.

Wildcards can be used in the following fields:

■ Mailbox number

■ Last name

■ First name

■ Department

■ Title
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Examples
The following examples illustrate how the Find function can be used:

■ You need to find Robert Jones in the Technology Department.

■ You need to find an employee whose last name is Mordavia, but you do
know if she uses the first name Elizabeth, Beth, or Liz.

■ You must locate all users who have not yet recorded a personal verifica

■ You must find all users in the New Productions department so that they
be reassigned to the new Research and Development department.

Results: When the remote users are found, they are presented in a list. The
following information is provided for each found remote user, if available:

■ last name

■ first name

■ title

■ department

■ comments

Uses of the results list
The list of remote users that is displayed as a result of a search has various

View or modify a found remote user
You can view the information contained in the database for any remote use
the list.

To view the information, select the remote user whose information you wan
view, and press Enter. The remote user’s User Administration screen appe

You can modify the information about the remote user, including recording 
personal verification for a remote user or changing the status of a remote u
between temporary and permanent.

To modify the information, make all required changes to the information an
press Enter. The database is updated.
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Delete a remote user
Delete all remote users who are not required.

See also
For more information about working with users, consult the Basic 
Administration Guide.
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Printing a list of remote users

Introduction
You can print a list of all the remote users in your network database. This li
provides detailed information about the remote users and their activities. Re
this list as part of the regular maintenance of remote users in your network 
database.

Getting there  Nortel SMI > Meridian Application Server > User Administration > 
Users

To print the list of remote users

1 In the Users dialog box, on the File menu, click Open Search.

Result: The Search Users dialog box opens.

2 In the Condition box, select User Type.

3 In the Operator box, select “Is.”

4 In the Value box, select Temporary or Permanent Remote Users.

5 Click Search.

Result: A list of all remote user appears.

6 On the File menu, select Print.
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Modifying records of remote users

Introduction
You can modify the information about remote users when required. 
Modification of remote user records is important for keeping records up-to-d

Example
Hanna Moos is a permanent remote user at your site. Recently she was pro
and moved from the sales department to a senior management position in 
marketing. She received a new mailbox number as well.

You modify the information contained in your database to reflect these chan
In addition to changing the department and mailbox number fields, you cha
Hanna’s status from temporary to permanent.

Before you begin
To modify any information about a remote user, first find the remote user’s 
records.

Getting there  Nortel SMI > Meridian Application Server > User Administration > 
Users

To modify a remote user

1 Find the record of the remote user that you want to modify.

Note: For procedures on finding a remote user, consult Finding remote 
users on page 266.

2 Open the record of the remote user.

3 Make any necessary changes.

4 Click Save.
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Manually deleting remote voice users

Introduction
You can manually delete any remote user, both temporary and permanent.

Example
Two remote users, Pedro Afonso and Yang Wang, recently left your compa
You would like to remove them from your database. Pedro is a permanent 
remote user. If you do not manually remove his record, it will remain in you
database indefinitely. Yang is a temporary remote user. If you do not manu
remove his record, it will remain in the system until a nightly audit eventuall
removes it.

Before you begin
To manually delete a remote user, first find the remote user’s records.

To manually delete a remote user

1 Find the record of the remote user that you want to delete.

Note: For procedures on finding a remote user, consult Finding remote 
users on page 266.

2 Open the record of the remote user and make sure that it is the correct 
remote user.

3 To delete the record, click Remove.

4 Click Save.
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Troubleshooting Enterprise 
Networking

Although testing and regular maintenance procedures ensure that Enterpris
Networking is operating properly, the system may experience occasional 
problems. This chapter describes how to diagnose and correct these proble

In this chapter
About troubleshooting Enterprise Networking 275

Determining if problems are switch-related 281
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About troubleshooting Enterprise 
Networking

In this section
Overview 276

Determining if Enterprise Networking is disabled 278

Reviewing Alarm and Event reports 279

Reviewing Operational Measurement reports 280
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Overview

Introduction
If you are experiencing problems with Enterprise Networking, this chapter w
help you to identify and solve these problems.

Common causes of Enterprise Networking problems include the following:

■ Enterprise Networking is disabled.

■ The status of a remote site prevents it from receiving messages from t
local site.

■ Networking configuration is incorrect or incomplete.

■ The switch is configured incorrectly.

■ There are hardware problems.

Identifying the source of the problem
To identify the source of the problem, first determine if Enterprise Networkin
disabled.

If Enterprise Networking is properly enabled, then review the following:

■ appropriate Alarm and Event reports

■ network status

■ Operational Measurement (OM) reports

Configuration errors
Configuration errors may include the following:

■ incorrect connection DNs

■ message transfer protocols that do not match between the remote and
sites

■ incorrect dialing plan information, including ESN prefixes and CDP 
steering codes

■ scheduling parameters that need to be modified
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Site status errors
A site can be either intentionally disabled or put into error status.

A remote site may be put into error status because of unsuccessful attempt
the local site to deliver messages to the remote site. Failed message delive
happen for the following reasons:

■ The remote site is experiencing hardware or software problems.

■ There are site configuration errors.

Switch-related problems
If you are unable to identify the problem using CallPilot, the error may be 
switch-related. Perform the call trace test.

Call trace
Call trace helps you to determine if network calls are being blocked for one
more of the following reasons:

■ Digit manipulation is performed incorrectly. Either not enough or too ma
digits are inserted or deleted.

■ Class of service restrictions are either too stringent or too loose.

■ Dialing is incorrect. More digits are required by the trunks or trunk route

On the switch, you can perform a call trace on a telephone or on a trunk an
trunk route.

Hardware problems
If you are unable to locate the problem in the CallPilot networking configurat
or in the switch, your system may be experiencing hardware problems that
not related to networking.

Solution
Perform a basic hardware check. Examine all connections.
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Determining if Enterprise Networking is 
disabled

Introduction
You must enable Enterprise Networking to receive incoming Enterprise 
messages and to deliver outgoing Enterprise messages.

Begin any troubleshooting session by determining if Enterprise Networking
properly enabled.

There are several methods of disabling and enabling the sending and recei
of Enterprise Networking messages. 

To determine if Enterprise Networking is disabled
To determine if Enterprise Networking has been disabled to receive incomi
messages or to send outgoing messages, or both, check the settings on th
Enterprise tab of the Message Delivery Configuration dialog box.

1 From the Message Delivery Configuration dialog box, select the Enterprise 
tab.

2 Check the settings of the Outgoing Enterprise networking and Incoming 
Enterprise networking check boxes. Ensure that these check boxes are 
selected as required for your system.

3 Click Save to exit and save any changes that you made.

IF THEN check this setting

the system does not receive 
incoming messages

Incoming Enterprise messages enabled.

the system does not deliver 
outgoing messages

Outgoing Enterprise messages enabled.
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Reviewing Alarm and Event reports

Introduction
Alarm and Event reports track and report system errors and unusual events
These reports can be viewed on-screen or printed, or both.

Reports related to Enterprise Networking
The following reports are useful for monitoring Enterprise Networking:

■ Networking Activity report

■ Network Usage Bill-back report

■ Failed Networking Sessions alert

See also
For instructions on reviewing and interpreting Alarm and Event reports, con
the Reporter Guide.
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Reviewing Operational Measurement reports

OM reports
Operational Measurement (OM) reports contain detailed information on how
system is functioning. When you attempt to locate problems with Enterprise
Networking, review these reports.

When you review the OM reports, consider the following:

See also
For detailed instructions on producing, reviewing, and interpreting Operatio
Measurement reports, consult the Reporter Guide.

This OM result suggests

large number of accesses the holding time may be too low, or the batch thresh
too small.

excessive “Failed to Send” 
messages

the remote system may be down, or the dialing 
translations are incorrectly configured, or the call 
maximum number is too small.

high number of NDNs users are entering incorrect addresses, or mailboxes d
exist on the remote system.

networking traffic is 
excessive

an unusual or cyclical event affected the system, or the
number of channels used by Enterprise Networking is to
small, or the number of channels available to Enterprise
Networking is too small.

failures the remote system does not support the Enterprise 
Networking protocol, or the number of channels is too 
small.
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Determining if problems are switch-
related

In this section
Switch-related problems 282

Call trace test 283

Link diagnostic test 285
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Switch-related problems

Enterprise Networking problems and the switch
If you cannot identify the cause of the Enterprise Networking errors using 
CallPilot, the problem may be switch-related.

The following tests identify switch-related problems:

■ call trace

■ link diagnostic
282 CallPilot
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Call trace test

Purpose
If you cannot identify the Enterprise Networking problem using CallPilot, ca
may be blocked by the switch. The call trace test determines

■ if calls are blocked

■ why calls are blocked

Why calls are blocked
A network call can be blocked for one or more of the following reasons:

■ Digit manipulation is performed incorrectly. Not enough or too many dig
are inserted or deleted.

■ Class of service restrictions are too stringent or too loose.

■ Dialing is incorrect. More digits are required by the trunks or card trunk
routes.

Where a call trace is performed
On the switch, you can perform a call trace on a telephone or on a trunk an
trunk route.

Before you begin
To interpret the results of a call trace test, you need to understand

■ how the switch processes calls

■ how to interpret the results of a call trace session

A switch technician should perform the call trace test and interpret the resu
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The information that is required to perform the call trace test varies for each 
of switch. However, the following information is usually required:

■ your customer number

■ the directory number that will be tested

■ the type of telephone and key number (for multiline telephones)

■ the terminal number (loop, shelf, card, unit) of the telephone or trunk th
will be tested

■ the route type and trunk number of the trunk and trunk route that will b
tested

To perform the call trace test
Follow the instructions in your switch documentation.

How to interpret the results
For guidelines on how to interpret the results of the call trace test, consult y
switch documentation.
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Link diagnostic test

Purpose
If you cannot identify the cause of the networking problem on the CallPilot or
performing the call trace test, the problem may not be related to networking

The link diagnostic test determines if the link between the switch and the 
Meridian Application Server is working.

Before you begin
The link diagnostic must be performed by a switch technician.

To perform the link diagnostic test
Follow the instructions in your switch documentation.
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A
Add/Update Remote Users on this Server, 158

B
Batch Threshold, 139

C
CDP Steering Code

Overlap, 173
Prime Switch Location Properties dialog box, 

173
Remote Prime and Satellite Switch Location 

Properties dialog boxes, 196
Collect (number of) messages before sending 

(Batch Threshold), 139

D
Description

Local Messaging Server Properties dialog 
box, 157

Prime Switch Location Properties dialog box, 
165

Remote Messaging Server Properties dialog 
box, 180

Remote Prime and Satellite Switch Location 
Properties dialog boxes, 188

Dialing plans for dialing to this location
Prime Switch Location Properties dialog box, 

166
Remote Prime and Satellite Switch Location 

Properties dialog boxes, 190

E
Economy delivery start and stop times, 139

Economy stale time, 140
Enterprise economy delivery start and stop 

times, 139
Enterprise Location ID

Prime Switch Location Properties dialog box
165

Remote Prime and Satellite Switch Location
Properties dialog boxes, 189

Enterprise Networking Connection DNs, 184
Enterprise Site ID

Local Messaging Server Properties dialog 
box, 159

Remote Messaging Server Properties dialog
box, 182

ESN Access Code used by this location
Prime Switch Location Properties dialog box

169
Remote Prime Switch Location Properties 

dialog box, 193
ESN Location Code

Overlap, 169
Prime Switch Location Properties dialog box

169
Remote Prime and Satellite Switch Location

Properties dialog boxes, 193

I
Incoming Enterprise networking, 138
Initiating Password, 184

L
Local Messaging Server Properties dialog box

Add/Update Remote Users on this Server, 
158

Description, 157
Enterprise Site ID, 159
Name, 157
Receive Message Text Info, 159
Send Messages to all other Servers, 157
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Server FQDN, 159
Server type, 157

M
Mailbox addressing follows dialing plan

Prime Switch Location Properties dialog box, 
166

Remote Prime and Satellite Switch Location 
Properties dialog boxes, 190

Mailbox prefixes
Prime Switch Location Properties dialog box, 

166
Remote Prime and Satellite Switch Location 

Properties dialog boxes, 191
Message Delivery Configuration dialog box

Batch Threshold, 139
Collect (number of) messages before sending 

(Batch Threshold), 139
Economy delivery start and stop times, 139
Economy stale time, 140
Enterprise economy delivery start and stop 

times, 139
Incoming Enterprise networking, 138
Outgoing Enterprise networking, 138
Standard stale time, 140
Urgent stale time, 140

Messaging Administration Properties dialog box
Networking Loopback mailbox, 143

N
Name

Local Messaging Server Properties dialog 
box, 157

Prime Switch Location Properties dialog box, 
165

Remote Messaging Server Properties dialog 
box, 179

Remote Prime and Satellite Switch Location 
Properties dialog boxes, 188

Network protocol, 183
Networking Loopback mailbox, 143

O
Outgoing Enterprise networking, 138
Overlap

CDP Steering Code, 173
ESN Location Code, 169

P
Prime Switch Location Properties dialog box

CDP Steering Code, 173
CDP Steering Code Overlap, 173
Description, 165
Dialing plans for dialing to this location, 166
Enterprise Location ID, 165
ESN Access Code used by this location, 16
ESN Location Code, 169
ESN Location Code Overlap, 169
Mailbox addressing follows dialing plan, 166
Mailbox prefixes, 166
Name, 165
Spoken Name Recorded, 165

R
Receive Message Text Info, 159
Remote Messaging Server Properties dialog b

Description, 180
Enterprise Networking Connection DNs, 184
Enterprise Site ID, 182
Initiating Password, 184
Name, 179
Network protocol, 183
Responding Password, 184
Send local user information to this Server, 

181
Send Message Text Info to this Server, 182
Send Messages to this Server, 180
Server FQDN, 182
Server type, 180

Remote Prime and Satellite Switch Location 
Properties dialog box

CDP Steering Code Overlap, 196
Remote Prime and Satellite Switch Location 

Properties dialog boxes
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CDP Steering Code, 196
Description, 188
Dialing plans for dialing to this location, 190
Enterprise Location ID, 189
ESN Access Code used by this location, 193
ESN Location Code Overlap, 193
ESN Location Codes, 193
Mailbox addressing follows dialing plan, 190
Mailbox prefixes, 191
Name, 188

Remote Prime Switch Location Properties 
dialog box

See also Remote Prime and Satellite Switch 
Location Properties dialog boxes

Spoken Name Recorded, 189
Remote Satellite Switch Location Properties 

dialog box
See also Remote Prime and Satellite Switch 

Location Properties dialog boxes
Spoken Name Recorded, 200

Responding Password, 184

S
Send local user information to this Server, 181
Send Message Text Info to this Server, 182
Send Messages to all other Servers, 157
Send Messages to this Server, 180
Server FQDN

Local Messaging Server Properties dialog 
box, 159

Remote Messaging Server Properties dialog 
box, 182

Server type
Local Messaging Server Properties dialog 

box, 157
Remote Messaging Server Properties dialog 

box, 180
SMTP/VPIM Server FQDN

Local Messaging Server Properties dialog 
box, 159

Remote Messaging Server Properties dialog 
box, 182

Spoken Name Recorded
Prime Switch Location Properties dialog box, 

165
Remote Prime Switch Location Properties 

dialog box, 189
Remote Satellite Switch Location Properties

dialog box, 200
Standard stale time, 140

U
Urgent stale time, 140
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Numerics
120-Minute Messages��64

A
access code, ESN��169
access to OM reports��238
Acknowledgment Tag��64
adding a remote site��251
adding a remote user

with User Administration��265
adding and configuring a remote site��176

information required��176
main steps��176

Administrator-Recorded Personal Verification��

63
AMIS Networking

implementation��76
ANA (Analog Networking Agent)

call setup��94
description��89
function��93

as-required maintenance tasks��232

B
backing up Enterprise Networking��227

backup schedule��227
CallPilot backup��227
switch backup��227
types of backup��227

backup��75
balancing channel resources��249
batch threshold

default value��136
description��81��139
impact of holding time��140

C
call routing test

evaluating results��218
procedure��218
purpose��216

Call Sender��62
call trace test

preliminary requirements��283
purpose��283

CallPilot
and Enterprise Networking��58
and Enterprise Networking features��62
backup��227
configuring��134

CDP dialing plan
configuration overview��172

CDP information
configuring��174
remote prime switch location��196

CDP steering code��173
overlap��173

CDP tab
Prime Switch Location Properties dialog box��

163
Remote Prime Switch Location Properties 

dialog box��187
Remote Satellite Switch Location Properties

dialog box��199
channel resource allocation��249

determining if modifications are required��
249

minimum and maximum��121
modifying��249

channel types supported��120
checklist for gathering information��106
complex messaging network��60

implementation in��76
order of implementation��76

configuration errors��276
configuration, printing information��235
configuring a remote messaging server��185
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overview��178
configuring a remote satellite switch location��

201
configuring a remote satellite switch location, 

overview��199
configuring a remote switch location

overview��187
configuring CallPilot for Enterprise 

Networking��74
configuring CallPilot, main steps��134
configuring CDP information��174

for a remote prime switch location��197
configuring Enterprise Networking

if other networking solutions are 
implemented��149

overview��135
preliminary requirements��134��137
required information��135
suggested process��137

configuring ESN information��170
configuring local prime switch location��167

overview��162
configuring local server

overview��156
configuring local site��154

process��154
configuring message delivery parameters��141
configuring non-CallPilot system as a remote 

site��209
configuring the switch, preliminary 

requirements��116
confirming switch settings��104
connection DN

modifying��255
remote messaging server��184

Connections tab, Remote Messaging Server 
Properties dialog box��183

controlled directory number queues��128
types��128

creating a loopback mailbox��144
creating diagram of messaging network��110
creating messaging network representation��73
creating spreadsheet of messaging network��110

D
default value

batch threshold��136
delivery stop time for economy messages��

136
holding time for standard messages��136
holding time for urgent messages��136
parameters��80
reason to use��136
scheduling parameters��136
stale time for economy messages��136
stale time for standard messages��136
stale time for urgent messages��136

definition
Enterprise Networking��58
loopback mailbox��143
service directory number (SDN)��118

deleting
a remote user manually��272
a satellite switch location��259
in multi-administrator environment��257
remote messaging server��257
remote site��257
satellite switch location��257
several remote sites��258

delivery start and stop times��83
economy messages��139

delivery start time for economy messages��83
default value, default value

delivery start time for economy messages��

136
delivery stop time for economy messages��83

default value��136
diagram

how MTA and ANA handle messages��90
diagram of messaging network��110
dialing plan

CDP for remote prime switch location��196
CDP information��172
configuring��108
ESN for remote prime switch location��193
ESN information��168
information for remote prime switch 

location��190
information required from switch��103
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mailbox addressing follows��166
mailbox addressing follows for remote prime 

switch location��190
modifying��255��260
remote satellite switch location��200
requirements��108
used to a remote switch location��190

directory number (DN)
and switch��128
for Enterprise Networking��128

disabling Enterprise Networking��138��244
other methods��245

dual-tone multifrequency signaling��59

E
economy message

delivery start and stop times��83��139
economy priority message��79
Economy Tag��64
enabling Enterprise Networking��138��157��244

other methods��245
end-to-end test

evaluating results��225
procedure��224
purpose��217

Enterprise Location ID
local prime switch location��165
remote prime switch location��189

Enterprise Networking
and CallPilot��58
and Names Across the Network��66
backing up information��75
configuring a remote messaging server��185
configuring a remote satellite switch location��

201
configuring CDP information��174
configuring CDP information for remote 

prime switch location��197
configuring ESN information for a remote 

prime switch location��194
configuring parameters��141
configuring the local server��160
definition��58

determining if disabled��278
directory number��128
disabling��138��244
enabling��138��244
Enterprise Location ID��189
Enterprise Site ID��159
features��62
gathering information��102
implementation in a complex messaging 

network��76
implementation overview��72
in complex network��60
information validation��74
internal controls��88
local site configuration��154
maintaining��232
message��59
message contents��78
message handling��78
modifying an SDN��250
modifying channel resource allocation��249
modifying configuration��240
modifying message delivery parameters��

247��248
Names Across the Network��158
parameters��80
performing backups��227
phantom DN��129
preliminary requirements for configuration��

148
protocol used��59
receiving message text information��159
relevant OM reports��238
sending message text information to a remo

site��182
site IDs��60
switch configuration required��116
switch requirements��116
switch settings required��108��128
switch-related problems��282
testing��74
troubleshooting overview��276

Enterprise Networking protocol��59
Enterprise Networking test suite��216

call routing test��216
end-to-end test��217
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local SDN test��216
loopback test��217

Enterprise Site ID��60
description��84��159
modifying��255
remote messaging server��182

Enterprise tab, Message Delivery Configuration 
dialog box��138

ESN
access code��169
location code��169
location code overlap��169

ESN dialing plan, configuration overview��168
ESN information

remote prime switch location��193
ESN tab

Prime Switch Location Properties dialog box��

163
Remote Prime Switch Location Properties 

dialog box��187
Remote Satellite Switch Location Properties 

dialog box��199
evaluating gathered information��108

F
Failed Networking Sessions alert��238
Fax Call Answering CDN queues��128
fax channel type��120
features of Enterprise Networking��62
Find key, using to locate an item��253
finding a remote site��253
finding a remote user��266
finding problem with Enterprise Networking��

276
FQDN of local SMTP/VPIM server��154��159

G
gathering information

checklist��106
evaluating��108
for network��73
from other sites��109
from switch��103

purpose��102
remote switch location checklist��107
required from switch��105
switch information��73
to implement Enterprise Networking��102

General tab
Prime Switch Location Properties dialog box��

163
Remote Messaging Server Properties dialog

box��179
Remote Prime Switch Location Properties 

dialog box��188��199
Remote Switch Location Properties dialog 

box��187

H
hardware problems��277
header contents��78
holding time

description��81
interaction with batch threshold��140
relationship to stale time��140
standard messages��81
urgent messages��81

holding time for standard messages
default value��136

holding time for urgent messages
default value��136

how a message is transferred��94
how to

add a remote user with User Administration��

265
add and configure a new inbound service 

directory number (SDN)��125
check Enterprise Location ID��208
configure a remote messaging server��185
configure a remote satellite switch location��

201
configure CDP information��174
configure CDP information for a remote 

prime switch location��197
configure Enterprise Networking parameters��

141
configure ESN information��170
294 CallPilot



November 1998 Index

 

 

configure ESN information for remote prime 
switch location��194

configure local prime switch location��167
configure the local messaging server��160
create a loopback mailbox��144
delete a remote site��258
delete a satellite switch location��259
delete several remote sites��258
determine if Enterprise Networking is 

disabled��278
disable Enterprise Networking��245
enable Enterprise Networking��245
find a remote user with a known mailbox 

number��266
find a remote user with an unknown mailbox 

number��266
import a spoken name��206
locate an item using Find��253
modify an SDN��250
modify dialing plan information��260
modify message delivery parameters��248
modify remote site configuration��256
modify the Enterprise Networking 

configuration��242
open the Prime Switch Location Properties 

dialog box��164
print configuration information��236
print list of remote users��270
record a spoken name��204
share an existing inbound service directory 

number (SDN)��126

I
impact of modifications��247
implementation

backup��75
configuring CallPilot��74
configuring the switch��73
gather information for network��73
main steps��72
order in complex messaging network��76
overview��72
parameters set during��80
preliminary requirements��72

recommended order in complex messaging
network��76

testing��74
validation��74

implementing Enterprise Networking, NMS 
local site��149

importing a spoken name��205��206
inbound service directory number (SDN)

how to add and configure new��125
how to share existing��126
services that can share��124
ways to set up��124

indicators in OM reports��280
information, gathering to implement Enterprise

Networking��102
initiating password��184

description��84
modifying��260

Integrated AMIS Networking
implementation��76

L
last access time��265
link diagnostic test, purpose��285
local messaging server name��154
local prime switch location

configuration if NMS local site��162
configuration if other networking solution 

implemented��162
configuration overview��162
configuration procedure��167
description��165
Enterprise Location ID��165
mailbox prefix��166
name��165
Prime Switch Location Properties dialog box��

163
recording spoken name��165

local SDN test
evaluating results��220
procedure��219
purpose��216

local server
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configuration if another networking solution 
implemented��155

configuration overview��156
configuration process��160
name��157
server type��157

local server FQDN��159
local site configuration��154
local site name��154��157
locating a remote user��266
locating remote site��253
location code

ESN��169
overlap��169

loopback mailbox
creating��144
definition��143
description��143
requirements��143
using��144

loopback test
evaluating results��223
procedure��222

M
mailbox addressing follows dialing plan

local prime switch location��166
remote prime switch location��190

mailbox prefix
local prime switch location��166
remote prime switch location��191

mailbox, loopback��143
main steps in implementation��72
maintenance

as-required tasks��232
backups following��233
overview��232
regularly scheduled tasks��232

Meridian Mail system
remote site��211

message
body contents��79
handling scenario��95
header contents��78

parts��59��78
priorities��79
transfer process��94

message body contents��79
Message Delivery Configuration dialog box, 

Enterprise tab��138
message delivery parameters

modifying configuration��247
message delivery parameters, configuring��141
message handling��90
Message Subject (Text)��64
message transfer protocol, modifying��255
message transfer, main steps��89
messages sent while system disabled��244
messaging network��148
Messaging Network Configuration tree view

adding sites��148
messaging network representation

benefits��111
coordination with other sites��111
diagram��110
implementation��73
overview��110
security��111
spreadsheet��110

modifying a remote site��251
modifying channel resource allocation��249
modifying configuration of Enterprise 

Networking��240
modifying connection DN��255
modifying dialing plan��255��260
modifying Enterprise Networking

announcing��243
modifying Enterprise Site ID��255
modifying message delivery parameters��247
modifying message transfer protocol��255
modifying passwords��260
modifying records of remote users��271
modifying remote site��251

impact��254
impact on network database��252
preliminary requirement��251

modifying remote site configuration��254
MTA (Message Transfer Agent), description��88
MTA Monitor, description��88
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multi-administrator environment, deleting items 
from tree view��257

Multiple Recipients��63

N
name

local prime switch location��165
local server��157
local site��154
remote prime switch location��188
remote site��179

Name Addressing��62
Names Across the Network��62��158

adding remote users��66
configuration examples��66
limitations��69
outgoing sessions��70
overview��66

network database, impact of modifying remote 
sites��252

network history
contents��234
overview��234

network message service (NMS)
local site��149

network protocol used with a remote site��183
network representation, using to add and 

configure a remote site��176
Network Usage Bill-back report��238
networking solutions

configuration if implemented��149
order of implementation��76

NMS local site, configuring local prime switch 
location��162

NMS site
spoken name imported for��205
spoken name recorded for��203

non-CallPilot remote sites��209
non-CallPilot system

server type��209
Norstar Voice Mail, remote site��212

O
OM reports

importance of reviewing��238
relevant for Enterprise Networking��238
restricted access��238

Open Networking Activity report��238
outbound service directory number (SDN)��124
overlap

CDP steering code��173
ESN location code��169

P
parameters

default values��80
Enterprise Networking��80
set during implementation��80

passwords
description��84
modifying��260

passwords for remote site��184
Personal Distribution Lists��62
personal verification recorded, remote user��264
phantom DNs

relationship to service directory number 
(SDN)��120

required by Enterprise Networking��129
ways to create��130

prefix, mailbox��166
Prime Switch Location Properties dialog box��

163
CDP tab��163
ESN tab��163
General tab��163
opening��164
SMTP/VPIM tab��163

printing
configuration information��235
list of remote users��270

priorities of messages��79
Private Tag��63
protocol

Enterprise Networking��59
used with a remote site��183
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Q
quick SDN test

evaluating results��221
procedure��221
purpose��216

R
Received Time Announced��64
receiving message text information��159
Recipient’s Name (Text)��64
recommended order of implementation��76
recording a spoken name��204
regularly scheduled maintenance tasks��232
remote messaging server

configuration if another messaging solution 
implemented��178

configuration overview��178
connection DN��184
deleting��257
Enterprise Site ID��182
name��179
network protocol used��183
sending local user information to��181
sending message text information��182
sending messages to a remote site��180
server FQDN��182
server types supported��180

Remote Messaging Server Properties dialog box
Connections tab��183
General tab��179

remote prime switch location
CDP information��196
configuring ESN information��194
dialing plan for dialing to this location��190
dialing plan information��190
Enterprise Location ID��189
ESN information��193
mailbox addressing follows dialing plan��190
mailbox prefix��191
name��188

Remote Prime Switch Location Properties 
dialog box

CDP tab��187

ESN tab��187
General tab��188
SMTP/VPIM tab��187
tabs��187

remote satellite switch location
configuration overview��199
configuring��201
dialing plan��200
spoken name recorded��200

Remote Satellite Switch Location Properties 
dialog box

CDP tab��199
ESN tab��199
tabs��199

remote site
adding��251
adding and configuring��176
adding, modifying, and deleting��251
checking configuration��207
correcting information about��177
deleting��257
how to modify configuration��256
information required to add and configure��

176
locating��253
Meridian Mail system��211
modification impact��254
modifying configuration��251��254
non-CallPilot��209
Norstar Voice Mail system��212
passwords��184
using network representation to add and 

configure��176
remote site name��179
Remote Site Spoken Names��63
remote sites

if other networking solutions implemented��
149

main steps to add and configure��176
remote switch location

configuration overview��187
spoken name��203��205

Remote Switch Location Properties dialog box
General tab��187

remote switch location, information required��
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adding with User Administration��263
DN��264
finding��266
last access time��265
mailbox number��264
maintenance overview��262
manually deleting��272
methods for finding��266
modifying records of��271
personal verification recorded��264
printing list of��270
status��264
temporary��66
time stamps��70
when added and updated��69

remote user information, sending��70
remote users

adding with Names Across the Network��66
examples of Names Across the Network��66

Reply All��63
Reply To��63
reports for Enterprise Networking��279
responding password��184

description��84
modifying��260

restricting
message exchange��157
sending messages to a remote site��180

reviewing Alarm and Event reports��279
reviewing OM reports��238

what to look for��280

S
satellite switch location, deleting��257
scheduling backups��227
Sender’s Department��65
Sender’s Name (Text)��64
sending local user information to a remote site��

181
sending message text information to a remote 

site��182
sending messages to other sites��157
Sent Time Announced��64

server FQDN��154��159
remote site��182

server type
local server��157
non-CallPilot remote sites��209
supported for remote messaging server��180

service directory number (SDN)
adding and configuring new��125
and DN setting on switch��120
definition��118
examples��121
how to modify��250
inbound��118��124
outbound��118��124
relationship to other numbers��120
sharing existing inbound��126

Service Directory Number (SDN) Table
description��118
example��119

Shared Distribution Lists��63
site ID number��60
site status errors��277
SMTP/VPIM server FQDN��154
SMTP/VPIM tab

Prime Switch Location Properties dialog box��

163
Remote Prime Switch Location Properties 

dialog box��187
speech recognition channel type��120
Speech Recognition Messaging CDN queues��

128
spoken name

for remote switch location��203��205
importing��205��206
importing for local NMS site��205
recorded for remote satellite switch location��

200
recording��204
recording for local NMS site��203
recording for local prime switch location��165
recording overview��203
ways to record��189

spreadsheet of messaging network��110
stale time

description��82
relationship to holding time��140
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stale time for economy messages, default value��

136
stale time for standard messages, default value��

136
stale time for urgent messages, default value��

136
standard message, holding time��81
standard priority message��79
steering code for CDP��173
switch

and directory numbers (DNs)��128
configuration changes��260
configuring for Enterprise Networking��73
confirming settings��104
dialing plan information required��103
Enterprise Networking requirements��116
gathering information��103
how an Enterprise Networking message is 

treated��116
information required from��105
information to gather��73
mandatory requirements��108
setting required for Enterprise Networking��

128
switch backup��227
switch configuration

preliminary requirements��116
requirements for Enterprise Networking��116

switch-related problems��282
call trace��277
call trace test��283
link diagnostic test��285

T
temporary remote user, Names Across the 

Network��66
test suite

call routing test��216
end-to-end test��217
local SDN test��216
purpose��216
quick SDN test��216
tests included��216

testing Enterprise Networking��74

coordination required��217
ensuring quick results��217

testing with loopback mailbox��144
text information in messages��159
time stamps of remote users��70
Timed Delivery��65
tree view, deleting items��257
troubleshooting Enterprise Networking

configuration errors��276
hardware problems��277
identifying problem��276
overview��276
site status errors��277
switch-related problems��277

U
urgent message��79

holding time��81
Urgent Tag��64
User Administration

adding a remote user��263��265
User’s Actual Personal Verification��63
using a loopback mailbox��144

V
validation of information��74
voice channel type��120
Voice Messaging controlled directory number 

queue��128
VPIM Networking, server FQDN of remote site��

182

W
ways to disable to disable Enterprise 

Networking��245
ways to enable Enterprise Networking��245
300 CallPilot



CALLPILOT, NORTEL NETWORKS, NORTEL, NORTEL NETWORKS HOW THE WORLD 
SHARES IDEAS, NORTHERN TELECOM, BNR, DMS, DMS-100, DMS-250, DMS-MTX, DMS-
SCP, DNC, DPN, DUALMODE, HELMSMAN, IVR, LINK, MAP, MERIDIAN DIGITAL CENTREX 
(MDC), MERIDIAN, MERIDIAN 1, MERIDIAN LINK, MERIDIAN MAIL, MERIDIAN MAX, MFA, 
NORSTAR, SL-1, SL-100, SUPERNODE, SYMPOSIUM, and UNITY are trademarks of Northern 
Telecom Limited. TELESIS is a trademark of Bell-Northern Research.

ACCENT is a trademark of Accent Software International Ltd.

ACTION REQUEST SYSTEM and AR SYSTEM are trademarks of Remedy Corporation.

AMDEK is a trademark of Amdek Corporation.

ANSI is a trademark of the American National Standards Institute, Inc. 

AT&T is a trademark of American Telephone and Telegraph Corporation.

ATRIA is a trademark of Pure Atria Corporation.

CASEWARE is a trademark of Caseware, Inc.

CLEARCASE is a trademark of Rational Software Corporation.

CONTINUUS and CONTINUUS/CM are trademarks of Continuus Software Corporation. 

CRYSTAL REPORTS is a trademark of Seagate Software Inc.

FRAME, FRAMEBUILDER, FRAMEMAKER, and POSTSCRIPT are trademarks of Adobe Systems 
Incorporated.

HELVETICA and TIMES are trademarks of Linotype Corporation.

HITACHI is a trademark of Hitachi Limited.

LOGITECH is a trademark of Logitech, Inc. 

MACINTOSH and APPLE are trademarks of Apple Computer Inc.

MICROSOFT, MICROSOFT WINDOWS, MICROSOFT WINDOWS NT, MS-DOS, and 
POWERPOINT are trademarks of Microsoft Corporation.

NOVELL is a trademark of Novell, Inc.

PCANYWHERE is a trademark of Symantec.

PROMARK and RHOBOT are trademarks of DMI Promark, Inc.

SONY is a trademark of Sony Corporation.

SYBASE is a trademark of Sybase, Inc.

3COM is a trademark of 3Com Corporation.

UNIX is a trademark of Novell, Inc.

WINRUNNER is a trademark of Mercury Interactive Corporation.



CallPilot
Enterprise Networking Implementation and Administration 
Guide

Toronto Information Products
Nortel Networks
522 University Avenue, 14th Floor
Toronto, Ontario, Canada
M5G 1W7

Copyright © 1998 Northern Telecom, All Rights Reserved.

Information is subject to change without notice. Northern Telecom reserves the right to make 
changes in design or components as progress in engineering and manufacturing may warrant.
The process of transmitting data and call messaging between the Meridian 1 and the Meridian 
Application Server is proprietary to Northern Telecom. Any other use of the data and the 
transmission process is a violation of the user license unless specifically authorized in writing by 
Northern Telecom prior to such use. Violations of the license by alternative usage of any portion of 
this process or the related hardware constitutes grounds for an immediate termination of the license 
and Northern Telecom reserves the right to seek all allowable remedies for such breach.

The information in these back matter pages contains Northern Telecom and third-party trademarks.
Publication number: 555-7101-304
Product release: 1.0
Document release: Standard 1.0
Date: November 1998

Printed in the United States of America


	About CallPilot
	About this guide
	Overview
	Skills you need
	Related information products
	Using the online reference guides
	Contacting technical support
	How this guide is organized
	Conventions

	Finding your way around CallPilot
	Connecting to CallPilot
	Multi-administrator access
	Error handling in property sheets
	Using the online Help


	Getting started
	About Enterprise Networking
	Overview
	CallPilot and Enterprise Networking
	Names Across the Network

	Implementing Enterprise Networking
	Overview
	Implementation in a complex messaging network

	How Enterprise Networking works
	About Enterprise Networking messages
	About Enterprise Networking parameters
	Understanding Enterprise Networking settings

	How Enterprise Networking handles messages
	Overview
	What the MTA does
	What the ANA does
	How a message is transferred


	Gathering information
	Information required
	Overview
	Switch information
	Information required from the switch
	Evaluating the gathered information
	Information from other sites
	Messaging network representation


	Configuring the switch for Enterprise Networking
	Configuring the switch
	Overview
	SDN Table and Enterprise Networking
	Adding and configuring SDNs
	Phantom DNs and Enterprise Networking


	Configuring CallPilot for Enterprise Networking
	Configuring CallPilot
	Overview
	Configuration summary
	Message delivery parameters—Enterprise tab
	Configuring the message delivery parameters
	Creating a loopback mailbox


	Adding sites to Enterprise Networking
	About the messaging network
	Overview
	Configuration and other networking solutions

	Configuring the local site
	Overview
	Configuring the local messaging server
	Configuring the local prime switch location
	Configuring ESN information
	Configuring CDP information

	Adding and configuring a remote site
	Overview
	Configuring a remote messaging server
	Configuring a remote prime switch location
	Configuring a remote satellite switch location
	Recording a spoken name
	Importing a spoken name
	Checking the configuration of other remote sites
	Non-CallPilot remote sites
	Meridian Mail remote sites
	Norstar Voice Mail remote sites


	Testing and backing up Enterprise Networking
	Tests and backups
	Enterprise Networking test suite
	Call routing test
	Local SDN test
	Quick SDN test
	Loopback test
	End-to-end test
	Backing up Enterprise Networking


	Maintaining Enterprise Networking
	About maintaining Enterprise Networking
	Overview
	Maintain a network history
	Printing configuration information

	Regularly scheduled maintenance tasks
	Reviewing OM reports and alerts

	As-required maintenance tasks
	Overview
	Modifying the Enterprise Networking configuration
	Disabling and enabling Enterprise Networking
	Modifying message delivery parameters
	Modifying the channel resource allocation
	Add, modify, or delete remote sites
	Locating an item in the tree view
	Modify a remote site configuration
	Deleting items in the tree view
	Modifying dialing plan information

	Maintaining remote users
	Overview
	Adding remote users with User Administration
	Finding remote users
	Printing a list of remote users
	Modifying records of remote users
	Manually deleting remote voice users


	Troubleshooting Enterprise Networking
	About troubleshooting Enterprise Networking
	Overview
	Determining if Enterprise Networking is disabled
	Reviewing Alarm and Event reports
	Reviewing Operational Measurement reports

	Determining if problems are switch- related
	Switch-related problems
	Call trace test
	Link diagnostic test



